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Introduction
Thank you for purchasing the color image scanner ScanSnap S1500/S1500M (hereinafter 
referred to as "the ScanSnap").

This manual explains how to handle and operate the ScanSnap.
Be sure to read this manual and "Getting Started" thoroughly before using the ScanSnap to 
ensure correct use.
We hope that this manual will provide you with useful information in order to utilize the 
ScanSnap.

If you are using a Microsoft® Windows® operating system, either Adobe® Acrobat® (7.0 or 
later) or Adobe® Reader® (7.0 or later) is required to display or print this manual.

Trademarks

Microsoft, Windows, Windows Vista, Excel, PowerPoint, Outlook, SharePoint, and 
Entourage are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries.
Word is the product of Microsoft Corporation in the United States.
Apple, the Apple logo, Mac, Mac OS, iPhoto, and Rosetta are trademarks of Apple Inc.
Adobe, the Adobe logo, Acrobat, and Adobe Reader are either registered trademarks or 
trade names of Adobe Systems Incorporated in the United States and/or other countries.
Intel, Pentium, and Intel Core are registered trademarks or trademarks of Intel Corporation in 
the United States and other countries.
PowerPC is a registered trademark or trademark of International Business Machines 
Corporation in the United States, other countries, or both.
Cardiris is a trademark of I.R.I.S.
ABBYY™ FineReader™ Engine ©2011 ABBYY. OCR by ABBYY
ABBYY and FineReader are trademarks of ABBYY.
Evernote is a registered trademark or trademark of Evernote Corporation.
Google and Google Docs are registered trademarks or trademarks of Google Inc.
Salesforce, the Salesforce logo, and Salesforce CRM are registered trademarks or 
trademarks of salesforce.com, inc. in the United States and other countries.
ScanSnap, the ScanSnap logo, CardMinder, and Rack2-Filer are registered trademarks or 
trademarks of PFU LIMITED in Japan.
Other company names and product names are the registered trademarks or trademarks of 
the respective companies.
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Manufacturer

PFU LIMITED
International Sales Dept., Imaging Business Division, Products Group Solid Square East 
Tower 580 Horikawa-cho, Saiwai-ku, Kawasaki-shi, Kanagawa 212-8563, Japan
Phone: (81-44) 540-4538

©  PFU LIMITED 2008-2012

Disclaimer

Reproducibility of the image data
Confirm that the image data scanned with the ScanSnap meets your requirements (e.g. 
image reproducibility in size accuracy, information amount, fidelity, content and color).

Disposing of the original document
Check the image data using the application where you transferred the image data to 
make sure that there are no missing parts before disposing of the original document 
scanned with the ScanSnap.
It is the responsibility of the customer to store and manage the scanned image, and 
dispose of the original document scanned with the ScanSnap.

Manuals

Read the following manuals as needed when using the ScanSnap.

Manual Description Location

Safety Precautions Read this manual before you 
start using the product because 
it contains important information 
about the safe use of the 
ScanSnap.

Included in the package.

ScanSnap S1500/S1500M
Getting Started

This manual explains about the 
ScanSnap package contents, 
software installation, connecting 
the ScanSnap, and checking 
the operation.

ScanSnap S1500/S1500M
Operator's Guide
(this manual)

Read this manual for 
information about the basic 
operations of the ScanSnap, 
software installation, scanning 
methods, various settings, and 
handling of the ScanSnap.

Select [Start] menu → [All Programs] → 
[ScanSnap Manager] → [ScanSnap 
Operator's Guide].

Select [Applications] from the sidebar in 
Finder, and double-click [ScanSnap] → 
[Manual] → [Operator's Guide].
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Introduction
Troubleshooting 
(installation)

Read this manual when you 
failed to install the software or 
when the ScanSnap does not 
operate normally after software 
installation. It explains about the 
resolutions for such troubles.

Click [Manuals] → [Troubleshooting 
(installation)] in the [ScanSnap Setup] 
dialog box that appears when you insert 
the Setup DVD-ROM into the DVD-ROM 
drive.
Select [Start] menu → [All Programs] → 
[ScanSnap Manager] → 
[Troubleshooting (installation)].

Double-click the [Troubleshooting 
(installation)] icon in the [ScanSnap] 
window that appears when you insert 
the Setup DVD-ROM into the DVD-ROM 
drive.
Select [Applications] from the sidebar in 
Finder, and double-click [ScanSnap] → 
[Manual] → [Troubleshooting 
(installation)].

ScanSnap Connect 
Application
User's Guide (iOS)

Read this manual for 
information about connecting 
the mobile device and the 
computer, ScanSnap Connect 
Application operations on the 
mobile device, settings and 
receiving files.

Tap  on the [File List] screen of 
ScanSnap Connect Application installed on 
your mobile device, and then tap [Help] on 
the [Information] screen that appears.

ScanSnap Organizer
User's Guide

Read these manuals when 
using this product for the first 
time, or when you need more 
information on product features, 
dialog boxes/windows, 
operating environment and 
functions.

Select [Start] menu → [All Programs] → 
[ScanSnap Organizer] → [Manual].

CardMinder User's Guide Select [Start] menu → [All Programs] → 
[CardMinder] → [Manual].

Cardiris™ 4 User Guide From Finder, select [Applications] and 
double-click [Cardiris for ScanSnap] → 
[Manuals] → [User Guide.pdf].

ABBYY FineReader for 
ScanSnap User's Guide

Select [Start] menu → [All Programs] → 
[ABBYY FineReader for ScanSnap (TM)4.1] 
→ [User's Guide].

Scan to Microsoft 
SharePoint User Guide

Select [Start] menu → [All Programs] → 
[KnowledgeLake] → [Scan to Microsoft 
SharePoint User Guide].

Manual Description Location
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Introduction
ScanSnap Manager
Help

Read this Help file when 
questions or problems 
regarding operations (e.g. when 
setting items) arise.
This Help file explains about 
scanner operations, operational 
troubles and their resolution, 
dialog boxes/windows and 
messages.

Refer to this Help by either of the following 
methods:

Right-click the ScanSnap Manager icon 

 on the taskbar, and then select 
[Help] → [Help] from the menu that 
appears.
In Windows 7, the ScanSnap Manager 

icon  is displayed in the menu that 

appears when you click  on the 
taskbar.
Click the Help button ( ) for 
ScanSnap Manager.
Press the [F1] key on the keyboard 
when a dialog box is displayed.
Click the [Help] button in each dialog 
box.

Click the ScanSnap Manager icon  in 
the Dock while pressing the [control] key 
on the keyboard, and then select [Help] 
→ [Help] from the menu that appears.
Click the Help button  for ScanSnap 
Manager.
From the menu bar, select [Help] → 
[ScanSnap Manager Help].

ScanSnap Organizer
Help

Read these Help files when 
questions or problems 
regarding operations (e.g. when 
setting items) arise.
These Help files explain about 
operations, dialog boxes/
windows and messages.

For details about how to start up the Help, 
refer to the User's Guide for each product.

CardMinder Help

Cardiris Help From the menu bar, select [Help] → 
[Cardiris Help].

ABBYY FineReader for 
ScanSnap Help

From the menu bar, select [Help] → 
[FineReader for ScanSnap Help].

Adobe Acrobat Help From the menu bar, select [Help] → 
[Acrobat Help].

Manual Description Location
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■ About This Manual

Structure of This Manual

This manual consists of the following:

ScanSnap Overview
This chapter explains about the features, the names and functions of the parts, 
system requirements, and basic operations of the ScanSnap.

Installing the Software
This chapter explains about the software bundled with the ScanSnap and how 
to install them.

Using the ScanSnap (for Windows Users)/Using the ScanSnap (for Mac OS 
Users)

This chapter explains how to perform a scan, change or save scan settings, 
add, change or delete profiles, as well as other various scanner functions.

Troubleshooting
This chapter provides references for resolving troubles such as removing 
jammed documents.

Daily Care
This chapter explains about the cleaning materials and how to clean the 
ScanSnap.

Consumables
This chapter explains how to replace and purchase the pad assy and the pick 
roller.

Appendix
This appendix explains how to update ScanSnap Manager, how to uninstall 
the software, about settings that differ by the scanning method, how to 
purchase/clean the Carrier Sheet and the ScanSnap installation specifications.

Read this manual in order starting from "ScanSnap Overview" through "Using the 
ScanSnap" for a better understanding of ScanSnap operations.
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Introduction
Symbols Used in This Manual

The following indications are used in this manual to obviate any chance of accident or 
damage to you and people near you, and your property. Warning labels indicate the warning 
level and statements. The symbols indicating warning levels and their meanings are as 
follows.

Besides warning indicators, the following symbols are also used in this manual.

Arrow Symbols in This Manual

Right-arrow symbols (→) are used to connect icons or menu options you should select in 
succession.
Example: Select [Start] menu → [Computer].

Indication Description

WARNING
This indication alerts operators to an operation that, if not 
strictly observed, may result in severe injury or death.

CAUTION
This indication alerts operators to an operation that, if not 
strictly observed, may result in safety hazards to personnel 
or damage to the product.

Symbol Description

This symbol alerts operators to particularly important information.
Be sure to read this information.

This symbol alerts operators to helpful advice regarding operations.

This symbol indicates operations using Windows.

This symbol indicates operations using Mac OS.
7



Introduction
Screen Examples in This Manual

Windows screen
Screenshots in this manual are used according to the guidelines provided by Microsoft 
Corporation.
The screenshots used in this manual are of Windows Vista.
The actual windows and operations may differ depending on the operating system that you 
are using.

Mac OS screen
The screenshots used in this manual are of Mac OS X v10.6.
The actual windows and operations may differ depending on the Mac OS that you are using.

The screen examples in this manual are subject to change without notice in the interest of 
product development.
If the actual screen differs from the screen examples in this manual, operate by following the 
actual displayed screen.
8



Introduction
Abbreviations Used in This Manual

The following abbreviations are used in this manual:

Windows 7 : Windows® 7 Starter operating system, English Version
Windows® 7 Home Premium operating system, English Version
Windows® 7 Professional operating system, English Version
Windows® 7 Enterprise operating system, English Version
Windows® 7 Ultimate operating system, English Version

Windows Vista : Windows Vista® Home Basic operating system, English Version
Windows Vista® Home Premium operating system, English Version
Windows Vista® Business operating system, English Version
Windows Vista® Enterprise operating system, English Version
Windows Vista® Ultimate operating system, English Version

Windows XP : Windows® XP Home Edition operating system, English Version
Windows® XP Professional operating system, English Version

Windows 2000 : Windows® 2000 Professional operating system, English Version

Windows : Windows 7, Windows Vista, Windows XP or Windows 2000 operating 
system

Microsoft Office : Microsoft® Office

Word : Microsoft® Word 2010
Microsoft® Office Word 2007
Microsoft® Office Word 2003
Microsoft® Office Word 2002
Microsoft® Word for Mac 2011
Microsoft® Word 2008 for Mac
Microsoft® Word 2004 for Mac

Excel : Microsoft® Excel® 2010
Microsoft® Office Excel® 2007
Microsoft® Office Excel® 2003
Microsoft® Office Excel® 2002
Microsoft® Excel® for Mac 2011
Microsoft® Excel® 2008 for Mac
Microsoft® Excel® 2004 for Mac

PowerPoint : Microsoft® PowerPoint® 2010
Microsoft® Office PowerPoint® 2007
Microsoft® Office PowerPoint® 2003
Microsoft® Office PowerPoint® 2002

SharePoint : Microsoft® SharePoint® Server 2010, English Version
Microsoft® Office SharePoint® Server 2007, English Version
Microsoft® Office SharePoint® Portal Server 2003, English Version
Microsoft® SharePoint® Foundation 2010, English Version
Microsoft® Windows® SharePoint® Services 2.0/3.0, English Version

Office Live : Microsoft® Office Live

Internet Explorer : Windows® Internet Explorer®

Microsoft® Internet Explorer®

Windows Live Mail : Windows Live™ Mail
9



Introduction
Windows Mail : Microsoft® Windows® Mail 

Outlook : Microsoft® Outlook® 2010
Microsoft® Office Outlook® 2007
Microsoft® Office Outlook® 2003

Outlook Express : Microsoft® Outlook® Express

Outlook for Mac : Microsoft® Outlook® for Mac

.NET Framework : Microsoft® .NET Framework

Entourage : Microsoft® Entourage®

Mac OS : Mac OS X v10.7
Mac OS X v10.6
Mac OS X v10.5
Mac OS X v10.4

Adobe Acrobat : Adobe® Acrobat®

All the descriptions in this manual assume the usage of Adobe Acrobat 
bundled with the ScanSnap. Unless otherwise specified, the term Adobe 
Acrobat refers to the Adobe Acrobat bundled with the ScanSnap.
Note that Adobe Acrobat may be upgraded without notice.
If the descriptions differ from the actual displayed screens, refer to the 
Adobe Acrobat Help.

Adobe Reader : Adobe® Reader®

ABBYY FineReader for 
ScanSnap

: ABBYY FineReader for ScanSnap™
All the descriptions in this manual assume the usage of ABBYY 
FineReader for ScanSnap bundled with the ScanSnap. Unless otherwise 
specified, the term ABBYY FineReader for ScanSnap refers to the ABBYY 
FineReader for ScanSnap bundled with the ScanSnap.
Note that ABBYY FineReader for ScanSnap may be upgraded without 
notice.
If the descriptions differ from the actual displayed screens, refer to the 
ABBYY FineReader for ScanSnap Help.

Cardiris : Cardiris™ for ScanSnap

Google Docs : Google Docs™

ScanSnap : Color image scanner ScanSnap S1500
Color image scanner ScanSnap S1500M

Carrier Sheet : ScanSnap Carrier Sheet
10
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ScanSnap Overview
This chapter explains about the features, the names and functions of the parts, system 
requirements, and basic operations of the ScanSnap.

Features of the ScanSnap . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
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System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Turning the ScanSnap ON/OFF. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Documents for Scanning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

How to Load Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Scanning Operation Flow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
16



Features of the ScanSnap
Features of the ScanSnap

The main features of the ScanSnap are as follows:

Turn documents into digital data by just pressing the [Scan] button
By converting paper documents cluttering up your desk into PDF or JPEG files, you can 
conveniently view, edit, manage and archive the documents in your computer.

Speedy scanning
Double-sided color documents of A4 or Letter size can be scanned at a speed of 
approx. 20 sheets per minute under the following conditions:

System requirements

Intel® Core™ 2 Duo  2.2 GHz or higher
Windows 7, Windows Vista or Windows XP operating system

Intel® Core™ 2 Duo  2.4 GHz or higher
Mac OS X v10.7, Mac OS X v10.6, Mac OS X v10.5 or Mac OS X v10.4

Scan setting (*)
When [Image quality] is set to [Automatic resolution], [Color mode] to [Auto color 
detection], [Compression rate] to [3], and other settings are in default

* : - Scanning speed may slow down in [B&W] (black & white) mode depending on the document.
Example: Scanning color brochures in [B&W] mode (converting a color image to black & 

white)
- Scanning speed may slow down when [Correct skewed character strings automatically] and/ 

or [Allow automatic image rotation] is enabled.

The Quick Menu makes the operation easy even for beginners
The Quick Menu will allow you to start using the ScanSnap right away even if it is your 
first time. Simply press the [Scan] button on the scanner to scan your document, and 
then the Quick Menu will appear where you can select the action you want to perform.

Automatically recognize color and black & white documents (Auto color 
detection)
The ScanSnap determines the color mode of each document, saves color documents in 
color, black & white documents in black & white, and black & white documents with 
photos or illustrations in grayscale. This function will optimize your PDF file size.
17



Features of the ScanSnap
Scan different size documents together (Automatic page size detection, 
Carrier Sheet mixed batch scanning)
Paper size is automatically recognized so that you do not need to change the paper size 
setting. The bundled Carrier Sheet allows you to scan documents larger than A4/Letter 
size as well as photographs and clippings. Multiple Carrier Sheets can be scanned at 
once and together with regular documents in the same batch.

Automatically set the resolution by the paper size (Automatic resolution 
function)
Documents are scanned at 300 dpi at first, then the image is saved at 300 dpi if the 
document length is 148 mm (5.83 in.) or less, and converted to 200 dpi for longer 
documents. When linked with a text recognition application (e.g. for scanning business 
cards), you can save high resolution image data without having to change the scan 
settings.

Create searchable PDF files
You can create searchable PDF files by performing automatic text recognition for PDF 
files after scanning.
You can also perform text recognition on character strings marked by a highlight pen in 
black & white documents, and add them as keywords for the PDF file.

E-mail or print a scanned image directly from scanning
You can attach the scanned image to an e-mail without needing any additional 
application or print it out instead of using a copy machine.

Compatible with both Windows and Mac OS
You can use the ScanSnap in a manner that best suits your office environment in either 
Windows or Mac OS (*).

* : The following functions are not available for Mac OS:
• Color high compression
• Loading the document face-up
• Setting passwords for PDF files

Convert paper documents into Word/Excel/PowerPoint files
Use the bundled "ABBYY FineReader for ScanSnap" to directly convert the scanned 
image into a Word/Excel/PowerPoint file.
In Mac OS, only conversion to Word and Excel file is supported.
18



Features of the ScanSnap
Organize and manage scanned images by linking with ScanSnap 
Organizer

Setting a keyword (Intelligent Indexing)
Keywords can be set by the following methods:
- Recognize a character string on a page (OCR) and set as a keyword (Zone OCR)
- Set any character string as a keyword
- Set a marked character string as a keyword (Marker Index)
- Drag and drop a keyword from the keyword list (Keyword Addition by Drag&Drop)
The keywords can be viewed in thumbnails. (Keyword Overlay)
Distributing files by keyword (Automatic Keyword Sort)
Files can also be sorted into folders according to the keyword set for files as a sorting 
condition.
Search a variety of files (Search Engine Selection)
Files can be found quickly searched by file name, keyword, text or date.
Cropping marked sections (Intelligent Cropping)
Selections on a page that are marked with a highlight pen can be cut and pasted 
elsewhere to create scrapbooks.

Easy filing of business cards
Text recognition can be performed on business cards which then can be easily 
converted into digital data with the bundled business card application. With CardMinder, 
you can create a database which facilitates data search of business cards converted 
into digital data.
The bundled business card application is as follows:

CardMinder

Cardiris

Share documents converted into digital data with others
You can conveniently share documents by saving the scanned image directly in 
SharePoint or Office Live.

Access documents converted into digital data anytime, anywhere
Through linkage with Evernote, Google Docs, Salesforce Chatter or SugarSync, you 
can access scanned images anytime from your computer or smartphone no matter 
where you are.

Save documents converted into digital data to a mobile device
Scanned image can be saved directly to a mobile device such as tablet devices and 
smartphones.

Two separate scanned images can be merged into a single image
Two scanned images can be merged into a single image either vertically or horizontally.

Note: The ScanSnap does not conform to the TWAIN, ISIS and WIA standards.
19



Parts and Functions
Parts and Functions

This section explains names and functions of the ScanSnap parts.

■ Front

ADF paper chute (cover)
Open to use the ScanSnap.

Opening the ADF paper chute (cover) turns 
on the ScanSnap.

Extension
Pull out when scanning long documents.

Side guide
Adjust to the width of documents to prevent 
them from getting skewed.

ADF release catch
Pull this tab to open the 
ADF top section.

[Scan] button
Press this button to start scanning. Can be 
pressed even when the stacker is closed.
It indicates the status of the ScanSnap as follows:

Blue (lit) : Ready
Blue (flashing) : Scanning
Orange (flashing) : Error

ADF paper chute (cover)
You can load the document here after 
opening it.

Stacker
Open to use the stacker.

Stacks up the ejected documents.

ADF top section
Open to remove jammed documents, replace 
the pad assy and the pick roller, or clean the 
inside of the ScanSnap.
20



Parts and Functions
■ Back

Power connector

Security cable slot
Used to connect an anti-theft security cable 
(commercially available).

Tape seal
Remove this tape seal after installing the 
software.

USB connector

Ventilation port
Holes for ventilating hot air from inside the 
ScanSnap.
21



System Requirements
System Requirements

The system requirements for the ScanSnap are as follows:

■ Windows

*1 : Service Pack 2 or later required
*2 : Service Pack 4 or later required

Evernote for Windows and Adobe Acrobat X are not supported.
*3 : When the font size is large, some screens may not be displayed properly.

In that case, use a smaller font size.
*4 : When using a USB 3.0 port, data is transferred at the same speed as USB 2.0. 

Operating 
system

Windows 7
(32 bit/64 bit)

Windows Vista
(32 bit/64 bit)

Windows XP (*1)
(32 bit)

Windows 2000 
(*2)

CPU Intel® Core™ 2 Duo  2.2 GHz or higher recommended 
(minimum: Intel® Pentium® 4  1.8 GHz)

Memory 32 bit: 1 GB or more
64 bit: 2 GB or more 512 MB or more (1 GB or more recommended)

Display
resolution 800 × 600 pixels or higher (*3)

Hard disk 
space

Disk space required to install the software bundled with the ScanSnap is as follows:
ScanSnap Manager: 530 MB
ScanSnap Organizer: 620 MB
CardMinder: 280 MB
ABBYY FineReader for ScanSnap: 600 MB
Evernote for Windows: 150 MB
Scan to Microsoft SharePoint: 40 MB
Adobe Acrobat X Standard:1130 MB

USB port 
(*4) USB2.0 / USB1.1
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System Requirements
The following applications may be installed at the same time when ScanSnap Manager, 
ScanSnap Organizer or CardMinder is installed.
Windows Vista

.NET Framework 3.5 SP1 (500 MB free disk space required)
Windows XP
- If Service Pack 3 or later is installed

.NET Framework 3.5 SP1 (500 MB free disk space required)
- If Service Pack 2 is installed

Windows Installer 3.1 (30 MB free disk space required)
NET Framework 3.5 SP1 (500 MB free disk space required)

The following applications may be installed at the same time when Scan to Microsoft 
SharePoint is installed.
Windows XP
- If Service Pack 3 or later is installed

.NET Framework 2.0 (280 MB free disk space required)
- If Service Pack 2 is installed

Windows Installer 3.1 (30 MB free disk space required)
.NET Framework 2.0 (280 MB free disk space required)

Windows 2000
Windows Installer 3.1 (30 MB free disk space required)
.NET Framework 2.0 (280 MB free disk space required)

Do not use the USB port on the keyboard or the monitor to connect the ScanSnap (it may not 
function properly).
Make sure to use a powered hub equipped with an AC adapter if you are using a 
commercially available USB hub.
If the USB port or the USB hub is USB 1.1, scanning speed will slow down.
If the CPU or the memory does not meet the required specifications, scanning speed will 
slow down.
The actual increase in used disk space after installation and the required disk space for 
installation may differ from each other depending on your Windows system disk 
management.
A disk space approximately three times larger than the resulting scanned file size is required 
for scanning documents.
If the characters are not displayed correctly when you use CardMinder, Scan to Mobile or 
Scan to Salesforce Chatter, perform the following:
- Windows 2000 (*)

Select [Control Panel] → [Regional Options] → [General] tab → [Language settings for 
the system], and then select the [Western Europe and United States], [Simplified 
Chinese], [Traditional Chinese], and [Korean] check boxes.
Install the universal font (Arial Unicode MS) from the setup disc for Microsoft Office 
2000 or later.

- Windows XP
Select [Control Panel] → [Regional and Language Options] → [Languages] tab → 
[Install files for East Asian languages] check box.
Install the universal font (Arial Unicode MS) from the setup disc for Microsoft Office 
2000 or later.

- Windows Vista or Windows 7
Install the universal font (Arial Unicode MS) from the setup disc for Microsoft Office 2003 
or later.

*: The following applications are not supported on Windows 2000:
Scan to Mobile
Scan to Salesforce Chatter
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System Requirements
The following shows the estimated file size when scanning one side of a color 
document.

File format Compression rate Paper size

PDF 3 A4 (catalog)

Estimated image data size (KB)

Color mode Automatic 
resolution Normal Better Best Excellent

Color 438.4 295.1 442.4 859.3 2921.4

Gray 393.4 264.3 390.0 753.1 2500.4

B&W 175.8 112.0 183.5 352.1 1630.2

Color high compression 209.8 164.2 222.5 156.8 —
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System Requirements
■ Mac OS

*1 : It is recommended to apply the latest updates to the Mac OS.
*2 : Evernote for Mac is not supported for versions earlier than Mac OS X v.10.5.8.
*3 : When using Mac OS X v10.7, you need to use an Adobe Acrobat version which supports Mac 

OS X v10.7.
For information about the Adobe Acrobat versions officially supported on Mac OS X v10.7, 
visit the website of Adobe Systems Incorporated.

*4 : When using a USB 3.0 port, data is transferred at the same speed as USB 2.0.

Operating system 
(*1) Mac OS X v10.7 Mac OS X v10.6 Mac OS X v10.5 Mac OS X v10.4 

(*2)

CPU Intel® Core™ 2 Duo  2.4 GHz or higher recommended
(minimum: Intel® Core™ Duo  1.83 GHz, PowerPC® G5  1.6 GHz)

Memory 2 GB or more 1 GB or more 512 MB or more 
(1 GB or more recommended)

Display resolution 1024 × 768 pixels or higher

Hard disk space

Disk space required to install the software bundled with the ScanSnap is as 
follows:

ScanSnap Manager: 800 MB
ABBYY FineReader for ScanSnap: 570 MB
Cardiris: 130 MB
Evernote for Mac: 55 MB
Adobe Acrobat 9 Pro (*3): 1540 MB

USB port (*4) USB2.0 / USB1.1

Do not use the USB port on the keyboard or the monitor to connect the ScanSnap (it may not 
function properly).
Make sure to use a powered hub equipped with an AC adapter if you are using a 
commercially available USB hub.
If the USB port or the USB hub is USB 1.1, scanning speed will slow down.
If the CPU or the memory does not meet the required specifications, scanning speed will 
slow down.
A disk space approximately three times larger than the resulting scanned file size is required 
when scanning documents.
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System Requirements
The following shows the estimated file size when scanning one side of a color 
document.

File format Compression rate Paper size

PDF 3 A4 (catalog)

Estimated image data size (KB)

Color mode Automatic 
resolution Normal Better Best Excellent

Color 438.4 295.1 442.4 859.3 2921.4

Gray 393.4 264.3 390.0 753.1 2500.4

B&W 175.8 112.0 183.5 352.1 1630.2
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Turning the ScanSnap ON/OFF
Turning the ScanSnap ON/OFF

This section explains how to turn the ScanSnap ON/OFF.
The ScanSnap is turned ON/OFF in conjunction with the computer. Therefore, you do not 
have to worry about turning the power ON/OFF as long as the ScanSnap is connected to a 
computer.

 Turning the ScanSnap on
Open the ADF paper chute (top cover) when the computer is turned on.
The [Scan] button flashes blue to indicate that the ScanSnap is turned on, and lights in 
blue when the ScanSnap is ready to scan.

 Turning the ScanSnap off
Turn off the computer or close the ADF paper chute (cover).
The [Scan] button switches off when the ScanSnap is turned off.

With some computers, the initialization of the ScanSnap may be performed several 
times when the computer is started up.

Close the ADF paper chute (cover) after putting the extension back.
Make sure to close the stacker firmly. If you close the ADF top section when the 
stacker is loose, the ScanSnap will not be turned off.
With some computers, it may take two to three minutes until the light of the [Scan] 
button goes out after the computer is turned off.
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Turning the ScanSnap ON/OFF
ScanSnap in sleep mode
When the ScanSnap has not been in operation for 15 minutes while the power is on, it 
enters sleep (power saving) mode.
The ScanSnap's internal light flashes in sleep mode.
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Documents for Scanning
Documents for Scanning

This section explains about the documents that can be scanned with the ScanSnap.

■ Conditions for Documents That Can Be Scanned

Documents conditions for documents that can be scanned with the ScanSnap are as follows:

* : Scanning starts when you hold down the [Scan] button on the ScanSnap for 3 seconds or 
longer.

Paper type Standard office paper, postcards, business cards

Paper weight 52 to 127 g/m² (14 to 34 lb)

Paper size

Width: 50.8 to 216 mm (2 to 8.5 in.)
Length: 50.8 to 360 mm (2 to 14.17 in.)
Maximum size for long page scanning (*)
 216 × 863 (mm) / 8.5 × 34 (in.)

When you scan documents written in pencil, there may be black traces left on them. It is 
recommended that you scan such documents by using the Carrier Sheet. Clean the rollers as 
often as possible when you scan such documents directly without using a Carrier Sheet 
because dirt accumulating on the rollers may cause feeding errors.
For details about how to clean the inside of the ScanSnap, refer to "Cleaning the Inside of the 
ScanSnap" (page 425).
The following types of documents must not be scanned:
- Paper-clipped or stapled documents (remove the paper clips and staples for scanning)
- Documents on which the ink is still wet (wait until the ink dries completely to scan these 

documents)
- Documents larger than 216 × 863 (mm) / 8.5 × 34 (in.) (width × length)
- Documents other than paper such as fabric, metal foil, OHP film and plastic cards

When you scan picture postcards, be aware that the picture side may get damaged.
Scanning the following types of documents without using the Carrier Sheet can result in 
documents being damaged or scanned incorrectly. It is recommended that you use the 
Carrier Sheet to scan such documents.
- Documents smaller than 50.8 × 50.8 (mm) / 2 × 2 (in.) (width × length)
- Documents whose paper weight is less than 52 g/m² (14 lb)
- Documents of non-uniform thickness (e.g. envelopes and paper sheets with attached 

materials)
- Wrinkled or curled documents
- Folded or torn documents
- Tracing paper
- Coated paper
- Photographs (photographic paper)
- Perforated or punched documents
- Odd shaped documents (not square or rectangular)
- Carbon paper or thermal paper
- Documents with memo papers or sticky notes attached
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Documents for Scanning
Since carbonless paper may contain chemicals that can harm the pad assy and the pick 
roller, take note of the following when scanning carbonless paper:
- It is recommended that you use the Carrier Sheet to scan such documents.
- Make sure to clean the rollers regularly to maintain the scanner performance when 

scanning carbonless paper directly without using the Carrier Sheet. Depending on the 
type of carbonless paper, the life span of the scanner may be shortened compared to 
scanning standard office paper.
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Documents for Scanning
■ Conditions for Using the Carrier Sheet

The bundled Carrier Sheet is a sheet designed to transport documents through the 
ScanSnap.
You can scan documents that are larger than A4/Letter size, photographs and clippings.
Conditions for documents that can be scanned using the Carrier Sheet are as follows:

CAUTION

Do not use a damaged Carrier Sheet because it may damage or cause the scanner to 
malfunction.
Be careful not to cut your finger on the edge of the Carrier Sheet.

* : Fold in half to scan.

Paper type Documents that cannot be fed directly into the ScanSnap

Paper weight
Up to 127 g/m² (up to 34 lb)

Up to 63.5 g/m² (17 lb) (when scanning documents folded in half)

Paper size

Carrier Sheet size (216 × 297 mm)
A3 (297 × 420 mm) (*)
A4 (210 × 297 mm)
A5 (148 × 210 mm)
A6 (105 × 148 mm)
B4 (257 × 364 mm) (*)
B5 (JIS) (182 × 257 mm)
B6 (JIS) (128 × 182 mm)
Post card (100 × 148 mm)
Business card (90 × 55 mm, 55 × 90 mm)
Letter (8.5 × 11 in. (216 × 279.4 mm))
11 × 17 in. (279.4 × 431.8 mm) (*)
Custom size

Width: 25.4 to 216mm (1 to 8.5 in.)
Length: 25.4 to 297 mm (1 to 11.69 in.)

Do not stain, or cut the end with a black & white pattern because the Carrier Sheet will not be 
recognized properly.
Do not place the Carrier Sheet upside down. Otherwise, a paper jam may occur and damage 
the Carrier Sheet and the document inside.
Do not leave your document inside the Carrier Sheet for a long time. Otherwise, the ink on 
the document may be transferred onto the Carrier Sheet.
To avoid deformation, do not use or leave the Carrier Sheet in high temperature places such 
as under direct sunlight or near a heating apparatus for a long time.
Do not fold or pull the Carrier Sheet.
To avoid deformation, store the Carrier Sheet on a flat surface without any weight on it.
Paper jams may occur when several small size documents such as photographs and 
postcards are placed inside the Carrier Sheet to be scanned at once. It is recommended that 
you scan such documents one at a time.
If paper jams occur frequently, feed about 50 sheets of PPC paper (recycled paper) before 
scanning with the Carrier Sheet. The PPC paper can either be blank or printed.
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How to Load Documents
How to Load Documents

Load documents in the ScanSnap in the following procedure.
For details about documents that can be loaded, refer to "Documents for Scanning" (page 29).

1. If you are loading multiple sheets, check the number of sheets.

The maximum number of sheets that can be loaded in the ScanSnap is as follows:
For A4 or smaller sizes: Up to 50 sheets can be loaded (with paper weight of 80g/m² 
[20 lb] and thickness of the document stack under 5 mm).

2. Fan the documents.

1. Hold both ends of the documents and fan them a few times.

2. Rotate the documents by 90 degrees and fan them in the same manner.

3. Straighten the edges of the documents and slightly displace the top 
edges at an angle.

If you try to scan more than the maximum amount that can be loaded, the following 
problems may occur:

Files may not be properly created due to excessive file size.
Paper jams may occur.

Paper jams or damage to documents may occur if you scan the documents without 
aligning the edges first.

Ba
ck
Ba

ck
at an angle

Feed direction
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How to Load Documents
4. Open the ADF paper chute (cover) of the ScanSnap.

5. Pull the stacker on the ADF top section towards you.

6. Pull out the extension on the ADF paper chute (cover) and open the 
stacker.

ADF paper chute (cover)

Stacker

Extension

Stacker
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How to Load Documents
7. Load the documents in the ADF paper chute (cover).

Load the documents face-down and top-first with their back facing you. Load the 
documents so that they are not beyond the reference marks within the side guides.

Do not leave more than 50 sheets (80 g/m² or 20 lb.) of ejected documents on the 
stacker.

Right-click the ScanSnap Manager icon  on 
the taskbar, and select [Scan Button Settings]. 
In the ScanSnap setup dialog box that appears, 
click the [Detail] button, then select the 
[Scanning] tab → [Option] button. If the [Set the 
document with its face up] check box is selected 
in the [Scanning mode option] dialog box, load 
documents face-up and bottom edge first.

In Windows 7, the ScanSnap Manager icon  
is displayed in the menu which appears when 

you click  on the taskbar.

Side guide
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How to Load Documents
8. Adjust the side guides to the width of the documents.

Do not leave space between the side guides and the documents.
Otherwise, the documents may be fed skewed.

Paper size
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Scanning Operation Flow
Scanning Operation Flow

This section explains the flow of operations for scanning documents.
You can scan documents in two different ways. Choose either way depending on your 
intended use.

Using the Quick Menu
With the Quick Menu, even the first time users can easily use each ScanSnap function 
by following the instructions on the screen and perform scanning.
After scanning, select an application to link with ScanSnap Manager in the Quick Menu.
For details about how to perform scanning using the Quick Menu, refer to the following:

- For Windows (→ page 73)
- For Mac OS (→ page 262)

Without Using the Quick Menu
You can perform scanning by using predefined scan settings.
Before you perform scanning, select a profile which is already configured with an 
application to link with ScanSnap Manager. Documents are scanned according to the 
scan settings of the selected profile.
For details about how to perform scanning using the Quick Menu, refer to the following:

- For Windows (→ page 79)
- For Mac OS (→ page 267)

The above scanning methods can be switched by selecting or clearing the [Use Quick Menu] 
check box in the ScanSnap setup dialog box/window.
Display the ScanSnap setup dialog box/window in the following procedure:

Right-click the ScanSnap Manager icon  on the taskbar, and select [Scan Button Settings].

In Windows 7, the ScanSnap Manager icon  is displayed in the menu which appears when 

you click  on the taskbar.

Click the ScanSnap Manager icon  in the Dock while pressing the [control] key on the 
keyboard, and select [Settings].
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Scanning Operation Flow
Without Using the Quick MenuUsing the Quick Menu

Select an application from the Quick Menu.

The selected application starts up.

Select a profile.

Turn on the ScanSnap. (→ page 27)

Press the [Scan] button to scan.
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Installing the Software
This chapter explains about the software bundled with the ScanSnap and how to install them.

Bundled Software Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Installing in Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Installing in Mac OS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
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Bundled Software Overview
Bundled Software Overview

This section gives an overview of each bundled software and their functions. You can edit, 
manage and arrange the scanned image by using the following software:

ScanSnap Manager
This scanner driver is required to scan documents with the ScanSnap. The scanned 
image can be saved as a PDF or JPEG file.
You need to have ScanSnap Connect Application installed on your mobile device to 
save PDF or JPEG files to your mobile device.
You can download ScanSnap Connect Application for mobile devices from the App 
Market.

ScanSnap Organizer
You can use this application to display image data (PDF or JPEG files) without opening 
them, create folders and arrange files as you like.

CardMinder
You can use this application to efficiently digitalize a large number of business cards.
Text recognition can be performed on business cards and you can create a database to 
facilitate card data management and searches. 

Cardiris
You can use this application to efficiently digitalize a large number of business cards by 
performing text recognition on them.

ABBYY FineReader for ScanSnap
This application can perform text recognition on the scanned images using OCR 
(Optical Character Recognition) and convert the image data to Word, Excel or 
PowerPoint files that can be edited.
In Mac OS, only conversion to Word and Excel files is supported.

Evernote for Windows  / Evernote for Mac
You can easily save files in Evernote using the ScanSnap.

Scan to Microsoft SharePoint
You can easily save files in SharePoint and Office Live using the ScanSnap.
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Bundled Software Overview
Rack2-Filer V5.0 Trial Version
This application provides integrated management of digitalized paper documents 
(electronic documents) and digital data created with computer, as if you are filing paper 
documents in actual binders.
For details about the languages supported in Rack2-Filer, refer to Rack2-Filer 
"Readme".

Adobe Acrobat X Standard  (*1)/ Adobe Acrobat 9 Pro  (*2)
An industry-standard application to create, edit, and manage electronic documents in 
PDF format.

*1 : Only bundled with S1500.
*2 : Only bundled with S1500M.

You can download the following software from the Setup DVD-ROM.

SugarSync Manager for Windows /SugarSync Manager for 
Mac
You can easily save files to your SugarSync folder using the ScanSnap.
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Installing in Windows
Installing in Windows

This section explains how to install the software in Windows.

■ How to Install the Software

When you insert the Setup DVD-ROM into the DVD-ROM drive on your computer, the 
[ScanSnap Setup] dialog box appears.

The functions of each button in the [ScanSnap Setup] dialog box are as follows.

Button Function

Readme Displays the [Readme] dialog box where you can refer to the Readme file of 
each software. 

Install Products Displays the [Install Products] dialog box. 
[ScanSnap] button
Installs the following software:
- ScanSnap Manager
- ScanSnap Organizer
- CardMinder
- ABBYY FineReader for ScanSnap

[Evernote] button
Installs Evernote for Windows.
[SugarSync] button
Opens the SugarSync Manager for Windows download web page.
[Scan to Microsoft SharePoint] button
Installs Scan to Microsoft SharePoint.

Manuals Displays the [Manuals] dialog box where you can refer to the software 
manuals including "Troubleshooting (installation)".
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Installing in Windows
Browse DVD Contents Opens Windows Explorer to display the files from the DVD-ROM.

Contact Us Displays contact information for customer support.

Trial Software Displays the [Trial Software] dialog box from which you can install the trial 
version software.

Button Function
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Installing in Windows
■ ScanSnap Software

Install the following software:
ScanSnap Manager
ScanSnap Organizer
CardMinder
ABBYY FineReader for ScanSnap

The procedure is as follows.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap Setup] dialog box appears.

3. Click the [Install Products] button.

The [Install Products] dialog box appears.

If the [ScanSnap Setup] dialog box does not appear, double-click "ScanSnap.exe" in the 
Setup DVD-ROM via Windows Explorer.
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Installing in Windows
4. Click the [ScanSnap] button.

The [ScanSnap] dialog box appears, displaying the [Welcome to the InstallShield 
Wizard for ScanSnap] screen.

5. Click the [Next] button.

The [ScanSnap Setup] dialog box appears.

6. Read the message about anti-virus software, and click the [OK] button.

The [Select Features] screen appears.
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Installing in Windows
7. Confirm the check boxes of the software that you want to install are 
selected, and click the [Next] button.

The [Choose Destination Location] screen appears.

8. Confirm the destination folder, and then click the [Next] button.

A confirmation about accepting the license agreement appears.

9. Read the "END-USER LICENSE AGREEMENT", select [I accept the terms 
of the license agreement], and then click the [Next] button.

The [Start Copying Files] screen appears.

10.Confirm the settings, and then click the [Next] button.

Installation starts. When the installation is complete, the "Install Complete" screen 
appears.

11.Click the [Finish] button.

The software will not be installed unless the check box is selected.
Note that you must install ScanSnap Manager. Also, it is recommended to install all 
software in order to utilize the features of the ScanSnap.

Depending on the number of the installed software, this step may be required more than 
once.
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Installing in Windows
12.Remove the Setup DVD-ROM from the DVD-ROM drive.

If the installation is not successfully completed, select [Manuals] → [Troubleshooting 
(installation)] in the [ScanSnap Setup] dialog box and refer to Troubleshooting (installation).
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Installing in Windows
■ Evernote for Windows

The procedure is as follows.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap Setup] dialog box appears.

3. Click the [Install Products] button.

The [Install Products] dialog box appears.

If the [ScanSnap Setup] dialog box does not appear, double-click "ScanSnap.exe" in the 
Setup DVD-ROM via Windows Explorer.
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Installing in Windows
4. Click the [Evernote] button.

Installation starts.

5. Follow the instructions on the screen to complete the installation.

6. Click the [Finish] button when the installation complete notification is 
displayed.

7. Remove the Setup DVD-ROM from the DVD-ROM drive.
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Installing in Windows
■ SugarSync Manager for Windows

The procedure is as follows.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap Setup] dialog box appears.

3. Click the [Install Products] button.

The [Install Products] dialog box appears.

An Internet connection is required to install SugarSync Manager for Windows.

If the [ScanSnap Setup] dialog box does not appear, double-click "ScanSnap.exe" in the 
Setup DVD-ROM via Windows Explorer.
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Installing in Windows
4. Click the [SugarSync] button.

A web browser starts up and the SugarSync Manager for Windows download web 
page opens.
Download and install SugarSync Manager for Windows.

5. When the installation is complete, remove the Setup DVD-ROM from the 
DVD-ROM drive.
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Installing in Windows
■ Scan to Microsoft SharePoint

The procedure is as follows.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap Setup] dialog box appears.

3. Click the [Install Products] button.

The [Install Products] dialog box appears.

For details about system requirements and notes on installation, refer to "Readme" of Scan to 
Microsoft SharePoint. Click the [Scan to Microsoft SharePoint] button in the [Readme] dialog 
box to open the Readme file.

If the [ScanSnap Setup] dialog box does not appear, double-click "ScanSnap.exe" in the 
Setup DVD-ROM via Windows Explorer.
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Installing in Windows
4. Click the [Scan to Microsoft SharePoint] button.

Installation starts.

5. Follow the instructions on the screen to complete the installation.

6. Click the [Close] button when the installation complete notification is 
displayed.

7. Remove the Setup DVD-ROM from the DVD-ROM drive.

For details about how to use Scan to Microsoft SharePoint, refer to the Scan to Microsoft 
SharePoint User Guide. Click the [Scan to Microsoft SharePoint] button in the [Manuals] dialog 
box to open the Scan to Microsoft SharePoint User Guide.
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Installing in Windows
■ Trial Software

The procedure is as follows.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap Setup] dialog box appears.

3. Click the [Trial Software] button.

The [Trial Software] dialog box appears.

For details about system requirements and installation, refer to "Readme" of the trial version 
software. Click on the name of the software in the [Trial Software] dialog box, then click the 
[Readme] button to open the Readme file.

If the [ScanSnap Setup] dialog box does not appear, double-click "ScanSnap.exe" in the 
Setup DVD-ROM via Windows Explorer.
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Installing in Windows
4. Click the button of the trial software you want to install.

The setup dialog box of the trial software appears (e.g. [Rack2-Filer Setup]).

5. Click the [Install Product] button.

Installation starts.

6. Follow the instructions on the screen to complete the installation.

7. Click the [Finish] button when the installation complete notification is 
displayed.

8. Remove the Setup DVD-ROM from the DVD-ROM drive.

For details about how to use trial versions of the software, refer to the software manual. 
Click the [Manuals] button in the setup dialog box of the trial software to open the manual.
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Installing in Windows
■ Adobe Acrobat

Install Adobe Acrobat in the following procedure.

1. Insert the Adobe Acrobat DVD-ROM into the DVD-ROM drive.

The [AutoPlay] dialog box appears.

2. Click on [Run AutoPlay.exe].

The [Setup] dialog box appears.

3. Click the [English / Français / Deutsch] button for [Select the Language].

The [Adobe Acrobat X Standard - English, Français, Deutsch - Setup] dialog box 
appears.

Adobe Acrobat DVD-ROM for Windows is bundled with S1500.
Adobe Acrobat can be used in the following operating systems:
- Windows 7 
- Windows Vista (Service Pack 2 or later required)
- Windows XP (Service Pack 3 or later required)

Additional requirements are as follows:
- Internet Explorer 7.0 or later / Firefox 3.5 or later
- A display resolution of 1024 × 576 pixels or higher

Adobe Acrobat can display the scanned image through linkage with ScanSnap Manager. If the 
latest version of Adobe Acrobat is already installed on your computer, you do not need to install 
it again.
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Installing in Windows
4. Click the [Next] button.

5. Follow the instructions on the screen to complete the installation.

6. When the installation is complete, remove the Adobe Acrobat DVD-ROM 
from the DVD-ROM drive.

For details about the installation of Adobe Acrobat, refer to "Readme" included on the 
Adobe Acrobat DVD-ROM.
To open Readme, open the file below via Windows Explorer.

DVD-ROM drive: \ReadMe.htm
For details about how to use Adobe Acrobat, refer to the Adobe Acrobat Help.
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Installing in Mac OS
Installing in Mac OS

This section explains how to install the software in Mac OS.

■ How to Install the Software

When you insert the Setup DVD-ROM into the DVD-ROM drive on your computer, the 
[ScanSnap] window appears.

The functions of each icon in the [ScanSnap] window are as follows.

Icon Function

ScanSnap Installs the following software:
ScanSnap Manager
ABBYY FineReader for ScanSnap
Cardiris

Other Software Displays the [Other Software] window.
[Evernote] icon
Installs Evernote for Mac.
[SugarSync] icon
Opens the SugarSync Manager for Mac download web page.

Readme Displays the Readme file.

Troubleshooting (installation) Displays "Troubleshooting (installation)".

Operator's Guide Displays this manual.
57



Installing in Mac OS
■ ScanSnap Software

Install the following software:
ScanSnap Manager
ABBYY FineReader for ScanSnap
Cardiris

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap] window appears.

3. Double-click the [ScanSnap] icon.

A confirmation message appears.
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Installing in Mac OS
4. Click the [Continue] button.

The [Install ScanSnap] window appears, displaying the [Welcome to the ScanSnap 
Installer] screen.

5. Click the [Continue] button.

The [Important Information] screen appears.

6. Read [Important Information], and then click the [Continue] button.

The [Software License Agreement] screen appears.

7. Read the "END-USER LICENSE AGREEMENT", and click the [Continue] 
button.

A confirmation message appears.

8. To accept the license agreement, click the [Agree] button.

The [Cardiris License] screen appears.

9. Scroll down and read the "I.R.I.S. License Agreement" to the end, and 
then click the [Continue] button. 

A confirmation message appears.
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10.To accept the license agreement, click the [Agree] button.

The [Standard Install on "disk name"] screen appears.

11.Click the [Install] button.

An authentication window appears.

12.Enter the user name and password for a user with Administrator 
privileges, and click the [OK] button.

Installation starts. When the installation is complete, the [The installation was 
completed successfully.] screen appears.

13.Click the [Close] button.

14.Remove the Setup DVD-ROM from the DVD-ROM drive.

To install only ScanSnap Manager, clear the [ABBYY FineReader for ScanSnap] and 
[Cardiris] checkboxes in the [Custom install on "disk name"] screen which is displayed 
by clicking the [Customize] button.
ABBYY FineReader for ScanSnap or Cardiris cannot be installed on its own.
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■ Evernote for Mac

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap] window appears.

3. Double-click the [Other Software] icon.

The [Other Software] window appears.
61



Installing in Mac OS
4. Double-click the [Evernote] icon.

A confirmation message appears.

5. To accept the license agreement, click the [Agree] button.

A window to start installing Evernote for Mac appears.
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6. Drag the [Evernote] icon onto the [Applications] icon.

Evernote for Mac is copied into the [Applications] folder.

7. When the copying is finished, drag the Evernote icon on the desktop into 
the Trash.

8. Remove the Setup DVD-ROM from the DVD-ROM drive.

9. Prepare for the linkage with Evernote.

Start up Evernote and create a new Notebook.

If the installation is not successfully completed, select [Troubleshooting (installation)] in 
the [ScanSnap] window and refer to Troubleshooting (installation).
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■ SugarSync Manager for Mac

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges. 

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap] window appears.

3. Double-click the [Other Software] icon.

The [Other Software] window appears.

An Internet connection is required to install SugarSync Manager for Mac.
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4. Double-click the [SugarSync] icon.

A web browser starts up and the SugarSync Manager for Mac download web page 
opens.
Download and install SugarSync Manager for Mac.

5. When the installation is complete, remove the Setup DVD-ROM from the 
DVD-ROM drive.
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■ Adobe Acrobat

Install Adobe Acrobat in the following procedure.

1. Insert the Adobe Acrobat DVD-ROM into the DVD-ROM drive.

The DVD-ROM is detected automatically and [Adobe Acrobat 9 Pro] window 
appears.

2. Drag the [Adobe Acrobat 9 Pro] icon onto the [Applications] icon.

[Adobe Acrobat 9 Pro] is copied into the [Applications] folder.

Adobe Acrobat DVD-ROM for Mac OS is bundled with S1500M.
Adobe Acrobat can be used in the following operating systems:
- Mac OS X v10.6 (Adobe Acrobat 9.1 or later required)
- Mac OS X v10.5
- Mac OS X v10.4.11

Additional requirements are as follows:
- Safari 3.0.4 or later
- A display resolution of 1024 × 768 pixels or higher

Adobe Acrobat can display the scanned image through linkage with ScanSnap Manager. If the 
latest version of Adobe Acrobat is already installed on your computer, you do not need to install 
it again.

To remove the DVD-ROM, press the [ ] button or the [F12] key on the keyboard.
If the [Adobe Acrobat 9 Pro] window does not appear when you insert the Adobe 
Acrobat DVD-ROM into the DVD-ROM drive, double-click the [Adobe Acrobat 9 Pro] 
icon on the desktop.
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3. When the copying is finished, install Adobe Acrobat in the following 
procedure.

1. Double-click the [Applications] icon.
2. Open the [Adobe Acrobat 9 Pro] folder in the [Applications] folder.
3. Double-click the [Adobe Acrobat Pro] icon and follow the instructions on the screen 

to continue with the installation.

4. When the installation is complete, remove the Adobe Acrobat DVD-ROM 
from the DVD-ROM drive.

For details about the installation of Adobe Acrobat, click [Read Me] on the [Adobe 
Acrobat 9 Pro] dialog box in step 2. and read the installation instructions.
For details about how to use Adobe Acrobat, refer to Adobe Acrobat Help.
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This chapter explains how to perform scanning, configure scan settings, add, change or 
delete profiles, as well as various scanner functions and uses.

ScanSnap Manager Icon and Operations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

How to Perform a Scan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Configuring ScanSnap Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

Actions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

Using the ScanSnap in Various Ways . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 218
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ScanSnap Manager Icon and Operations

All operations on the ScanSnap are managed in ScanSnap Manager.
The ScanSnap Manager icon automatically appears on the taskbar when Windows starts up.
The ScanSnap Manager icon indicates whether or not ScanSnap Manager is successfully 
communicating with the ScanSnap. The appearance of the icon changes according to the 
communication status as shown below.

A menu appears when you click the ScanSnap Manager icon.

Status ScanSnap Manager icon

Communicating

Not communicating

In Windows 7, the ScanSnap Manager icon  is displayed in the menu which appears when 

you click  on the taskbar.

To have the ScanSnap Manager icon  always displayed on the taskbar, drag the icon  and 
drop it onto the taskbar.
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■ Right-Click Menu

This menu appears when you right-click the ScanSnap Manager icon .

Item Function

Duplex Scan Scans both sides of the document. Follows the settings configured in [Scan 
Button Settings].

Simplex Scan Scans only one side of the document. Follows the settings configured in [Scan 
Button Settings].

Scan Button Settings Displays the ScanSnap setup dialog box.
You can configure the scan settings in this dialog box.

"How to Configure Scan Settings" (page 87)

Profile Management Displays the [ScanSnap Manager - Profile Management] dialog box.
You cannot select [Profile Management] when the [Use Quick Menu] check box is 
selected in the ScanSnap setup dialog box.

"Profile Management" (page 90)

Show scanning 
results

After scanning is completed, a message appears to inform you whether blank 
pages are removed or the image is rotated.

Check consumable 
status

Displays the [ScanSnap Manager - Check consumable status] dialog box.
You can reset the consumable counters after replacing the consumables.

"Consumables" (page 430)

Help Displays the following menu:
Help
Opens the ScanSnap Manager Help.
Troubleshooting
Displays [Troubleshooting] in the ScanSnap Manager Help.
ScanSnap Portal Site
Opens the ScanSnap global homepage (http://scansnap.fujitsu.com/).
About ScanSnap Manager
Displays the [ScanSnap Manager - Version Information] dialog box.
Preferences
Displays the [ScanSnap Manager - Preferences] dialog box.
Online Update
Displays the [ScanSnap Manager - Online Update] dialog box (page 446).

Exit Exits ScanSnap Manager.
"Finishing ScanSnap Operation" (page 83)

Right-click
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■ Left-Click Menu

This menu appears when you left-click the ScanSnap Manager icon .
Available profiles are displayed in the Left-Click Menu.

Select a profile in the Left-Click Menu before you perform scanning. Documents are scanned 
according to the scan settings of the selected profile.
For details about how to add, change or delete profiles, refer to "Profile Management" (page 
90).

To enable the Left-Click Menu, clear the [Use Quick Menu] check box in the ScanSnap setup 
dialog box. The Left-Click Menu does not appear when this check box is selected.
Profiles configured for the following scanner models will be carried over to ScanSnap S1500/
S1500M if the computer is the same:
- ScanSnap S1300
- ScanSnap S1100
- ScanSnap S510
- ScanSnap S500
- ScanSnap S300

Left-click
Left-Click Menu example
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How to Perform a Scan

This section explains how to perform scanning with the ScanSnap.

■ Preparation

1. Turn on the computer.

The ScanSnap Manager icon  appears on the taskbar when Windows starts up.

If the ScanSnap Manager icon  is not displayed, select [Start] menu → [All 
Programs] → [ScanSnap Manager] → [ScanSnap Manager] to start up ScanSnap 
Manager. Normally, ScanSnap Manager is registered under [Startup] when installed so 

its icon  is displayed on the taskbar when Windows starts.
When ScanSnap Manager is not registered under [Startup], register ScanSnap 
Manager in the following procedure:
1. Select [Help] → [Preferences] in the Right-Click Menu.

[ScanSnap Manager - Preferences] dialog box appears.
2. In the [Auto Startup] tab, select the [Start up ScanSnap Manager when you log on] 

check box.

In Windows 7, the ScanSnap Manager icon  is displayed in the menu which appears 

when you click  on the taskbar.

For details about how to display the ScanSnap Manager icon  on the taskbar, refer 
to "ScanSnap Manager Icon and Operations" (page 69).
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2. Open the ADF paper chute (cover) of the ScanSnap to turn the power on.

The ScanSnap Manager icon changes from  to .

There are two ways to perform scanning, either with the Quick Menu or without using the 
Quick Menu. For details, refer to the following:

Using the Quick Menu (→ page 73)
Without Using the Quick Menu (→ page 79)

■ Using the Quick Menu

The following explains the procedure for scanning by using the Quick Menu.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. Select the [Use Quick Menu] check box.

There may be a slight delay before the ScanSnap Manager icon changes to  depending 
on your computer's performance, operating environment and load such as when multiple 
programs are running at the same time.

ADF paper chute 
(cover)
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3. Click one of the profile buttons.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

Profile Button Description

[Recommended] button Settings are [Automatic resolution] for [Image quality] in the [Scanning] 
tab in the ScanSnap setup dialog box and default for other settings.
It is recommended that you select this button when you want to scan 
documents in optimum quality suitable for the paper size of the 
document.

[Small File] button Settings are [Normal] (Color/Gray: 150 dpi, B&W: 300 dpi) for [Image 
quality] in the [Scanning] tab in the ScanSnap setup dialog box and 
default for other settings.
It is recommended that you select this button when you want to reduce 
the file size.

[High Quality] button Settings are [Best] (Color/Gray: 300 dpi, B&W: 600 dpi) for [Image 
quality] in the [Scanning] tab in the ScanSnap setup dialog box and 
default for other settings.
It is recommended that you select this button when you want to scan 
documents in high quality.

[Customize] button Default settings are the same as the [Recommended] settings.
Scan settings can be changed depending on your scanning purpose.

The [Recommended] button is selected in default.
For details about the default settings when using the Quick Menu, refer to the 
ScanSnap Manager Help.
You cannot change the settings for the [Recommended], [Small File], and [High Quality] 
buttons. If you change any of these settings, the profile automatically switches to 
[Customize].
For details about how to change scan settings, refer to "How to Configure Scan 
Settings" (page 87).

Profile Button
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6. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan] button on the ScanSnap flashes in blue throughout the scan.
The [ScanSnap Manager - Image scanning and file saving] dialog box appears.

The Quick Menu appears when the scanning is completed.

The [Scan] button setting is [Duplex Scan (Double-sided)] in default. Note that you can 
switch the [Scan] button setting to [Simplex Scan (Single-sided)] in ScanSnap 
Manager.
For more details, refer to "Scanning Only One Side of a Document" (page 218).
You can also start scanning from the Right-Click Menu.
For more details, refer to "Right-Click Menu" (page 70).

Do not connect or disconnect the ScanSnap and other USB devices during scanning.
Do not close the ADF paper chute (cover) during scanning.
Do not switch users during scanning. Doing so will cancel scanning.
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7. In the Quick Menu, click the icon of the application to link with ScanSnap 
Manager.

The selected application starts up.

To specify which applications to display/hide in the Quick Menu, or change the display 
order of the applications, refer to "Quick Menu Settings" (page 84).
To select an application to link with ScanSnap Manager before scanning, refer to 
"Without Using the Quick Menu" (page 79).

Application Description

Scan to ScanSnap 
Organizer (*1)

Displays the [ScanSnap Organizer] dialog box.
Saves the scanned images in a folder specified in ScanSnap 
Organizer.
For details about how to operate ScanSnap Organizer, refer to 
the ScanSnap Organizer User's Guide.

Scan to CardMinder (*2) Displays the [CardMinder] dialog box.
Saves the scanned images in CardMinder.
For details about how to continue the process after you select 
this item, refer to "Storing Business Cards in CardMinder" (page 
147).

Scan to Folder Displays the [Scan to Folder] dialog box.
You can specify the destination folder to save the scanned 
images.
For details about how to continue the process after you select 
this item, refer to "Saving Data in a Specified Folder" (page 
108).

Scan to E-mail Displays the [Scan to E-mail] dialog box.
Attaches the scanned images to an e-mail message.
For details about how to continue the process after you select 
this item, refer to "Attaching Files to E-Mail" (page 115).
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Scan to Print Displays the [Scan to Print] dialog box.
Prints out the scanned images with a specified printer.
For details about how to continue the process after you select 
this item, refer to "Using the ScanSnap as a Copy Machine" 
(page 124).

Scan to Rack2-Filer (*3) Creates a PDF file from the scanned image data and saves the 
file in a Rack2-Filer binder.
For details about how to continue the process after you select 
this item, refer to "Saving to Rack2-Filer" (page 161).

Scan to Mobile (*4) (*5) Displays the [Scan to Mobile] dialog box.
You can save the scanned images to a mobile device.
For details about how to continue the process after you select 
this item, refer to "Saving Data to a Mobile Device" (page 206).

Scan to Evernote 
(Document) (*5) (*6)

You can save PDF files created from the scanned images to 
Evernote.
For details about how to continue the process after you select 
this item, refer to "Saving Documents to Evernote" (page 167).

Scan to Evernote (Note) 
(*5) (*6)

You can save JPEG files created from the scanned images to 
Evernote.
For details about how to continue the process after you select 
this item, refer to "Saving Handwritten Notes to Evernote" (page 
174).

Scan to Google Docs(TM) 
(*4) (*5)

You can save PDF files created from the scanned images to 
Google Docs.
For details about how to continue the process after you select 
this item, refer to "Saving Documents to Google Docs" (page 
179).

Scan to Salesforce 
Chatter (*4) (*5)

You can post scanned images to Salesforce Chatter.
For details about how to continue the process after you select 
this item, refer to "Posting to Salesforce Chatter" (page 188).

Scan to SugarSync (*5) 
(*7)

You can save scanned images to your SugarSync folder.
For details about how to continue the process after you select 
this item, refer to "Saving Data to Your SugarSync Folder" 
(page 199).

Scan to Word (*8) Creates a Word file by converting the scanned images into text 
data.
For details about how to continue the process after you select 
this item, refer to "Converting into Word/Excel/PowerPoint 
Documents" (page 138).

Scan to Excel (*8) Creates an Excel file by converting the scanned images into text 
data.
For details about how to continue the process after you select 
this item, refer to "Converting into Word/Excel/PowerPoint 
Documents" (page 138).

Scan to PowerPoint(R) 
(*8)

Creates a PowerPoint file by converting the scanned images 
into text data.
For details about how to continue the process after you select 
this item, refer to "Converting into Word/Excel/PowerPoint 
Documents" (page 138).

Application Description
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*1 : Displayed when ScanSnap Organizer is installed.
*2 : Displayed when CardMinder is installed.
*3 : Displayed when Rack2-Filer trial version (bundled with the ScanSnap) or Rack2-Filer (V5.0 or 

later recommended/bundled model or sold separately) is installed.
*4 : Displayed when .NET Framework 3.0 is installed.

Note that .NET Framework 3.0 is also included in .NET Framework 3.5 (SP1 or later). 
It is recommended that you use .NET Framework 3.5 (SP1 or later) by updating Windows.
If .NET Framework 4 or later is already installed, you need to install .NET Framework 3.0 
separately because .NET Framework 3.0 is not included in the .NET Framework 4 or later 
version.

*5 : Not displayed in Windows 2000.
*6 : Displayed when Evernote for Windows 3.5 or later is installed.
*7 : Displayed when SugarSync Manager for Windows 1.9.28 or later is installed.
*8 : Displayed when ABBYY FineReader for ScanSnap is installed.
*9 : Displayed when Scan to Microsoft SharePoint is installed. 

Scan to SharePoint (*9) Saves the scanned images in SharePoint or Office Live.
For details about how to continue the process after you select 
this item, refer to "Saving Data in SharePoint" (page 152).

Scan to Picture Folder Displays the [Scan to Picture Folder] dialog box.
Saves JPEG files created from the scanned images in your 
Pictures folder.
For details about how to continue the process after you select 
this item, refer to "Saving Files to Picture Folder" (page 131).

The output image may slightly differ from the original document in size.
Performing a scan by pressing the [Scan] button on the ScanSnap while one of the 
following applications is active (with its window brought to front and selected on 
taskbar) automatically starts the linkage between ScanSnap Manager and the 
application:
- ScanSnap Organizer
- CardMinder (links with ScanSnap Manager only when the document is of business 

card size)
- Rack2-Filer trial version (bundled with the ScanSnap) or Rack2-Filer (V5.0 or later 

recommended/bundled model or sold separately)
- Scan to Mobile

For details about automatic linkage, refer to "Automatic Linkage with Applications" 
(page 99).

You cannot start scanning when the Quick Menu is displayed. Either select an icon from 
the Quick Menu and finish the process, or close the Quick Menu before you perform the 
next scan.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

Application Description
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■ Without Using the Quick Menu

The following explains the procedure for scanning without using the Quick Menu.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. Clear the [Use Quick Menu] check box.
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3. Select a profile.

Select a profile from either of the following:

[Profile] drop-down list

Left-Click Menu

4. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).
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5. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan] button on the ScanSnap flashes in blue throughout the scan.
The [ScanSnap Manager - Image scanning and file saving] dialog box appears.

The application specified for the selected profile starts up.

The [Scan] button setting is [Duplex Scan (Double-sided)] in default. Note that you can 
switch the [Scan] button setting to [Simplex Scan (Single-sided)] in ScanSnap 
Manager. 
For more details, refer to "Scanning Only One Side of a Document" (page 218).
You can also start scanning from the Right-Click Menu.
For more details, refer to "Right-Click Menu" (page 70).

Do not connect or disconnect the ScanSnap and other USB devices during scanning.
Do not close the ADF paper chute (cover) during scanning.
Do not switch users during scanning. Doing so will cancel scanning.

To select an application to link with ScanSnap Manager in the Quick Menu after 
scanning is completed, refer to "Using the Quick Menu" (page 73).
When the [Set the marked text as a keyword for the PDF file] or the [Convert to 
Searchable PDF] check box is selected in the [File option] tab, the application starts 
after text recognition has been performed on the scanned image.
A dialog box showing the text recognition progress appears.
By default, documents are scanned with the following settings: [Image quality: 
Automatic resolution] and [Color mode: Auto color detection].
For details about how to change scan settings, refer to "How to Configure Scan 
Settings" (page 87).
The application that starts after scanning varies depending on what is selected in the 
[Application] tab in the ScanSnap setup dialog box. For details, refer to the ScanSnap 
Manager Help. 
The output image may slightly differ from the original document in size.
When ScanSnap Organizer, CardMinder or Rack2-Filer becomes active (with the 
application’s dialog box brought to front and selected on taskbar), performing a scan by 
pressing the [Scan] button automatically starts the linkage between ScanSnap 
Manager and the active application.
- ScanSnap Organizer
- CardMinder (links with ScanSnap Manager only when the document is of business 

card size)
- Displayed when Rack2-Filer trial version (bundled with the ScanSnap) or Rack2-

Filer (V5.0 or later recommended/bundled model or sold separately) is installed.
- Scan to Mobile

For details about automatic linkage, refer to "Automatic Linkage with Applications" 
(page 99).
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■ Stopping the Scan

You can stop a scan in progress in case you are scanning a wrong document or the wrong 
side of a document.
Stop the scan in the following procedure:

1. Click the [Stop] button in the [ScanSnap Manager - Image scanning and 
file saving] dialog box which appears during scanning.

The following message appears when the scanning stops.

2. Click the [Quit] button.

To continue scanning, click the [Continue Scanning] button or press the [Scan] button 
on the ScanSnap after loading another document in the ScanSnap.

Remove all documents from the ScanSnap after stopping the scan. 
For details about how to remove documents, refer to "Troubleshooting" in the ScanSnap 
Manager Help.
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■ Finishing ScanSnap Operation

Exiting ScanSnap Manager
Select [Exit] from the Right-Click Menu.
Normally, you do not have to exit ScanSnap Manager.

Disconnecting the ScanSnap

1. Close the ADF paper chute (cover) to turn off the ScanSnap.

The ScanSnap Manager icon on the taskbar changes from  to .

2. Unplug the USB cable from the computer.

3. Unplug the power cable of the ScanSnap from the AC outlet.

You cannot use the ScanSnap after exiting ScanSnap Manager.
Select [Start] menu → [All Programs] → [ScanSnap Manager] → [ScanSnap Manager] to 
start up ScanSnap Manager when you want to use the ScanSnap.

The ScanSnap does not have a power switch and is turned ON/OFF in conjunction with the 
computer's power. The ScanSnap can also be automatically turned ON/OFF by opening or 
closing the ADF paper chute (cover).
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Configuring ScanSnap Manager

This section explains how to specify which applications to display in the Quick Menu, set scan 
settings, how to add, change and delete profiles, automatic linkage with applications, 
scanning progress status, and dialog boxes displayed during scanning.

■ Quick Menu Settings

You can specify which applications to display or hide in the Quick Menu, as well as change 
the display order of the applications in the following procedure.

1. Click [Applications to Show/Hide] in the Quick Menu.

For details about how to display the Quick Menu, refer to "Using the Quick Menu" (page 
73).

The [Applications to Show/Hide] dialog box appears.
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2. Specify which applications to display in the Quick Menu.

Showing or Hiding Application Icons
The icons of the applications listed under [Show] are displayed in the Quick Menu.
When you select an application in [Show] and click the [Remove] button, the application 
is moved to [Hide]. Likewise, when you select an application in [Hide] and click the [Add] 
button, the application is moved to [Show].
To display all the applications in the Quick Menu, click the [Restore Default] button.

Display Order of Applications
Application icons are displayed in the Quick Menu in the same order as they are listed in 
[Show].
You can change the display order of an application by selecting an application in [Show] 
and clicking either the [Up] or [Down] button.
To restore the default display order of the applications displayed in the Quick Menu, 
click the [Restore Default] button.
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The applications are displayed in the order shown below in the Quick Menu and in 
[Show] of the [Applications to Show/Hide] dialog box.

3. Click the [OK] button to close the [Applications to Show/Hide] dialog 
box.

The applications to be displayed in the Quick Menu and their display order are set.
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■ How to Configure Scan Settings

You can configure scan settings in the ScanSnap setup dialog box depending on your 
intended use in the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. Click the [Detail] button to switch to the detail view mode.

Using the Quick Menu

Without using the Quick Menu

You can also open the ScanSnap setup dialog box by the following ways:

Double-click the ScanSnap Manager icon .
Press [Ctrl], [Shift], and [Space] keys simultaneously.

The ScanSnap setup dialog box retains the display status from the last time the ScanSnap 
was used. For example, if it was closed in detail view mode, the dialog box is displayed in 
detail view mode next time you open it.

Outline view Detail view

Outline view Detail view
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3. Change the scan settings in each tab.

The following items can be configured in each tab:
For details, refer to the ScanSnap Manager Help.

[Application] tab
- Application to be used with the ScanSnap
[Save] tab
- Folder in which scanned image is saved
- File name used for saving the scanned image
[Scanning] tab
- Scanning

(Which image quality to scan with, use color, gray or black & white, scan in 
simplex or duplex mode, enable or disable [Setting for text only document], [Allow 
automatic blank page removal], [Correct skewed character strings automatically], 
[Allow automatic image rotation], [Set the document with its face up] and 
[Continue scanning after current scan is finished].)

[File option] tab
- File format of the scanned image (*.pdf, *.jpg)
- Whether to perform text recognition on a marked character string in the scanned 

image and add the character string as a keyword for the PDF file
(Whether to perform text recognition only on the character strings in the first 
marked section or all marked sections to be added as keywords, and in which 
language to perform text recognition.)

- Whether to perform text recognition on character strings in the scanned image to 
convert the file to a searchable PDF file
(Whether to convert the first page only or all pages, and in which language to 
perform text recognition.)

- Whether to create separate PDF files
(Whether to include all scanned images in a single PDF file, or create PDF files, 
each of which including a preset number of pages)

- Whether to password-protect the created PDF files
(Whether to set the same password for all PDF files, or set a different password 
per scan.)
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[Paper] tab
- Paper size of documents (paper size selection, Carrier Sheet settings)
- Whether to detect multifeed
[Compression] tab
- File size of the scanned image (compression rate)

4. Click the [OK] or [Apply] button.

When you use the Quick Menu, scan settings for the [Customize] button are 
changed.
When you do not use the Quick Menu, scan settings for the currently selected profile 
are changed.

Scan settings vary depending on the scanning method.
For details about items that can be set, refer to "Setting Items With/Without the Quick 
Menu" (page 457).

If you press the [Scan] button on the ScanSnap while the ScanSnap setup dialog box is 
displayed, the ScanSnap setup dialog box closes and scanning starts. Scan setting 
changes made up to this point are saved and documents are scanned by these settings.
Note that when other dialog boxes are open, scanning does not start even if you press the 
[Scan] button on the ScanSnap unless open dialog boxes are closed. 
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■ Profile Management

You can manage up to 20 profiles.
You can select a profile in the [Profile] drop-down list in the ScanSnap setup dialog box or 
from the Left-Click Menu.

[Profile] drop-down list

Left-Click Menu

Once the frequently used scan settings are saved as profiles, you do not have to open the 
ScanSnap setup dialog box to change scan settings every time you perform scanning. You 
can easily switch to an appropriate profile you want by just selecting it.
For details about how to add, change or delete profiles, refer to the following:

To add a new profile (→ page 91)
To change scan settings for profiles (→ page 94)
To rename a profile (→ page 96)
To delete a profile (→ page 98)

To use a profile, you need to clear the [Use Quick Menu] check box in the ScanSnap setup 
dialog box.
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Adding Profiles

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. Configure the scan settings in each tab.

For details about each tab, refer to the ScanSnap Manager Help.

Clear the [Use Quick Menu] check box if it is selected.
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3. Select [Add Profile] from the [Profile] drop-down list.

The [Add new profile] dialog box appears.

4. Type in a new profile name and click the [OK] button.

The added profile appears in the [Profile] drop-down list in the ScanSnap setup 
dialog box.
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5. Click the [OK] button to close the ScanSnap setup dialog box.

Up to 20 profiles can be saved including the [Standard] profile.
You can change the display order of profiles except for the [Standard] profile.
1. Select [Profile Management] from the Right-Click Menu or the [Profile] drop-down 

list in the ScanSnap setup dialog box.
The [ScanSnap Manager - Profile Management] dialog box appears.

2. Select a profile from the list to arrange profiles in a different order.
3. Click the [Up] or [Down] button to move the profile to its desired position in the list.

4. Click the [Close] button to close the [ScanSnap Manager - Profile Management] 
dialog box.
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Changing Profile Settings

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. Select a profile from the [Profile] drop-down list.

3. Change the scan settings in each tab.

For details about each tab, refer to the ScanSnap Manager Help.

Clear the [Use Quick Menu] check box if it is selected.
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4. When you finish changing the settings for the selected profile, click the 
[OK] button.

A confirmation message appears.

5. To overwrite the profile, click the [Yes] button. To save the settings as 
“Standard”, click the [No] button.

If you select another profile from the [Profile] drop-down list before clicking the [OK] 
button, the following message appears.

When you click the [Yes] button, the modified settings are overwritten and the profile 
switches to the one you selected from the [Profile] drop-down list.
When you click the [No] button, the modified settings are canceled and the profile 
switches to the one you selected from the [Profile] drop-down list.

The confirmation message does not appear when the [Standard] profile is selected in step 
2.
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Renaming Profiles

1. Select [Profile Management] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The [ScanSnap Manager - Profile Management] dialog box appears.

2. Select a profile and click the [Rename] button.

The [Rename] dialog box appears.

If you cannot select [Profile Management] in the Right-Click Menu, clear the [Use 
Quick Menu] check box in the ScanSnap setup dialog box.
You can also display the [ScanSnap Manager - Profile Management] dialog box by 
selecting [Profile Management] from the [Profile] drop-down list in the ScanSnap 
setup dialog box.

The [Standard] profile cannot be renamed.
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3. Type in a new name, and click the [OK] button.

The profile is renamed.

4. Click the [Close] button to close the [ScanSnap Manager - Profile 
Management] dialog box.
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Deleting Profiles

1. Select [Profile Management] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The [ScanSnap Manager - Profile Management] dialog box appears.

2. Select a profile and click the [Delete] button.

The [Delete Profile] dialog box appears.

3. Click the [Yes] button.

The selected profile is deleted.

4. Click the [Close] button to close the [ScanSnap Manager - Profile 
Management] dialog box.

If you cannot select [Profile Management] in the Right-Click Menu, clear the [Use 
Quick Menu] check box in the ScanSnap setup dialog box.
You can also display the [ScanSnap Manager - Profile Management] dialog box by 
selecting [Profile Management] from the [Profile] drop-down list in the ScanSnap 
setup dialog box.

The [Standard] profile cannot be deleted.
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■ Automatic Linkage with Applications

When one of the applications which can automatically link with ScanSnap Manager is running 
and you perform scanning, ScanSnap Manager will automatically link with the corresponding 
application regardless of the current scan settings or whether you are using the Quick Menu.
Applications that can automatically link with ScanSnap Manager are as follows:

ScanSnap Organizer
Scanned image is displayed in ScanSnap Organizer.
CardMinder
Scanned image is displayed in CardMinder.
Rack2-Filer trial version (bundled with the ScanSnap) or Rack2-Filer (V5.0 or later 
recommended/bundled model or sold separately)
Scanned image is saved in a binder in Rack2-Filer.
Scan to Mobile (*)
Scanned image is sent to a mobile device.

* : Automatic linkage is available only when the application is active.

There are two modes for automatic linkage.

Link when one of the above applications is active (recommended)
When ScanSnap Organizer, CardMinder or Rack2-Filer becomes active (with the 
application’s dialog box brought to front and selected on taskbar), performing a scan by 
pressing the [Scan] button automatically starts the linkage between ScanSnap Manager 
and the active application.

The example above shows ScanSnap Manager automatically linking with ScanSnap 
Organizer when ScanSnap Organizer’s main window is in front (active).

Active

Not active
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Always link when one of the above applications is running
When ScanSnap Organizer, CardMinder, or Rack2-Filer is started, the application 
specified for [Application] in the [Application] tab in the ScanSnap dialog box 
automatically switches to the running application. The application will automatically link 
with ScanSnap Manager even when the application window is minimized or not 
displayed in the front. The linkage between the application and ScanSnap Manager 
automatically ends once you exit the application.
When more than one application is running at the same time, priority will be given in the 
following order:

- CardMinder
- ScanSnap Organizer
- Rack2-Filer trial version (bundled with the ScanSnap) or Rack2-Filer (V5.0 or 

later recommended/bundled model or sold separately)
When the Quick Menu is disabled, the name of the interacting application on the Left- 
Click Menu is followed by "is interacting".

When ScanSnap Manager automatically links with CardMinder, business cards are 
scanned with the current settings. If there are some settings that are not supported 
by CardMinder, defaults settings are used.
For details about CardMinder default settings, refer to the ScanSnap Manager Help.
ScanSnap Manager links with CardMinder only when the document is of business 
card size.
When documents in other sizes are scanned, the following error message appears.

When ScanSnap Organizer is automatically interacting with 
ScanSnap Manager
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Changing Automatic Linkage Mode
Change automatic linkage mode options in the following procedure.

1. Select [Help] → [Preferences] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
[ScanSnap Manager - Preferences] dialog box appears.

2. Select the automatic linkage mode in the [Automatic Linkage] tab.

3. Click the [OK] button to close the [ScanSnap Manager - Preferences] 
dialog box.

Application will link with ScanSnap Manager using the linkage mode you selected.
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■ ScanSnap's Communication Status

If you turn the ScanSnap ON/OFF when ScanSnap Manager is running, the pop-up balloon 
appearing from the taskbar icon notifies you of the communication status of the ScanSnap.

When the ScanSnap is on

When the ScanSnap is off

Receiving or hiding the ScanSnap's communication status 
notifications
You can specify whether or not to receive notifications of the ScanSnap’s communication 
status with a pop-up balloon.
Configure the setting in the following procedure.

1. Select [Help] → [Preferences] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
[ScanSnap Manager - Preferences] dialog box appears.

To disable notifications of the ScanSnap’s communication status, click the pop-up 
balloon and clear the [Notify of the communication status] check box in the [ScanSnap 
Manager - Preferences] dialog box that appears.
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2. In the [Status Display] tab, either select or clear the [Notify of the 
communication status] check box.

If you select the [Notify of the communication status] check box, you will be notified of 
the communication status in conjunction with the ScanSnap being turned ON/OFF.
If you clear the [Notify of the communication status] check box, you will not be notified of 
the communication status.

3. Click the [OK] button to close the [ScanSnap Manager - Preferences] 
dialog box.
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■ Showing the Scanning Progress

When scanning starts, the [ScanSnap Manager - Image scanning and file saving] dialog box 
appears.
The [ScanSnap Manager - Image scanning and file saving] dialog box consists of the 
following:

Scan status
Scan settings
Save completed
Preview

Also, note that you can stop scanning by clicking the [Stop] button in the [ScanSnap Manager 
- Image scanning and file saving] dialog box.
For details about how to stop scanning, refer to "Stopping the Scan" (page 82).

The [ScanSnap Manager - Image scanning and file saving] dialog box closes automatically 
after saving the scanned image of the last page scanned.
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Hiding the Scanning Progress Status
You can hide the [ScanSnap Manager - Image scanning and file saving] dialog box in the 
following procedure.

1. Select [Help] → [Preferences] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The [ScanSnap Manager - Preferences] dialog box appears.

2. In the [Status Display] tab, clear the [Show the scan progress status 
(recommended)] check box.

3. Click the [OK] button to close the [ScanSnap Manager - Preferences] 
dialog box.

The [ScanSnap Manager - Image scanning and file saving] dialog box is hidden from 
next scanning on.

When the scanning progress status dialog box is hidden, the ScanSnap Manager icon 

alternates between  and .
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Actions

The ScanSnap has functions useful in your office work available as Actions.
Actions allow you to:

Share the scanned document files with others.
Save the scanned image directly in a shared folder on a network after scanning, share 
the scanned image with others and inform them of the destination folder path by an e-
mail message automatically created with the path stated.

 Send document files to participants of a meeting via e-mail.
Send an e-mail message to others with the scanned image file attached.

Use a printer rather than a copy machine to make copies of documents.
Print the scanned image with a printer.

Convert catalogs and pamphlets into digital data and save them.
Save scanned images of catalogs and pamphlets directly into your Pictures folder.

Quote text from your paper documents when you do not want to type it.
Have the scanned image text recognized and converted into a Word, Excel, or 
PowerPoint document.

File and organize a large number of business cards.
Store and manage business cards in CardMinder. 

Share the scanned document files through linkage with SharePoint.
Save the scanned image in SharePoint and Office Live.

Convert your paper documents into digital data to conveniently 
organize them.
Save the scanned image directly in Rack2- Filer to manage and organize it.

Manage scanned documents through linkage with Evernote.
Save PDF files in Evernote and access them easily anytime, anywhere.

 Manage handwritten notes through linkage with Evernote.
Save JPEG files in Evernote and access them easily anytime, anywhere.

Manage scanned documents through linkage with Google Docs.
Save PDF files in Google Docs and access them easily anytime, anywhere.

Manage scanned documents through linkage with Salesforce Chatter.
Post scanned image files to Salesforce Chatter and manage them with Salesforce 
CRM.
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Manage scanned documents through linkage with SugarSync.
Save scanned image files to your SugarSync folder and access them easily anytime, 
anywhere.

Save scanned documents to a mobile device.
Save scanned image files to a connected mobile device. You can access the saved files 
through linkage with an application that can view PDF or JPEG files.

The following are explanations on how to use Actions.
107



Actions (for Windows Users)
■ Saving Data in a Specified Folder

This section explains how to save the scanned image file in a specified folder.
You can save the scanned image file in a shared folder on the network and share it with 
others. In addition, you can inform others of the destination folder path by an e-mail message 
automatically created with the path stated.

For details about the procedure to scan and save the scanned image in a specified folder 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 109)
Without Using the Quick Menu (→ page 112)

The default e-mail program is used as the e-mail program to link with.
The e-mail program may not properly link with ScanSnap Manager even if it is the default e-mail 
program. In this case, contact the manufacturer of the e-mail software.
Configure e-mail program settings in the following procedure.

Windows 7/Windows Vista
1. Select [Start] menu → [Default Programs] → [Set your default programs].

The [Set your default programs] dialog box appears.
2. Select an e-mail program to link with ScanSnap Manager from [Programs].
3. Select [Set this program as default] and click the [OK] button.

Windows XP/Windows 2000
The e-mail program selected in Internet Explorer [Tools] menu → [Internet Options] → the 
[Programs] tab → [E-mail] drop-down list is used to link with ScanSnap Manager.
If no e-mail program is selected, select an e-mail program to link with ScanSnap Manager in 
the [E-mail] drop-down list. E-mail programs that cannot be selected here cannot be set to 
link with ScanSnap Manager.

Tested e-mail programs
- Windows Live Mail
- Windows Mail (Windows Vista)
- Outlook 2010 / 2007 / 2003
- Outlook Express 6
- Thunderbird version 3.1
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Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Click the [Scan to Folder] icon.

The [Scan to Folder] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to"Using the Quick 
Menu" (page 73).
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4. Check the scanned image in the preview area.

In the [Scan to Folder] dialog box, you can change files names, destination folders, and 
specify whether to state a path to a destination folder in an e-mail message to notify 
others.
For details about the [Scan to Folder] dialog box, refer to the ScanSnap Manager Help.

Preview
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5. Click the [Save] button.

The scanned image file is saved in the specified folder.
When you select the [State a path to a destination folder in an E-mail message] 
check box in the [Scan to Folder] dialog box, a new message window appears listing 
the destination folder path where the file is saved.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Folder] dialog box is closed. Close the [Scan to Folder] dialog box before scanning the 
next document.
Do not move, delete, or rename scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to Folder] dialog box is closed.
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Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Folder].

3. Click the [OK] button to close the ScanSnap setup dialog box.

4. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

5. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan to Folder] dialog box appears when the scanning is completed.

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

ScanSnap Manager also links with [Scan to Folder] when you select:
[Scan to Folder] from the [Profile] drop-down list of the ScanSnap setup dialog box
[Scan to Folder] from the Left-Click Menu
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6. Check the scanned image in the preview area.

In the [Scan to Folder] dialog box, you can change files names, destination folders, and 
specify whether to state a path to a destination folder in an e-mail message to notify 
others.
For details about the [Scan to Folder] dialog box, refer to the ScanSnap Manager Help.

Preview
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7. Click the [Save] button.

The scanned image file is saved in the specified folder.
When you select the [State a path to a destination folder in an E-mail message] 
check box in the [Scan to Folder] dialog box, a new message window appears listing 
the destination folder path where the file is saved.

You cannot start scanning when the [Scan to Folder] dialog box is displayed. Close the 
dialog box before scanning the next document.
Do not move, delete or rename scanned image in other applications when the [Scan to 
Folder] dialog box is displayed.
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■ Attaching Files to E-Mail

This section explains how to attach the scanned image file to an e-mail message.

For details about the procedure to scan and attach the scanned image to an e-mail message 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 116)
Without Using the Quick Menu (→ page 120)

The default e-mail program is used as the e-mail program to link with.
The e-mail program may not properly link with ScanSnap Manager even if it is the default e-mail 
program. In this case, contact the manufacturer of the e-mail software.
Configure e-mail program settings in the following procedure.

Windows 7/Windows Vista
1. Select [Start] menu → [Default Programs] → [Set your default programs].

The [Set your default programs] dialog box appears.
2. Select an e-mail program to link with ScanSnap Manager from [Programs].
3. Select [Set this program as default] and click the [OK] button.

Windows XP/Windows 2000
The e-mail program selected in Internet Explorer [Tools] menu → [Internet Options] → the 
[Programs] tab → [E-mail] drop-down list is used to link with ScanSnap Manager.
If no e-mail program is selected, select an e-mail program to link with ScanSnap Manager in 
the [E-mail] drop-down list. E-mail programs that cannot be selected here cannot be set to 
link with ScanSnap Manager.

Tested e-mail programs
- Windows Live Mail
- Windows Mail (Windows Vista)
- Outlook 2010 / 2007 / 2003
- Outlook Express 6
- Thunderbird version 3.1
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Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to E-mail] (If you do not want to change 
any settings, go to step 4.).

1. Move the mouse cursor to the  mark on the [Scan to E-mail] icon, and then select 
the [Settings] menu.

The [Scan to E-mail - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).

Up to ten files can be attached to an e-mail message.
When you scan more than one document with the scan settings shown below, multiple files 
are created. Pay attention to the number of documents to scan:

File format: JPEG (*.jpg)
[Generate one PDF file per (n) page(s)] check box is selected
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2. Change the settings.
For details about the [Scan to E-mail - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to E-mail - Options] dialog box.

4. Click the [Scan to E-mail] icon.

The [Scan to E-mail] dialog box appears.
If you clear the [Show preview] check box of the [Scan to E-mail - Options] dialog box 
in step 3., the [Scan to E-mail] dialog box is not displayed. Instead, a new message 
window appears with the file(s) attached.
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5. Check the scanned image in the preview area.

In the [Scan to E-mail] dialog box, you can rename the file, specify whether to set a "Document 
Open Password", and save the scanned image in the folder specified for [Image saving folder] 
after sending it by e-mail.
For details about the [Scan to E-mail] dialog box, refer to the ScanSnap Manager Help.

6. Click the [Attach] button.

When the [Set a "Document Open password" for PDF files] check box is selected in 
the [Scan to E-mail - Options] dialog box or the [Scan to E-mail] dialog box, the [Scan 
to E-mail - Set a password] dialog box appears.

Enter a password, and then click the [OK] button.

Preview
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An e-mail message window appears with the file attached.

The following message appears if you click the [Cancel] button in the [Scan to E-mail - 
Set a password] dialog box.

If you do not want to set a document open password, click the [Yes] button.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
E-mail] dialog box is closed. Close the [Scan to E-mail] dialog box before scanning the 
next document.
Do not move, delete, or rename scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to E-mail] dialog box is closed.
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Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to E-mail].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

ScanSnap Manager also links with [Scan to E-mail] when you select:
[Scan to E-mail] from the [Profile] drop-down list of the ScanSnap setup dialog box
[Scan to E-mail] from the Left-Click Menu
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3. Change the settings for [Scan to E-mail] (If you do not want to change 
any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to E-mail - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to E-mail - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to E-mail - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

Up to ten files can be attached to an e-mail message.
When you scan more than one document with the scan settings shown below, multiple files 
are created. Pay attention to the number of documents to scan:

File format: JPEG (*.jpg)
[Generate one PDF file per (n) page(s)] check box is selected
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6. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan to E-mail] dialog box appears when the scanning is completed.
If you clear the [Show preview] check box of the [Scan to E-mail - Options] dialog box 
in step 3., the [Scan to E-mail] dialog box is not displayed. Instead, a new message 
window appears with the file(s) attached.

7. Check the scanned image in the preview area.

In the [Scan to E-mail] dialog box, you can rename the file, specify whether to set a 
“Document Open Password”, and save the scanned image in the folder specified for [Image 
saving folder] after sending it by e-mail.
For details about the [Scan to E-mail] dialog box, refer to the ScanSnap Manager Help.

Preview
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8. Click the [Attach] button.

When the [Set a “Document Open password” for PDF files] check box is selected in 
the [Scan to E-mail - Options] dialog box or the [Scan to E-mail] dialog box, the [Scan 
to E-mail - Set a password] dialog box appears.

Enter a password, and then click the [OK] button.

An e-mail message window appears with the file(s) attached.

The following message appears if you click the [Cancel] button in the [Scan to E-mail - 
Set a password] dialog box.

If you do not want to set a document open password, click the [Yes] button.

You cannot start scanning when the [Scan to E-mail] dialog box is displayed. Close the 
dialog box before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the 
[Scan to E-mail] dialog box is displayed.
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■ Using the ScanSnap as a Copy Machine

This section explains how to print the scanned image with a printer.
When a printer links with ScanSnap Manager, the ScanSnap can be used as a copy machine.

For details about the procedure to scan and print the scanned image using or without using 
the Quick Menu, refer to the following:

Using the Quick Menu (→ page 125)
Without Using the Quick Menu (→ page 128)

Note that shadows around the edges of the document may appear as lines on the generated 
scanned image, depending on the scanning method and paper conditions. If you print such 
an image, the printed image will also have lines appearing in it.
The scanned image will be printed at a resolution of 150 dpi regardless of the setting 
specified for [Image quality] in the [Scanning] tab.
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Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Print] (If you do not want to change any 
settings, go to step 4.).

1. Move the mouse cursor to the  mark on the [Scan to Print] icon, and then select 
the [Settings] menu.

The [Scan to Print - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).
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2. Change the settings.
For details about the [Scan to Print - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Print- Options] dialog box.

4. Click the [Scan to Print] icon.

The [Scan to Print] dialog box appears.
If the [Show “Print” dialog] check box is cleared in step 3., printing is immediately 
performed.
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5. Check the scanned image in the preview area.

In the [Scan to Print] dialog box, you can specify the printer to be used, the number of 
copies and size of the scanned image to be printed, and whether to save the scanned 
image in the folder specified for [Image saving folder].
For details about the [Scan to Print] dialog box, refer to the ScanSnap Manager Help.

6. Click the [Print] button.

The scanned image is printed.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Print] dialog box is closed. Close the [Scan to Print] dialog box before scanning the next 
document.
Do not move, delete, or rename the scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to Print] dialog box is closed.

Preview
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Actions (for Windows Users)
Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Print].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

ScanSnap Manager also links with [Scan to Print] when you select:
[Scan to Print] from the [Profile] drop-down list of the ScanSnap setup dialog box
[Scan to Print] from the Left-Click Menu
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3. Change the settings for [Scan to Print] (If you do not want to change any 
settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Print - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to Print - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Print - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan to Print] dialog box appears when the scanning is completed.
If the [Show “Print” dialog] check box is cleared in step 3., printing is immediately 
performed.
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7. Check the scanned image in the preview area.

In the [Scan to Print] dialog box, you can specify the printer to be used, the number of 
copies and size of the scanned image to be printed, and whether to save the scanned 
image in the folder specified for [Image saving folder].
For details about the [Scan to Print] dialog box, refer to the ScanSnap Manager Help.

8. Click the [Print] button.

The scanned image is printed.

You cannot start scanning when the [Scan to Print] dialog box is displayed. Close the 
dialog box before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the 
[Scan to Print] dialog box is displayed.

Preview
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Actions (for Windows Users)
■ Saving Files to Picture Folder

This section explains how to save the scanned image as a JPEG file in the “Pictures folder”.

For details about the procedure to scan and save the scanned image in the "Pictures folder" 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 132)
Without Using the Quick Menu (→ page 135)

The following folder is set as the “Pictures folder” by default:
Windows 7/Windows Vista

Drive name (such as C):\Users\user name\Pictures\ScanSnap
Windows XP/Windows 2000

Drive name (such as C):\Documents and Settings\user name\My Documents\
My Pictures\ScanSnap
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Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Picture Folder] (If you do not want to 
change any settings, go to step 4.).

1. Move the mouse cursor to the  mark on the [Scan to Picture Folder] icon, and then 
select the [Settings] menu.

The [Scan to Picture Folder - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).
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2. Change the settings.
For details about the [Scan to Picture Folder - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Picture Folder - Options] dialog box.

4. Click the [Scan to Picture Folder] icon.

The [Scan to Picture Folder] dialog box appears.
If you clear the [Show preview] check box in step 3., the image data is directly saved 
in the Pictures folder.
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5. Check the scanned image in the preview area.

In the [Scan to Picture Folder] dialog box, you can rename the file, change the 
destination folder, and save the scanned image in the folder specified for [Image saving 
folder].
For details about the [Scan to Picture Folder] dialog box, refer to the ScanSnap 
Manager Help.

6. Click the [Save] button.

The scanned image is saved in the Pictures folder.

In [Specify destination folder], you can change the destination folder for the image data to a 
folder other than the Pictures folder.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Picture Folder] dialog box is closed. Close the [Scan to Picture Folder] dialog box 
before scanning the next document.
Do not move, delete, or rename scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to Picture Folder] dialog box is closed.

Preview
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Actions (for Windows Users)
Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Picture Folder].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected from the [Profile] drop-down list or Left-Click Menu next time you 
perform a scan.
For details about how to add a profile, refer to "Profile Management" (page 90).
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3. Change the settings for [Scan to Picture Folder] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Picture Folder - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to Picture Folder - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Picture Folder - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan to Picture Folder] dialog box appears when the scanning is completed.
If you clear the [Show preview] check box in step 3., the image data is directly saved 
in the Pictures folder.
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7. Check the scanned image in the preview area.

In the [Scan to Picture Folder] dialog box, you can rename the file, change the 
destination folder, and save the scanned image in the folder specified for [Image saving 
folder].
For details about the [Scan to Picture Folder] dialog box, refer to the ScanSnap 
Manager Help.

8. Click the [Save] button.

The scanned image is saved in the Pictures folder.

In [Specify destination folder], you can change the destination folder for the image data to a 
folder other than the Pictures folder.

You cannot start scanning when the [Scan to Picture Folder] dialog box is displayed. 
Close the dialog box before scanning the next document.
Do not move, delete or rename scanned image in other applications when the [Scan to 
Picture Folder] dialog box is displayed.

Preview
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Actions (for Windows Users)
■ Converting into Word/Excel/PowerPoint Documents

This section explains how to convert the scanned image into Word/Excel/PowerPoint files 
using ABBYY FineReader for ScanSnap bundled with the ScanSnap.

The following applications must be installed in your computer in order to perform text-
recognition:
- ABBYY FineReader for ScanSnap (bundled with the ScanSnap)
- Word
- Excel
- PowerPoint
- Visual Basic for Applications of Office Shared Features (installed at the same time when 

you perform a standard installation of Microsoft Office)
You cannot view the documents converted into Word, Excel and PowerPoint files unless 
these applications are installed and you completed the user registration to use them. Install 
these applications and complete the user registration to view the converted documents on 
your computer.
ABBYY FineReader for ScanSnap can be used with the following versions of Word, Excel 
and PowerPoint:
- Word: 2010 / 2007 / 2003 / 2002
- Excel: 2010 / 2007 / 2003 / 2002
- PowerPoint: 2010 / 2007 / 2003 / 2002

Do not use this function while you are working in Word, Excel or PowerPoint. In addition, do 
not use Word, Excel or PowerPoint while this function is being executed. Otherwise, a 
message such as “Call is rejected by callee” may appear and the conversion result may not 
be displayed.
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About the OCR function of ABBYY FineReader for ScanSnap
ABBYY FineReader for ScanSnap is an application used exclusively with the ScanSnap. This 
application can perform text recognition only for PDF files created by using the ScanSnap. It 
cannot perform text recognition for PDF files created using Adobe Acrobat or other 
applications.
The optical character recognition program has the following features. Before performing text 
recognition, check whether the documents you want to convert are suitable for conversion 
according to the following guidelines:

Application Suitable for conversion Not suitable for conversion

Scan to Word Documents with simple layouts 
consisting of single or double 
columns

Documents with complex layouts 
containing a mixture of diagrams, 
tables and text (e.g. brochures, 
magazines and newspapers)

Scan to Excel Documents containing simple 
tables with no cells merged

Documents containing: 
- Tables with no solid border lines
- Tables with complicated cell 

formats
- Complex tables containing sub-

tables 
- Diagrams
- Graphs
- Photos 
- Vertical text 
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Actions (for Windows Users)
Application Suitable for conversion Not suitable for conversion

Scan to 
PowerPoint(R)

Documents containing text and 
simple diagrams/tables on a white 
or light monocolor background

- Documents with complex layouts 
containing text mixed with 
diagrams or illustrations 

- Documents containing 
photographs or patterns set as 
the background 

- Documents with light colored 
text on a deep colored 
background
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The following parameters may not be reproduced as they are in the original document. It is 
recommended that you check the conversion result in Word, Excel or PowerPoint and edit 
the data if necessary:
- Character font and size
- Character and line spacing
- Underlined, bold and italic characters
- Superscript/subscript

The following types of documents (characters) may not be recognized correctly.
Better results in text recognition may be achieved by changing the color mode or increasing 
the resolution:
- Documents including handwritten characters
- Documents containing small characters (smaller than 10 points)
- Skewed documents
- Documents written in languages other than the specified language
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders
- Documents with a complex layout and documents with image noise

(It may take extra time to process text recognition for these documents.)
The following message appears when you convert a long page document into a Word file, 
and the conversion result may be divided into more than one page.

When converting to Excel files, if the recognition result exceeds 65,536 lines, no more results 
are saved.
When converting to Excel files, information about the layout of the entire document, 
diagrams, and length/width of graphs and tables is not duplicated.Only tables and character 
strings are reproduced.
A converted PowerPoint document will not have the original background color and patterns.
Documents placed upside down or in landscape orientation cannot be recognized properly. 
Select the [Allow automatic image rotation] check box (page 228), or load documents face 
down in portrait orientation.
In the ScanSnap setup dialog box, even if the [Generate one PDF file per (n) page (s)] check 
box is selected in the [File option] tab → [Option], the conversion result is saved as one file.
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Actions (for Windows Users)
For details about the procedure to scan and convert the scanned image into Word/Excel/
PowerPoint files using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 143)
Without Using the Quick Menu (→ page 145)

You can change the settings applied during conversion to Word, Excel or PowerPoint documents 
in the ABBYY FineReader for ScanSnap setup dialog box.

Select [Start] menu → [All Programs] → [ABBYY FineReader for ScanSnap (TM) 4.1] → [ABBYY 
FineReader for ScanSnap (TM) 4.1] to display the following dialog box.

For details about how to configure settings, refer to ABBYY FineReader for ScanSnap User's 
Guide.
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Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Click the [Scan to Word], [Scan to Excel] or [Scan to PowerPoint(R)] 
icon.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab of the ScanSnap setup dialog box.

When you perform a scan with [JPEG(*.jpg)] selected for [File format] in the [File option] 
tab of the ScanSnap setup dialog box, scanned data cannot be converted into a Word, 
Excel or PowerPoint file.
You cannot start scanning when the Quick Menu is displayed. Wait until the conversion 
is over to scan another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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The following window appears, and conversion starts.

When the conversion is completed, Word, Excel or PowerPoint starts up, and the 
conversion result is displayed.

In a computer environment where Word, Excel or PowerPoint is not installed, the scanned 
image is saved in one of the following formats when the conversion is completed:

Scan to Word: RTF format (.rtf)
Scan to Excel: XLS format (.xls)
Scan to PowerPoint: PPT format (.ppt)
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Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select 
[ABBYY Scan to Word], [ABBYY Scan to Excel] or [ABBYY Scan to 
PowerPoint(R)].

3. Click the [OK] button to close the ScanSnap setup dialog box.

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in 
the [Scanning] tab of the ScanSnap setup dialog box.
ScanSnap Manager also links with [ABBYY Scan to Word], [ABBYY Scan to Excel] or 
[ABBYY Scan to PowerPoint(R)] when you select:
- [ABBYY Scan to Word], [ABBYY Scan to Excel] or [ABBYY Scan to PowerPoint(R)] 

from the [Profile] drop-down list of the ScanSnap setup dialog box
- [ABBYY Scan to Word], [ABBYY Scan to Excel] or [ABBYY Scan to PowerPoint(R)] 

from the Left-Click Menu
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Actions (for Windows Users)
4. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

5. Press the [Scan] button on the ScanSnap to start a scan.

When the scanning is completed, the following window appears, and conversion 
starts.

When the conversion is completed, Word, Excel or PowerPoint starts up and the 
conversion result is displayed.

In a computer environment where Word, Excel or PowerPoint is not installed, the scanned 
image is saved in one of the following formats when the conversion is completed:

Scan to Word: RTF format (.rtf)
Scan to Excel: XLS format (.xls)
Scan to PowerPoint: PPT format (.ppt)
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Actions (for Windows Users)
■ Storing Business Cards in CardMinder

This section explains how to store business card images and the related information in 
CardMinder.

For details about the procedure to scan and manage business cards in CardMinder using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 148)
Without Using the Quick Menu (→ page 150)

Blank pages are not removed even if the [Allow automatic blank page removal] is selected 
when you store scanned images of business cards in CardMinder.
Data of up to 1,000 pages, including blank pages, can be stored in CardMinder at once.
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Using the Quick Menu

1. Load a business card in the ScanSnap.

Load the business card so that the front side faces the ADF paper chute (cover).
To scan multiple business cards, load them in a pile.
Do not leave space between the side guides and business cards.

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab of the ScanSnap setup dialog box. ScanSnap Manager cannot link with 
CardMinder when [Image quality] is set to [Excellent].
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Actions (for Windows Users)
3. Click the [Scan to CardMinder] icon.

The CardMinder window appears.

4. Check the scanned card image and the text recognition result.

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap 
Manager links with CardMinder before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

For details about the functions of CardMinder and how to use it, refer to CardMinder User's 
Guide and CardMinder Help.
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Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select 
[CardMinder].

3. Click the [OK] button to close the ScanSnap setup dialog box.

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab of the ScanSnap setup dialog box. ScanSnap Manager cannot link with 
CardMinder when [Image quality] is set to [Excellent].

ScanSnap Manager also links with [CardMinder] when you select:
[CardMinder] from the [Profile] drop-down list of the ScanSnap setup dialog box
[CardMinder] from the Left-Click Menu
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4. Load a business card in the ScanSnap.

Load the business card so that the front side faces the ADF paper chute (cover).
To scan multiple business cards, load them in a pile.
Do not leave space between the side guides and business cards.

5. Press the [Scan] button on the ScanSnap to start a scan.

The CardMinder window appears.

6. Check the scanned card image and the text recognition result.

For details about the functions of CardMinder and how to use it, refer to CardMinder User's 
Guide and CardMinder Help.
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■ Saving Data in SharePoint

This section explains how to save the scanned image in SharePoint or Office Live.

For details about the procedure to scan and save the scanned image in SharePoint/Office 
Live using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 153)
Without Using the Quick Menu (→ page 157)

To save a large file to SharePoint or Office Live, you may need to have the system 
administrator change the SharePoint or Office Live setting.
When you start up Scan to Microsoft SharePoint for the first time, you need to register a 
SharePoint site. Once you register the SharePoint site, ScanSnap Manager automatically 
connects to that site from the next startup.
For more details, refer to the Scan to Microsoft SharePoint User Guide.
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Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to SharePoint] (If you do not want to 
change any settings, go to step 4.).

1. Move the mouse cursor to the  mark on the [Scan to SharePoint] icon, and then 
select the [Settings] menu.

The [Scan to SharePoint - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).
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2. Change the setting.
For details about the [Scan to SharePoint - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to SharePoint - Options] dialog box.

4. Click the [Scan to SharePoint] icon.

Scan to Microsoft SharePoint starts up.

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap 
Manager links with Microsoft SharePoint before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Windows Users)
5. Save the scanned image.

Saving to SharePoint
1. Select a folder in which you want to save the scanned image.
2. In the Scan to Microsoft SharePoint Index Pane, enter information, such as the title, 

and click the [Accept] button.

The scanned image is saved in the specified folder.

Saving to Office Live

1. Select [Connect to Office Live] from the menu.

The Office Live logon dialog box appears.

Support for Office Live varies depending on the country. For more details, refer to the 
Office Live Web site.
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2. Enter the ID and the password in the Office Live logon dialog box, and then click the 
[Sign In] button.

The [Scan to Microsoft SharePoint] dialog box appears after the ScanSnap is 
connected to Office Live.

3. Select a folder in which you want to save the scanned image.
4. In the Scan to Microsoft SharePoint Index Pane, enter information, such as the title, 

and click the [Accept] button.

The scanned image is saved in the specified folder.

For details, refer to the Scan to Microsoft SharePoint User Guide.
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Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to SharePoint].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected from the [Profile] drop-down list or Left-Click Menu next time you 
perform a scan.
For details about how to add a profile, refer to "Profile Management" (page 90).
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Actions (for Windows Users)
3. Change the settings for [Scan to SharePoint] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to SharePoint - Options] dialog box appears.

2. Change the setting.
For details about the [Scan to SharePoint - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to SharePoint - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

Scan to Microsoft SharePoint starts up when the scanning is completed.
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7. Save the scanned image.

Saving to SharePoint
1. Select a folder in which you want to save the scanned image.
2. In the Scan to Microsoft SharePoint Index Pane, enter information, such as the title, 

and click the [Accept] button.

The scanned image is saved in the specified folder.

Saving to Office Live

1. Select [Connect to Office Live] from the menu.

The Office Live logon dialog box appears.

Support for Office Live varies depending on the country. For more details, refer to the 
Office Live Web site.
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2. Enter the ID and the password in the Office Live logon dialog box, and then click the 
[Sign In] button.

The [Scan to Microsoft SharePoint] dialog box appears after the ScanSnap is 
connected to Office Live.

3. Select a folder in which you want to save the scanned image.
4. In the Scan to Microsoft SharePoint Index Pane, enter information, such as the title, 

and click the [Accept] button.

The scanned image is saved in the specified folder.

For details, refer to the Scan to Microsoft SharePoint User Guide.
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Actions (for Windows Users)
■ Saving to Rack2-Filer

This section explains how to save the scanned image as a PDF file in Rack2-Filer trial version 
(bundled with the ScanSnap) or Rack2-Filer (V5.0 or later recommended/bundled model or 
sold separately).

For details about the procedure to scan and save the scanned image in Rack2-Filer using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 162)
Without Using the Quick Menu (→ page 164)

Rack2-Filer trial version (bundled with the ScanSnap) or Rack2-Filer (V5.0 or later 
recommended/ bundled model or sold separately) is required to use this function.
Rack2-Filer is an application that converts paper documents and electronic documents into 
PDF files and manages them in a computer. You can manage the documents as if you bind 
them, store them on a cabinet shelf, and browse them as if you flip through a book.
The following settings in ScanSnap Manager are disabled when the scanned image is saved 
to Rack2-Filer:
- Rename file after scanning
- Color high compression
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Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Rack2-Filer] (If you do not want to 
change any settings, go to step 4.).

1. Move the mouse cursor to the  mark on the [Scan to Rack2-Filer] icon, and then 
select the [Settings] menu.

The [ScanSnap - > Rack2] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).
162



Actions (for Windows Users)
2. Change the settings.
In this dialog box, specify the destination to save the scanned image.
For details about the [ScanSnap - > Rack2] dialog box, refer to Rack2-Filer Help. 
Click the [Help] button in the [ScanSnap - > Rack2] dialog box to display Rack2-Filer 
Help.

3. Click the [OK] button to close the [ScanSnap - > Rack2] dialog box.

4. Click the [Scan to Rack2-Filer] icon.

Rack2-Filer starts up, and the PDF file created by the ScanSnap is saved in Rack2- 
Filer in accordance with the settings specified in step 3.

When you perform a scan with [JPEG(*.jpg)] selected for [File format] in the [File option] 
tab of the ScanSnap setup dialog box, you cannot save the image in Rack2-Filer.
You cannot start scanning when the Quick Menu is displayed. Save the scanned image 
to Rack2-Filer before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

For details about how to use Rack2-Filer, refer to the Rack2-Filer User’s Guide.
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Actions (for Windows Users)
Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).

The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Rack2- 
Filer].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

ScanSnap Manager also links with [Rack2-Filer] when you select:
[Rack2-Filer] from the [Profile] drop-down list of the ScanSnap setup dialog box
[Rack2-Filer] from the Left-Click Menu
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Actions (for Windows Users)
3. Change the settings for [Scan to Rack2-Filer] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [ScanSnap - > Rack2] dialog box appears.

2. Change the settings.
In this dialog box, specify the destination to save the scanned image.
For details about the [ScanSnap - > Rack2] dialog box, refer to Rack2-Filer Help. 
Click the [Help] button in the [ScanSnap - > Rack2] dialog box to display Rack2-Filer 
Help.

3. Click the [OK] button to close the [ScanSnap -> Rack2] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).
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Actions (for Windows Users)
6. Press the [Scan] button on the ScanSnap to start a scan.

When the scanning is completed, Rack2-Filer starts up, and the PDF file created by 
the ScanSnap is saved in Rack2-Filer in accordance with the settings specified in 
step 3.

For details about how to use Rack2-Filer, refer to the Rack2-Filer User’s Guide.
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Actions (for Windows Users)
■ Saving Documents to Evernote

This section explains how to save the scanned image as a PDF file to Evernote.
When you save a scanned image to Evernote after converting it into a searchable PDF, the 
PDF file becomes searchable in Evernote.

For details about the procedure to scan and save the scanned image to Evernote using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 168)
Without Using the Quick Menu (→ page 171)

Scan to Evernote (Document) is not supported on Windows 2000.
You need to create an Evernote account (free or premium).
You first need to sign in to Evernote for Windows to save a file to Evernote.

PDF
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Actions (for Windows Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Evernote (Document)] (If you do not 
want to change any settings, go to step 4.).

1. Move the mouse cursor to the  mark on the [Scan to Evernote (Document)] icon, 
and then select the [Settings] menu.

The [Scan to Evernote - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).
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Actions (for Windows Users)
2. Change the settings.
For details about the [Scan to Evernote - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Evernote - Options] dialog box.

4. Click the [Scan to Evernote (Document)] icon.

You cannot start scanning when the Quick Menu is displayed. Save the PDF file to 
Evernote before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Windows Users)
If [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup dialog box, a separate PDF file will be created from each JPEG file.
The following window appears during file creation.

If the [Convert to Searchable PDF] check box is selected in step 3., text recognition 
is performed according to the [OCR options] settings in the [Scan to Evernote - 
Options] dialog box.
The following window appears during text recognition.

Evernote for Windows starts up, and the PDF file is saved to Evernote.

Note that text recognition will be performed only on pages containing text which is not 
yet recognized.

The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup dialog box even after the scanned 
image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Windows Users)
Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Evernote (Document)].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

ScanSnap Manager also links with [Scan to Evernote (Document)] when you select:
[Scan to Evernote (Document)] from the [Profile] drop-down list of the ScanSnap setup 
dialog box
[Scan to Evernote (Document)] from the Left-Click Menu
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Actions (for Windows Users)
3. Change the settings for [Scan to Evernote (Document)] (If you do not 
want to change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Evernote - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to Evernote - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Evernote - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).
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Actions (for Windows Users)
6. Press the [Scan] button on the ScanSnap to start a scan.

When the scanning is completed, a separate PDF file will be created from each 
JPEG file if [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the 
ScanSnap setup dialog box.
The following window appears during file creation.

If the [Convert to Searchable PDF] check box is selected in step 3., text recognition 
is performed according to the [OCR options] settings in the [Scan to Evernote - 
Options] dialog box.
The following window appears during text recognition.

Evernote for Windows starts up, and the PDF file is saved to Evernote.

Note that text recognition will be performed only on pages containing text which is not 
yet recognized.

The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup dialog box even after the scanned 
image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Windows Users)
■ Saving Handwritten Notes to Evernote

This section explains how to save the scanned image as a JPEG file to Evernote.
When you save a JPEG file to Evernote, text recognition is performed on all text, including 
handwritten characters, and the file becomes searchable in Evernote.

For details about the procedure to scan and save the scanned image to Evernote using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 175)
Without Using the Quick Menu (→ page 177)

Scan to Evernote (Note) is not supported on Windows 2000.
You need to create an Evernote account (free or premium).
You first need to sign in to Evernote for Windows to save a file to Evernote.

JPEG
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Actions (for Windows Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Click the [Scan to Evernote (Note)] icon.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).

You cannot start scanning when the Quick Menu is displayed. Save the JPEG file to 
Evernote before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Windows Users)
If [PDF(*.pdf)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup dialog box, a separate JPEG file will be created from each page of the PDF 
file.
The following window appears during file creation.

Evernote for Windows starts up, and the JPEG file is saved to Evernote.

When you select [PDF(*.pdf)] for [File format] in the [File option] tab of the ScanSnap 
setup dialog box, a four-digit serial number is automatically added to the name of the 
file which is saved to Evernote.
e.g. When the file name is [ScanSnap], the file is saved as:

ScanSnap_0001, ScanSnap_0002, ScanSnap_0003...
The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup dialog box even after the 
scanned image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Windows Users)
Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Evernote (Note)].

3. Click the [OK] button to close the ScanSnap setup dialog box.

4. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

ScanSnap Manager also links with [Scan to Evernote (Note)] when you select:
[Scan to Evernote (Note)] from the [Profile] drop-down list of the ScanSnap setup dialog 
box
[Scan to Evernote (Note)] from the Left-Click Menu
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Actions (for Windows Users)
5. Press the [Scan] button on the ScanSnap to start a scan.

When the scanning is completed, a separate JPEG file will be created from each 
page of the PDF file if [PDF(*.pdf)] is selected for [File format] in the [File option] tab 
of the ScanSnap setup dialog box.
The following window appears during file creation.

Evernote for Windows starts up, and the JPEG file is saved to Evernote.

When you select [PDF(*.pdf)] for [File format] in the [File option] tab of the ScanSnap 
setup dialog box, a four-digit serial number is automatically added to the name of the 
file which is saved to Evernote.
e.g. When the file name is [ScanSnap], the file is saved as:

ScanSnap_0001, ScanSnap_0002, ScanSnap_0003...
The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup dialog box even after the 
scanned image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Windows Users)
■ Saving Documents to Google Docs

This section explains how to save the scanned image as a PDF file to Google Docs.

For details about the procedure to scan and save the scanned image to Google Docs using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 180)
Without Using the Quick Menu (→ page 184)

Scan to Google Docs is not supported on Windows 2000.
You need to create a Google account (free).
You need to have .NET Framework 3.0 installed in order to use this function.
Note that .NET Framework 3.0 is also included in .NET Framework 3.5 (SP1 or later). 
It is recommended that you use .NET Framework 3.5 (SP1 or later) by updating Windows.
If .NET Framework 4 or later is already installed, you need to install .NET Framework 3.0 
separately because .NET Framework 3.0 is not included in the .NET Framework 4 or later 
version.

PDF
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Actions (for Windows Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Google Docs(TM)] (If you do not want to 
change any settings, go to step 4.).

1. Move the mouse cursor to the  mark on the [Scan to Google Docs(TM)] icon, and 
then select the [Settings] menu.

The [Scan to Google Docs(TM) - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to"Using the Quick 
Menu" (page 73).
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Actions (for Windows Users)
2. Change the settings.
For details about the [Scan to Google Docs(TM) - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Google Docs(TM) - Options] dialog box.

4. Click the [Scan to Google Docs(TM)] icon.

If the computer is shared with other users, do not set your information in [Email] and 
[Password]. Otherwise, other users will be able to log into Google Docs 
automatically.
It is recommended to set only [Email] in this dialog box, and type in the password 
every time.

You cannot start scanning when the Quick Menu is displayed. Save the PDF file to 
Google Docs before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Windows Users)
If you did not specify a Google account in the [Scan to Google Docs(TM) - Options] 
dialog box in step 3., the [Scan to Google Docs(TM)] dialog box appears. To 
continue, enter your e-mail address and password, and click the [OK] button.

If [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup dialog box, a separate PDF file will be created from each JPEG file.
The following window appears during file creation.

If the [Convert to Searchable PDF] check box is selected in the [Scan to Google 
Docs(TM) - Options] dialog box in step 3., text recognition is performed according to 
the [OCR options] settings in the [Scan to Google Docs(TM) - Options] dialog box.
The following window appears during text recognition.

If the computer is shared with other users, do not select the [Save your account 
information.] check box in this dialog box.
Otherwise, other users will be able to log into Google Docs automatically. 
Scan to Google Docs is not available in a proxy environment that requires 
authentication upon connecting to the Internet.

Note that text recognition will be performed only on pages containing text which is not 
yet recognized.
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Actions (for Windows Users)
Saving to Google Docs starts. Click the [Close] button to close the [Scan to Google 
Docs(TM)] dialog box when the saving is completed.

If you select the [Close this window when save completes] check box above, the 
[Scan to Google Docs(TM)] dialog box will automatically close from next scanning on 
when the saving is completed.

Google Docs does not start up after the saving has completed. To check the saved PDF 
file, start a web browser and log in to Google Docs.
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Actions (for Windows Users)
Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Google Docs(TM)].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

ScanSnap Manager also links with [Scan to Google Docs(TM)] when you select:
[Scan to Google Docs(TM)] from the [Profile] drop-down list of the ScanSnap setup 
dialog box
[Scan to Google Docs (TM)] from the Left-Click Menu
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Actions (for Windows Users)
3. Change the settings for [Scan to Google Docs(TM)] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Google Docs(TM) - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to Google Docs(TM) - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Google Docs(TM) - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

If the computer is shared with other users, do not set your information in [Email] and 
[Password]. Otherwise, other users will be able to log into Google Docs 
automatically.
It is recommended to set only [Email] in this dialog box, and type in the password 
every time.
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Actions (for Windows Users)
6. Press the [Scan] button on the ScanSnap to start a scan.

If you did not specify a Google account in the [Scan to Google Docs(TM) - Options] 
dialog box in step 3., the [Scan to Google Docs(TM)] dialog box appears when the 
scanning is completed. To continue, enter your e-mail address and password, and 
click the [OK] button.

If [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup dialog box, a separate PDF file will be created from each JPEG file.
The following window appears during file creation.

If the [Convert to Searchable PDF] check box is selected in the [Scan to Google 
Docs(TM) - Options] dialog box in step 3., text recognition is performed according to 
the [OCR options] settings in the [Scan to Google Docs(TM) - Options] dialog box.
The following window appears during text recognition.

If the computer is shared with other users, do not select the [Save your account 
information.] check box in this dialog box.
Otherwise, other users will be able to log into Google Docs automatically. 
Scan to Google Docs is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Windows Users)
Saving to Google Docs starts. Click the [Close] button to close the [Scan to Google 
Docs(TM)] dialog box when the saving is completed.

If you select the [Close this window when save completes] check box above, the 
[Scan to Google Docs(TM)] dialog box will automatically close from next scanning on 
when the saving is completed.

Note that text recognition will be performed only on pages containing text which is not 
yet recognized.

Google Docs does not start up after the saving has completed. To check the saved PDF 
file, start a web browser and log in to Google Docs.
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Actions (for Windows Users)
■ Posting to Salesforce Chatter

This section explains how to post the scanned image as a PDF or a JPEG file to Salesforce 
Chatter.

For details about the procedure to scan and post the scanned image to Salesforce Chatter 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 189)
Without Using the Quick Menu (→ page 194)

Scan to Salesforce Chatter is not supported on Windows 2000.
A Salesforce CRM license is required separately.
ScanSnap Manager can link with the following Salesforce editions:
- Unlimited
- Enterprise

You need to have .NET Framework 3.0 installed in order to use this function.
Note that .NET Framework 3.0 is also included in .NET Framework 3.5 (SP1 or later).
It is recommended that you use .NET Framework 3.5 (SP1 or later) by updating Windows.
If .NET Framework 4 or later is already installed, you need to install .NET Framework 3.0 
separately because .NET Framework 3.0 is not included in the .NET Framework 4 or later 
version.
A maximum of 100 scanned image files can be posted to Salesforce Chatter at once.
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Actions (for Windows Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Salesforce Chatter] (If you do not want 
to change any settings, go to step 4.).

1. Move the mouse cursor to the  mark on the [Scan to Salesforce Chatter] icon, and 
then select the [Settings] menu.

The [Scan to Salesforce Chatter - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).
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Actions (for Windows Users)
2. Change the settings.
For details about the [Scan to Salesforce Chatter - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Salesforce Chatter - Options] dialog box.

4. Click the [Scan to Salesforce Chatter] icon.

If the computer is shared with other users, do not set your information in [User 
Name], [Password] and [Security Token]. Otherwise, other users will be able to log 
into Salesforce automatically.
It is recommended to set only [User Name] and [Security Token] in this dialog box, 
and type in the password every time. 
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Actions (for Windows Users)
If you did not specify a Salesforce account in the [Scan to Salesforce Chatter - 
Options] dialog box in step 3., the [Scan to Salesforce Chatter - Login] dialog box 
appears. To continue, enter your user name and password and click the [OK] button. 
Enter a security token if needed.

The [Scan to Salesforce Chatter] dialog box appears.

If the computer is shared with other users, do not select the [Save user account 
information.] check box in this dialog box.
Otherwise, other users will be able to log into Salesforce automatically.
Scan to Salesforce Chatter is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Windows Users)
5. Check the scanned image in the preview area.

In the [Scan to Salesforce Chatter] dialog box, you can set the posting destination and 
method, the message to post, the name and description of the image file that will be 
posted to Salesforce Chatter, and save the scanned image in the folder specified for 
[Image saving folder].
For details about the [Scan to Salesforce Chatter] dialog box, refer to the ScanSnap 
Manager Help.

Preview
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Actions (for Windows Users)
6. Click the [Post] button.

Posting to Salesforce Chatter starts. Click the [Close] button to close the [Scan to 
Salesforce Chatter] dialog box when the posting is completed.

If you select the [Close this window when posting completes] check box above, the 
[Scan to Salesforce Chatter] dialog box will automatically close from next scanning 
on when the posting is completed.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Salesforce Chatter] dialog box is closed. Close the [Scan to Salesforce Chatter] dialog 
box before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

Salesforce does not start up after the posting has completed. To check the saved scanned 
image file, start a web browser and log in to Salesforce.
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Actions (for Windows Users)
Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Salesforce Chatter].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected from the [Profile] drop-down list or Left-Click Menu next time you 
perform a scan.
For details about how to add a profile, refer to "Profile Management" (page 90).
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Actions (for Windows Users)
3. Change the settings for [Scan to Salesforce Chatter] (If you do not want 
to change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Salesforce Chatter - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to Salesforce Chatter - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Salesforce Chatter - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

If the computer is shared with other users, do not set your information in [User 
Name], [Password] and [Security Token]. Otherwise, other users will be able to log 
into Salesforce automatically.
It is recommended to set only [User Name] and [Security Token] in this dialog box, 
and type in the password every time. 
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Actions (for Windows Users)
6. Press the [Scan] button on the ScanSnap to start a scan.

If you did not specify a Salesforce account in the [Scan to Salesforce Chatter - 
Options] dialog box in step 3., the [Scan to Salesforce Chatter - Login] dialog box 
appears when the scanning is completed. To continue, enter your user name and 
password and click the [OK] button. Enter a security token if needed. 

The [Scan to Salesforce Chatter] dialog box appears.

If the computer is shared with other users, do not select the [Save user account 
information.] check box in this dialog box.
Otherwise, other users will be able to log into Salesforce automatically. 
Scan to Salesforce Chatter is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Windows Users)
7. Check the scanned image in the preview area.

In the [Scan to Salesforce Chatter] dialog box, you can set the posting destination and 
method, the message to post, the name and description of the image file that will be 
posted to Salesforce Chatter, and save the scanned image in the folder specified for 
[Image saving folder].
For details about the [Scan to Salesforce Chatter] dialog box, refer to the ScanSnap 
Manager Help.

Preview
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Actions (for Windows Users)
8. Click the [Post] button.

Posting to Salesforce Chatter starts. Click the [Close] button to close the [Scan to 
Salesforce Chatter] dialog box when the posting is completed.

If you select the [Close this window when posting completes] check box above, the 
[Scan to Salesforce Chatter] dialog box will automatically close from next scanning 
on when the posting is completed.

You cannot start scanning when the [Scan to Salesforce Chatter] dialog box is 
displayed. Close the dialog box before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
[Scan to Salesforce Chatter] dialog box is displayed.

Salesforce does not start up after the posting has completed. To check the saved scanned 
image file, start a web browser and log in to Salesforce.
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Actions (for Windows Users)
■ Saving Data to Your SugarSync Folder

This section explains how to save the scanned image as a PDF or a JPEG file to your 
SugarSync folder.

For details about the procedure to scan and save the scanned image to your SugarSync 
folder using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 200)
Without Using the Quick Menu (→ page 203)

Scan to SugarSync is not supported on Windows 2000. 
You need to have a SugarSync account.
You need to have SugarSync Manager for Windows 1.9.28 or later installed in order to use 
this function. 
You can save up to 100 files to your SugarSync folder at once.

When you first log into SugarSync after installing SugarSync Manager for Windows, the Magic 
Briefcase, which is a sync folder used for SugarSync, is automatically created.
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Actions (for Windows Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to SugarSync] (If you do not want to 
change any settings, go to step 4.

1. Move the mouse cursor to the  mark on the [Scan to SugarSync] icon, and then 
select the [Settings] menu.

The [Scan to SugarSync - Options] dialog box appears.

2. Change the setting.
For details about the [Scan to SugarSync - Options] dialog box, refer to ScanSnap 
Manager Help.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).
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3. Click the [OK] button to close the [Scan to SugarSync - Options] dialog box.

4. Click the [Scan to SugarSync] icon.

The [Scan to SugarSync] dialog box appears.
If you clear the [Show preview] check box in step 3., scanned image is directly saved 
to your SugarSync folder.
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5. Check the scanned image in the preview area.

In the [Scan to SugarSync] dialog box, you can rename the file and specify your 
SugarSync folder.
For details about the [Scan to SugarSync] dialog box, refer to the ScanSnap Manager 
Help.

6. Click the [Save] button.

The scanned image is saved to your SugarSync folder.

The file will not be synced with SugarSync unless you select a SugarSync folder as the 
destination folder.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
SugarSync] dialog box is closed. Close the [Scan to SugarSync] dialog box before 
scanning the next document.
Do not move, delete or rename the scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to SugarSync] dialog box is closed.

Preview
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Actions (for Windows Users)
Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to SugarSync].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected from the [Profile] drop-down list or the Left-Click Menu next time 
you perform a scan.
For details about how to add a profile, refer to "Profile Management" (page 90).
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3. Change the settings for [Scan to SugarSync] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to SugarSync - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to SugarSync - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to SugarSync - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan to SugarSync] dialog box appears when the scanning is completed.
If you clear the [Show preview] check box in step 3., scanned image is directly saved 
to your SugarSync folder.
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7. Check the scanned image in the preview area.

In the [Scan to SugarSync] dialog box, you can rename the file and specify your 
SugarSync folder.
For details about the [Scan to SugarSync] dialog box, refer to the ScanSnap Manager 
Help.

8. Click the [Save] button.

The scanned image is saved to your SugarSync folder.

The file will not be synced with SugarSync unless you select a SugarSync folder as the 
destination folder.

You cannot start scanning when the [Scan to SugarSync] dialog box is displayed. Close 
the dialog box before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the 
[Scan to SugarSync] dialog box is displayed.

Preview
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Actions (for Windows Users)
■ Saving Data to a Mobile Device

This section explains how to save the scanned image as a PDF or a JPEG file to a mobile 
device.

Scan to Mobile is not supported on Windows 2000.
Only one mobile device can be connected to the computer.
You need to have .NET Framework 3.0 installed in order to use this function.
Note that .NET Framework 3.0 is also included in .NET Framework 3.5 (SP1 or later).
It is recommended that you use .NET Framework 3.5 (SP1 or later) by updating Windows.
If .NET Framework 4 or later is already installed, you need to install .NET Framework 3.0 
separately because .NET Framework 3.0 is not included in the .NET Framework 4 or later 
version.
You need to have ScanSnap Connect Application installed in the mobile device in order to 
use this function. Download ScanSnap Connect Application for mobile devices from 
application stores such as App Store. 
ScanSnap Connect Application for mobile devices operate on the following operating 
systems:
- iOS 4.2.1 or later

The number of scanned image files and the maximum file size that can be saved on a mobile 
device at once are as follows:
- Number of files: Up to 100
- File size: 2048 MB

A firewall alert may be displayed when you first launch [Scan to Mobile]. When the alert is 
displayed, select [Allow access] or [Unblock].
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Actions (for Windows Users)
For details about the procedure to save scanned images to mobile devices through automatic 
linkage, and using or without using the Quick Menu, refer to the following:

Automatic Linkage (→ page 208)
Using the Quick Menu (→ page 210)
Without Using the Quick Menu (→ page 214)

The following message appears when you first launch [Scan to Mobile]. Click the [OK] button 
to open the [Scan to Mobile - Basic] dialog box. 

In the [Scan to Mobile - Basic] dialog box, enter a password to connect to the mobile device. 
For details about other setting items, refer to the Scan to Mobile Help. 

The Scan to Mobile icon appears on the taskbar when the file is saved to the mobile device.
In Windows 7, the Scan to Mobile icon is displayed in the menu that appears when you click 

 on the taskbar.
The Scan to Mobile icon shows the communication status between the computer and the 
mobile device. The appearance of the icon changes according to the communication status 
as shown below.

Status Scan to Mobile icon

Waiting

Standby

Sending

Sending error

Rejected
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Actions (for Windows Users)
Automatic Linkage

1. Select [Start] menu → [All Programs] → [ScanSnap Manager] → [Scan to 
Mobile].

The Scan to Mobile icon  appears on the taskbar.

2.  Connect to the computer from your mobile device. 

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User’s Guide (iOS).

When the connection is established, the [Scan to Mobile] dialog box appears on the 
computer, showing the mobile device that is currently connected to the computer. 

3. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

For details about the features of ScanSnap Connect Application for mobile devices and how 
to use it, refer to the ScanSnap Connect Application User's Guide (iOS). 
For details about automatic linkage with active applications, refer to "Automatic Linkage with 
Applications" (page 99).
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Actions (for Windows Users)
4. Press the [Scan] button on the ScanSnap to start a scan.

Scanned images will be sent to the mobile device from the computer when the 
scanning is completed.

5. Click the [Close] button to close the [Scan to Mobile] dialog box when 
sending of the scanned image is completed.

To enable automatic linkage with Scan to Mobile, press the [Scan] button on the ScanSnap 
and start a scan while Scan to Mobile is active (where this application is currently selected 
on the taskbar and the [Scan to Mobile] dialog box is brought to front). 

When you select the [Wait until the [Send] button is clicked] check box in the [Scan to Mobile - 
Basic] dialog box, the [Send] button appears in the [Scan to Mobile] dialog box. Click the [Send] 
button to send the image to the mobile device. 

The [Scan to Mobile] dialog box closes automatically when the mobile device is disconnected 
from the computer.
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Actions (for Windows Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Mobile] (If you do not want to change 
any settings, go to step 4.).

1. Move the mouse cursor to the  mark on the [Scan to Mobile] icon, and then select 
the [Settings] menu.

The [Scan to Mobile - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 73).

When [Scan to Mobile] has already started and is active (with the application selected on 
the taskbar and the [Scan to Mobile] dialog box brought to front), ScanSnap Manager links 
with [Scan to Mobile] automatically and the Quick Menu does not appear. 
To display the Quick Menu, minimize the [Scan to Mobile] dialog box first, and then try 
scanning again.
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Actions (for Windows Users)
2. Change the setting.
For details about the [Scan to Mobile - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Mobile - Options] dialog box.

4. Click the [Scan to Mobile] icon.

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap 
Manager links with Scan to Mobile before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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The [Scan to Mobile] dialog box appears.

5. Connect to the computer from your mobile device.

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User’s Guide (iOS).

When the connection is established, the [Scan to Mobile] dialog box appears 
showing the mobile device that is currently connected to the computer. Then, the 
scanned image is sent to the mobile device.

When you select the [Wait until the [Send] button is clicked] check box in the [Scan to 
Mobile - Basic] dialog box, the [Send] button appears in the [Scan to Mobile] dialog box. 
Click the [Send] button to send the image to the mobile device.
For details about the features of ScanSnap Connect Application for mobile devices and 
how to use it, refer to the ScanSnap Connect Application User's Guide (iOS).
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Actions (for Windows Users)
6. Click the [Close] button to close the [Scan to Mobile] dialog box when 
the sending of the scanned image is completed.

The [Scan to Mobile] dialog box closes automatically when the mobile device is 
disconnected from the computer.
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Actions (for Windows Users)
Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Mobile].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 79).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected from the [Profile] drop-down list or Left-Click Menu next time you 
perform a scan.
For details about how to add a profile, refer to "Profile Management" (page 90).
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Actions (for Windows Users)
3. Change the settings for [Scan to Mobile] (If you do not want to change 
any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Mobile - Options] dialog box appears.

2. Change the setting.
For details about the [Scan to Mobile - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Mobile - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).
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Actions (for Windows Users)
6. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan to Mobile] dialog box appears on the computer when the scanning is 
completed.

7. Connect to the computer from your mobile device. 

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User’s Guide (iOS).

When the connection is established, the [Scan to Mobile] dialog box appears 
showing the mobile device that is currently connected to the computer. Then, the 
scanned image is sent to the mobile device.

When you select the [Wait until the [Send] button is clicked] check box in the [Scan to 
Mobile - Basic] dialog box, the [Send] button appears in the [Scan to Mobile] dialog box. 
Click the [Send] button to send the image to the mobile device. 
For details about the features of ScanSnap Connect Application for mobile devices and 
how to use it, refer to the ScanSnap Connect Application User's Guide (iOS).
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Actions (for Windows Users)
8. Click the [Close] button to close the [Scan to Mobile] dialog box when 
the sending of the scanned image is completed.

The [Scan to Mobile] dialog box closes automatically when the mobile device is 
disconnected from the computer.
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Using the ScanSnap in Various Ways (for Windows Users)
Using the ScanSnap in Various Ways

This section explains about various ways of using the ScanSnap.

■ Scanning Only One Side of a Document

By default, the ScanSnap scans in duplex mode.
To perform simplex scanning, perform the following steps to change the setting.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Scanning side] drop-down list in the [Scanning] tab, select 
[Simplex Scan (Single-sided)].

3. Click the [OK] button to close the ScanSnap setup dialog box.

4. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).
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Using the ScanSnap in Various Ways (for Windows Users)
5. Press the [Scan] button on the ScanSnap to start a scan.

Scanned image is saved.

When you select [Simplex scan] from the Right-Click Menu, scanning is performed in 
simplex mode even if [Duplex Scan (Double-sided)] is specified for [Scanning side] in the 
[Scanning] tab.
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Using the ScanSnap in Various Ways (for Windows Users)
■ Scanning Color Documents in Gray or Black & White

When [Auto color detection] is specified for [Color mode] in the [Scanning] tab of the 
ScanSnap setup dialog box, the ScanSnap automatically recognizes whether the scanned 
document is color, gray or black & white, and saves documents in their respective color 
modes.
If you want to scan color documents and save them in gray or black & white, change the 
settings in the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In [Color mode] drop-down list in the [Scanning] tab, select [Gray] or 
[B&W].

3. Click the [OK] button to close the ScanSnap setup dialog box.

4. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

5. Press the [Scan] button on the ScanSnap to start a scan.

Scanned image is saved in gray or black & white.
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Using the ScanSnap in Various Ways (for Windows Users)
■ Scanning Color Documents in High Compression

The ScanSnap can save image data of color documents in high compression mode. You can 
scan large quantities of color documents in high compression mode and save them as a 
compact PDF file.
To scan color documents in high compression mode, perform the following steps to change 
the setting.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Color mode] drop-down list in the [Scanning] tab, select [Color 
high compression].

3. Click the [OK] button to close the ScanSnap setup dialog box.

4. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

In [Color high compression] mode, different compression rates are applied to characters and 
backgrounds. Therefore, the file size of a document with mostly text characters is reduced, while 
the quality of the characters is kept high.
However, high compression is applied to photographs and figures since they are regarded as 
backgrounds, resulting in deteriorated image data. For this reason, this mode is not appropriate 
for scanning photographs, images and such.
221



Using the ScanSnap in Various Ways (for Windows Users)
5. Press the [Scan] button on the ScanSnap to start a scan.

The scanned document is saved as highly compressed color image data.
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Using the ScanSnap in Various Ways (for Windows Users)
■ Deleting Blank Pages from the Scanned Image

The ScanSnap can detect and automatically delete blank pages from a scanned image. 
For example, when you scan a mixed batch of double-sided and single-sided documents in 
duplex mode, the images are generated without the back sides of the single-sided documents 
(blank pages).
To delete blank pages, perform the following steps to change the setting.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. Click the [Option] button in the [Scanning] tab.

The [Scanning mode option] dialog box appears.

The following documents may be detected as blank.
- Almost blank documents with only a few characters
- Documents of only one color (including black) and without any patterns, lines or 

characters
When you scan such documents, clear the [Allow automatic blank page removal] check box.
Also make sure to check the image data for accidentally deleted pages when discarding the 
scanned document.
Blank pages are not deleted when CardMinder is used.
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3. Select the [Allow automatic blank page removal] check box.

4. Click the [OK] button to close all open dialog boxes.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

Scanned image is saved without any blank pages.
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■ Correcting Skewed Character Strings

When documents with skewed character strings are scanned, the ScanSnap is able to detect 
the skewed character strings and correct them.
To correct skewed character strings, change the settings in the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. Click the [Option] button in the [Scanning] tab.

The [Scanning mode option] dialog box appears.

Up to +/-5 degrees of skew can be corrected.
Since this option is performed assuming that the document contains a certain amount of text, 
character strings may be adjusted at a wrong angle when the scanning the following types of 
documents.
In that case, clear the [Correct skewed character strings automatically] check box:
- Documents on which pitches between lines or characters are extremely narrow, or 

characters are overlapped
- Documents with many outlined or decorated characters
- Documents with many photographs or figures and few characters
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with characters printed in various directions such as drawings
- Documents with long diagonal lines
- Documents including handwritten characters.

This setting is disabled when you perform a scan using the Carrier Sheet.

You do not have to enable [Correct skewed character strings automatically] when [Automatic 
detection] is specified for [Paper size] in the [Paper] tab of the ScanSnap setup dialog box 
because the skewed image is always corrected when documents are scanned by this setting.
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Using the ScanSnap in Various Ways (for Windows Users)
3. Select the [Correct skewed character strings automatically] check box.

4. Click the [OK] button to close all open dialog boxes.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

Scanned image is saved with skewed character strings corrected.
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■ Correcting the Orientation of Scanned Images

In an office environment, it is often the case that a single batch contains same size documents 
of different page orientations.
The ScanSnap is able to automatically rotate each scanned image to its correct orientation for 
such document batches.
To rotate scanned images to their correct orientations, change the settings in the following 
procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

Since this option determines the document’s page orientation based on the character strings 
printed on the document, the following types of documents may be rotated to the wrong 
orientation.
In that case, clear the [Allow automatic image rotation] check box:

Documents with many extremely large or small characters
Documents on which pitches between lines or characters are extremely narrow, or characters 
are overlapped
Documents with many characters contacting underlines or borders
Documents with many photographs or figures and few characters
Documents with characters on an unevenly colored background
e.g. Shaded characters
Documents with many decorated characters
e.g. Decorated characters (embossed/outlined)
Documents with characters on a patterned background
e.g. Characters overlapping illustrations and diagrams
Documents with characters printed in various directions such as drawings
Documents written using only capital letters
Documents including handwritten characters.
Skewed documents
Documents written in an unsupported language (language other than Japanese/English/ 
French/German/Italian/Spanish/Chinese (simplified)/Chinese (traditional)/Korean/Russian/ 
Portuguese)
Documents with complex layouts
Documents with a large amount of image noise
Documents with faint characters
Documents with faded characters
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2. Click the [Option] button in the [Scanning] tab.

The [Scanning mode option] dialog box appears.

3. Select the [Allow automatic image rotation] check box.

4. Click the [OK] button to close all open dialog boxes.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start scan.

The scanned image is saved in correct orientation.
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■ Scanning Documents of Different Widths or Lengths 
in One Batch

You can scan documents of different widths or lengths in one batch.
To scan documents of different widths or lengths in one batch, change the settings in the 
following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size].
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3. Select an item other than [Check Length] in [Multifeed Detection].

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load documents in the ScanSnap.

1. Align the edges of the documents.

2. Place the documents at the center of the ADF paper chute (cover).

If you scan documents of different widths or lengths in one batch with [Check Length] 
selected, documents will be detected as multifeeds and scanning cannot be performed. 
Note that scanning Letter and A4 size documents in the same batch does not result in 
multifeed detection.
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6. Press the [Scan] button on the ScanSnap to start scan.

Scanned images are output in the original document sizes.

Make sure that all documents are placed above the pick roller.
Otherwise, some documents will not be picked.

Adjust the side guides to the widest document in the batch.
Carefully load small documents that cannot reach the side guide straight into the ADF 
paper chute (cover). If the documents are skewed during scanning, the quality of 
scanned image data may be degraded (partly lost image data/slant lines produced) or 
scanned image data may be output in a different size than the original. If you have 
difficulties in scanning the documents straight, it is recommended to scan documents in 
several batches, documents of the same width being in the same batch, and enable 
continuous scanning.
Note that documents that cannot be guided by the side guide may cause paper jams.

If the documents are scanned skewed, the images may not be output in their original 
sizes.

Pick roller's width
231



Using the ScanSnap in Various Ways (for Windows Users)
■ Scanning Documents Larger Than A4/Letter Size

You can scan documents larger than A4/Letter size such as A3, 11 × 17 in. and B4 size using 
the Carrier Sheet. By folding the document in half and scanning in duplex mode, the two sides 
are merged into a single image.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then 
click the [Carrier Sheet Settings] button.

The [Carrier Sheet Settings] dialog box appears.

The [Correct skewed character strings automatically] check box ([Scanning] tab → [Option] in the 
ScanSnap setup dialog box) will be disabled.

You can also scan documents smaller than A4/Letter size and have both sides saved as a single 
image.
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3. Select [one double-page spread image] in [Save as] and click the [OK] 
button.

For details about the Carrier Sheet settings, refer to the ScanSnap Manager Help.

4. In the [Scanning side] drop-down list in the [Scanning] tab, select 
[Duplex Scan (Double-sided)] and click the [OK] button.

If [Simplex Scan (Single-sided)] is specified for [Scanning side] in the [Scanning] tab, the 
ScanSnap outputs the same result as performing a simplex scan in [two separate 
images (front and back)] mode.
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5. Place the document inside the Carrier Sheet.

1. Fold the document in half so that the sides to be scanned are facing out.
Fold it tightly and smooth out any creases.

2. Open the Carrier Sheet to bind the document.
Align the fold line with the right edge of the 
Carrier Sheet so that the document fits in 
the upper right-hand corner of the Carrier 
Sheet.

6. Place the end with the black and white pattern as the leading edge in the 
direction of the arrow.

Secure the Carrier Sheet with the side guides to avoid 
skewing.

Note that the front side of the Carrier Sheet has a thick vertical line in the upper right-
hand corner.
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7. Press the [Scan] button on the ScanSnap to start a scan.

Both sides of the document are scanned and saved 
as one double-page spread image.

There may be a line or a gap appearing between the front and back side images.
Also when you scan thick papers, images on both left and right may skew towards each other 
from the top.
These symptoms may be improved when you perform the following:
- Fold the document properly
- Neatly align the edges of the document with the edges of the Carrier Sheet when placing 

the document inside the Carrier Sheet
If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] dialog box, 
an optimal size will be selected automatically from the available standard sizes (A3, B4 or 11 
× 17 in.) from the same drop-down list.                                                                                             
Note that the size of the image may become smaller than the original document depending 
on the document.
Example: When you scan an A3 size document whose content is printed to fit A4 size in the 

center, the image data is output in B4 size.
To output the scanned image in its original size, specify the document size in the [Paper size] 
drop-down list.
Part of the image data around where the document is folded may appear missing.
In that case, place the document so that its edge is about 1 mm inside from the edge of the 
Carrier Sheet.
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■ Scanning Documents Such as Photographs and 
Clippings

Using the Carrier Sheet allows you to scan documents that can be damaged quite easily such 
as photographs, or non-standard size documents that are difficult to load directly such as 
clippings.
Change the settings to scan documents such as photographs and clippings in the following 
procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then 
click the [Carrier Sheet Settings] button.

The [Carrier Sheet Settings] dialog box appears.

The [Correct skewed character strings automatically] check box ([Scanning] tab → [Option] in the 
ScanSnap setup dialog box) will be disabled.
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3. Select [two separate images (front and back)] in [Save as] and click the 
[OK] button.

For details about the Carrier Sheet settings, refer to the ScanSnap Manager Help.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Place the document inside the Carrier Sheet.

Open the Carrier Sheet and place the top of the 
document against the top center of the Carrier Sheet.
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6. Place the end with the black and white pattern as the leading edge in the 
direction of the arrow.

Set the back side of the document facing towards you.
Secure the Carrier Sheet with the side guides to avoid 
skewing.

When the [Set the document with its face up] check box is selected in the [Scanning mode 
option] dialog box (Right-Click Menu → [Scan Button Settings] → the [Scanning] tab → the 
[Option] button), place the document in the Carrier Sheet face-up and bottom edge down.

Back Back
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7. Press the [Scan] button on the ScanSnap to start a scan.

Scanned image is saved.

The scanned image is output at the center of the page in the size specified in the 
[Paper size] drop-down list of the [Carrier Sheet Settings] dialog box.
If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] dialog 
box, an optimal size will be selected automatically from the available standard sizes 
(A3, B4 or 11 × 17 in.) from the same drop-down list.                                                                                             
Note that the size of the image may become smaller than the original document 
depending on the document scanned, or part of the image may appear missing.
Example: When an A5 size image is printed in the center of an A4 size document, the 

image is output in A5 size.
To output the scanned image in its original size, specify the document size in the [Paper 
size] drop-down list.

In the following cases, place a blank (white) sheet of paper underneath the document when 
scanning:

The scanned image is not saved in the correct size (when [Automatic detection] is 
selected in the [Paper size] drop-down list of the [Carrier Sheet Settings] dialog box)
Shadows appear around the edges of the scanned image
Black lines appear around the edges of a uniquely shaped cutting

Blank 
sheet
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■ Long Page Scanning

Documents up to 863 mm (34 in.) in length can be scanned.
The following explains how to scan long pages.

1. Load a document in the ScanSnap.

For details about documents that can be loaded, refer to "How to Load Documents" 
(page 32).

Long page documents should be loaded one sheet at a time in the ADF paper chute 
(cover).

When you scan long pages, take note of the following.

Loading
Hold the document with your hands so 
that it does not fall out of the ADF paper 
chute (cover).

Removing
Secure enough space around the 
stacker to prevent the ejected sheet 
from falling off the stacker.
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2. Press the [Scan] button on the ScanSnap for 3 seconds or longer until it 
flashes in blue.

Scanning starts.

When you scan the first page as a long page and continue scanning, the next document is 
also scanned as long page.

The error message below appears and long page scanning is disabled when [Excellent] 
is selected in the [Image quality] drop-down list of the [Scanning] tab in the ScanSnap 
setup dialog box.

When you perform a long page scan, the current settings are ignored and the following 
settings are used:
- Multifeed Detection: None
- Paper size: Automatic detection
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■ Saving Scanned Images in Multiple PDF Files

The ScanSnap is able to save scanned image in separate PDF files based on the specified 
number of pages. For example, you can scan a batch of slips, and save each slip as a PDF 
file.
To save image data in multiple PDF files, change the settings in the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears. 

2. In the [File format] drop-down list in the [File option] tab, select [PDF 
(*.pdf)], and then click the [Option] button.

The [PDF file format option] dialog box appears.
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3. Select [Generate one PDF file per (n) page(s)] and enter the number of 
pages to split.

One PDF is created every time the number of pages specified here has been saved.

4. Click the [OK] button to close all open dialog boxes.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

One PDF file is created every time the number of pages specified in step 3. has been 
scanned.

In duplex mode, two pages (front/back) are created per document.
When you select the [Allow automatic blank page removal] check box in the [Scanning 
mode option] dialog box ([Scanning] tab → [Option] button), the number of pages of the 
original document and the scanned image does not match when blank pages are deleted. 
Clear this check box when you want to keep the original page number order.
243



Using the ScanSnap in Various Ways (for Windows Users)
■ Creating Searchable PDF Files

The ScanSnap is able to perform text recognition on a scanned image automatically and 
create a searchable PDF file.
To create searchable PDF files, change the settings in the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [File format] drop-down list in the [File option] tab, select [PDF 
(*.pdf)].

It is recommended that you select [Better] or [Best] for [Image quality] in the [Scanning] tab 
of the ScanSnap setup dialog box.
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3. Select the [Convert to Searchable PDF] check box.

The following message appears.

Click the [OK] button to close the dialog box.

Language
Select the language. Japanese, English, French, German, Italian, Spanish, Chinese 
(simplified), Chinese (traditional), Korean, Russian, and Portuguese can be selected.
Target pages
Select [All pages] to perform text recognition for all pages and [First page] for just the 
first page.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).
245



Using the ScanSnap in Various Ways (for Windows Users)
6. Press the [Scan] button on the ScanSnap to start a scan.

Text recognition is performed on the scanned image and a searchable PDF file is 
created.

It may take extra time to process text recognition depending on your computer system 
environment when you enable this setting in step 3.
Scanned images of the following types of documents (characters) may not be 
recognized correctly.
In that case, better results in text recognition may be achieved by changing the setting 
for [Color mode] or specifying a higher resolution in [Image quality].
- Documents including handwritten characters.
- Documents with small characters scanned at a low resolution
- Skewed documents
- Documents written in languages other than the specified language
- Documents including texts written in italic characters
- Documents containing characters with superscripts/subscripts and complicated 

mathematical expressions 
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders

It may take extra time to perform text recognition on the following documents:
- Documents with complex layouts
- Documents with information other than text

e.g. Text on a shaded background
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■ Automatically Setting Keywords for PDF Files

If the document is black & white, character strings (e.g. page heading, title) can be set as 
keywords and used for a PDF file search. 
Mark a character string to be set as a keyword with a water-based highlight pen so that the 
character string is completely covered. 
When you perform a scan, the marked character strings are recognized and set as keywords 
for the PDF file.

Mark black & white documents in the following way:
Any regular highlight pen can be used. 
The following shows the colors and thickness recommended for highlight pens:

Mark a straight line over a single character string.
The supported range of a marked section is as follows: 
Minimum: 3 mm (short side) × 10 mm (long side) 
Maximum: 20 mm (short side) × 150 mm (long side) 
Use only one color per page for marking.

Pink Yellow Blue Green

Scan

Scan

Scan Scan

Sets text as a keyword for the PDF 
file

Searchable PDF file

ImageConverts character string in a 
marked section into text

keyword

You can search for the file through 
the set keyword
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Make sure to cover the entire character string when marking it. 
Mark sections so that the entire section is evenly colored.

Do not mark more than ten sections per page.

Change the settings in the following procedure to automatically set keywords for PDF files.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

Good example: Bad example 1:
(does not cover the entire section)

Bad example 2:
(unevenly colored)

For the following documents, marked sections cannot be recognized and set as keywords:
- Color documents such as catalogues or pamphlets 
- Documents in which two or more colors are used for marking 
- Documents containing colors other than for marking (pens other than highlight pens are 

used or the document is stained) 
- Documents with too many marked sections on a single page

The following types of marked character strings cannot be set as keywords:
- The size of the marked section is outside the supported range 
- The marking is irregular (e.g. skewed) 
- Multiple marked sections are too close to each other 
- The color of the highlight pen is too pale or the color has faded 

When you mark more than one character string, make sure to leave a gap of at least 5 mm 
between the marked sections. Marked sections that are too close to each other may be 
detected as one marked section.
In the following case, character strings surrounding marked sections may be set as 
keywords: 
- Marked section overlaps the line above and below 

In the following cases, unmarked character strings may be set as keywords:
- Color documents such as catalogues or pamphlets 
- Documents with color text, diagrams, pictures, tables and lines
- Documents containing sections framed by a highlight pen
- Stained documents

Increase the resolution when you have trouble setting the keywords correctly.
Keywords set for a PDF file can be checked in the ScanSnap Organizer Main Window 
(thumbnail view), or in [Document Properties] of Adobe Acrobat/Adobe Reader.
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2. In the [File format] drop-down list in the [File option] tab, select [PDF 
(*.pdf)].

3. Select the [Set the marked text as a keyword for the PDF file] check box.

It is recommended that you select [Better] or [Best] for [Image quality] in the [Scanning] tab 
of the ScanSnap setup dialog box.
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Target marked sections
Select [First marked section] to perform text recognition and set a keyword for the 
PDF file only for the character strings in the first marked section, and [All marked 
sections] for all marked sections.

Language
Select the language. Japanese, English, French, German, Italian, Spanish, Chinese 
(simplified), Chinese (traditional), Korean, Russian, and Portuguese can be selected.
Target pages
Select [First page] to perform text recognition and set a keyword for the PDF file only 
for the first page, and [All pages] for all pages.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

Do not select [First marked section] when the text orientation of your document is 
vertical.

The following explanation is for when you select [First marked section]:
Select this button to set a character string such as a title of a document as a 
keyword for the PDF file.
Example: When only the title of a document is marked, the marked character 

string is set as a keyword for the PDF file, and the PDF file becomes 
searchable by the title character string.

When multiple marked sections exist in line, the marked character string closest 
to the top of the document is set as a keyword. 
Example: In the following case, the character string in marked section B, which is 

higher than marked section A, is set as a keyword.

Marked section A Marked section B
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6. Press the [Scan] button on the ScanSnap to start a scan.

Text recognition is performed on marked character strings and a PDF file is created 
with the keywords added.

It may take extra time to process text recognition depending on your computer system 
environment when you enable this setting in step 3.
Scanned images of the following types of documents (characters) may not be 
recognized correctly.
In that case, better results in text recognition may be achieved by specifying a higher 
resolution in [Image quality].
- Documents including handwritten characters.
- Documents with small characters scanned at a low resolution
- Skewed documents
- Documents written in languages other than the specified language
- Documents including texts written in italic characters
- Documents containing characters with superscripts/subscripts and complicated 

mathematical expressions 
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders

It may take extra time to perform text recognition on the following documents:
- Documents with complex layouts
- Documents with information other than text

e.g. Text on a shaded background
If the same character string is marked several times in the document, the same 
keyword is added multiple times in the PDF file.
Total length of all the keywords can be up to 255 characters, including punctuation 
marks in between keywords.
When you check keywords in Adobe Acrobat or Adobe Reader, the added keywords 
may be displayed with a set of quotation marks (e.g. "ABC").
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■ Setting Document Open Passwords for PDF Files

You can set Document Open passwords for PDF files when saving the image data as PDF 
files.
Once you set a password for a PDF file, the password-protected PDF files cannot be opened 
by anyone except the person who knows the password. You can protect important information 
by setting a password for private or confidential documents.
Change the settings to set passwords for PDF files in the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The ScanSnap setup dialog box appears.

2. In the [File format] drop-down list in the [File option] tab, select [PDF 
(*.pdf)], and then click the [Option] button.

The [PDF file format option] dialog box appears.

When you use the Quick Menu, you cannot set passwords to scanned documents.
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3. Select the [Set a password for PDF file] check box.

To set a different password per scan
Clear the [Use a fixed password] check box.
You can set a different password per scan.
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To use a preset password
1. Select the [Use a fixed password] check box.

The same password is set for all PDF files. You do not have to set a password every 
time a document is scanned.

2. Type in the same password in the [Password] and [Confirm] fields.

4. Click the [OK] button to close all open dialog boxes.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

The following characters can be used to set passwords:
Up to 16 characters
Alphanumeric characters: A-Z, a-z, 0-9
Symbols:! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { |  } ~
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6. Press the [Scan] button on the ScanSnap to start a scan.

When the [Use a fixed password] check box is cleared in step 3., the following dialog 
box appears after scanning is completed.

Type in the same password in the [Password] and [Confirm] fields, and then click the 
[OK] button.

The scanned image is saved as a password-protected PDF file.

The following characters can be used to set passwords:
Up to 16 characters
Alphanumeric characters: A-Z, a-z, 0-9
Symbols: ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \  ] ^ _ ` { | } ~
If you click the [Cancel] button, the PDF file is saved without a password.

It is not possible to open a PDF file if you forget the password.
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This chapter explains how to perform scanning, configure scan settings, add, change or 
delete profiles, as well as various scanner functions and uses.

ScanSnap Manager Icon and Operations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 257

How to Perform a Scan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261

Configuring ScanSnap Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 272

Actions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291

Using the ScanSnap in Various Ways . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 386
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ScanSnap Manager Icon and Operations

All operations on the ScanSnap are managed in ScanSnap Manager.
The ScanSnap Manager icon appears in the Dock to indicate that ScanSnap Manager is 
running. The icon automatically appears in the Dock when Mac OS starts up.
The ScanSnap Manager icon indicates whether or not ScanSnap Manager is successfully 
communicating with the ScanSnap. The appearance of the icon changes according to the 
communication status as shown below.

A menu appears when you click the ScanSnap Manager icon while pressing the [control] key 
on the keyboard.

Status ScanSnap Manager icon

Communicating

Not communicating

When you add the ScanSnap Manager icon to the Dock, normally  
appears.
A blue light appears under the ScanSnap Manager icon when ScanSnap 
Manager is running.
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■ ScanSnap Manager Menu

This menu appears when you click the ScanSnap Manager icon  while pressing the 
[control] key on the keyboard.

Item Function

Duplex scan Scans both sides of the document. Follows the settings configured in 
[Settings].

Simplex scan Scans only one side of the document. Follows the settings configured in 
[Settings].

Settings Displays the ScanSnap setup window.
You can configure the scan settings in this window.

"How to Configure Scan Settings" (page 275)

Profile Displays the Profile menu.
You cannot select [Profile] when the [Use Quick Menu] checkbox is selected 
in the ScanSnap setup window.

"Profile Menu" (page 260)

Profile Management Displays the [ScanSnap Manager - Profile Management] window.
You cannot select [Profile Management] when the [Use Quick Menu] 
checkbox is selected in the ScanSnap setup window.

"Profile Management" (page 278)

Check consumable status Displays the [ScanSnap Manager - Check consumable status] window. You 
can reset the consumable counters after replacing the consumables.

"Consumables" (page 430)

Help Displays the following menu:
Help
Opens the ScanSnap Manager Help.
Troubleshooting
Displays [Troubleshooting] in the ScanSnap Manager Help.
ScanSnap Portal Site
Opens the ScanSnap global homepage (http://scansnap.fujitsu.com/).
About ScanSnap Manager
Displays the [ScanSnap Manager - Version Information] window.
Preferences
Displays the [ScanSnap Manager - Preferences] window.
Online Update
Displays the [ScanSnap Manager - Online Update] window (page 449).

Click while pressing the [control] 
key on the keyboard
258



ScanSnap Manager Icon and Operations (for Mac OS Users)
* : Select the [Options] sub-menu to display these items.

Keep in Dock (*) Adds the ScanSnap Manager icon  to the Dock.

Open at Login (*) Automatically launches ScanSnap Manager when Mac OS is started up.

Show in Finder (*) Displays the contents of the [ScanSnap] folder by using the Finder.

Hide/Show Hides or redisplays all windows of ScanSnap Manager that are being 
displayed.

Quit Exits ScanSnap Manager.
"Finishing ScanSnap Operation" (page 271)

Item Function
259



ScanSnap Manager Icon and Operations (for Mac OS Users)
■ Profile Menu

This menu appears when you click the ScanSnap Manager icon .
Available profiles are displayed in the Profile menu.

Select a profile in the Profile menu before you perform scanning. Documents are scanned 
according to the scan settings of the selected profile.
For details about how to add, change or delete profiles, refer to "Profile Management" (page 
278).

To enable the Profile menu, clear the [Use Quick Menu] checkbox in the ScanSnap setup 
window. The Profile menu does not appear when this checkbox is selected.
You can also display the Profile menu by selecting [Profile] from ScanSnap Manager menu.
Profiles configured for the following scanner models will be carried over to ScanSnap S1500/
S1500M if the computer is the same:
- ScanSnap S1300
- ScanSnap S1100
- ScanSnap S510M
- ScanSnap S500M
- ScanSnap S300M

Click

Profile menu example
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How to Perform a Scan

This section explains how to perform scanning with the ScanSnap.

■ Preparation

1. Turn on the computer.

The ScanSnap Manager icon  appears in the Dock when Mac OS starts up.

2. Open the ADF paper chute (cover) of the ScanSnap to turn the power on.

The ScanSnap Manager icon changes from  to .

There are two ways to perform scanning, either with the Quick Menu or without using the 
Quick Menu. For details, refer to the following:

Using the Quick Menu (→ page 262)
Without Using the Quick Menu (→ page 267)

If the ScanSnap Manager icon  is not displayed, select [Applications] and double-
click [ScanSnap] → [ScanSnap Manager] from Finder to start up ScanSnap Manager.
If ScanSnap Manager does not start automatically when Mac OS starts up, select 
[Accounts] → [My Account] → [Login Items] → [ ] → [ScanSnap Manager] in the 
[System Preferences] window to start up ScanSnap Manager.

There may be a slight delay before the ScanSnap Manager icon changes to  depending 
on your computer's performance, operating environment and load such as when multiple 
programs are running at the same time.

ADF paper chute (cover)
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■ Using the Quick Menu

The following explains the procedure for scanning by using the Quick Menu.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. Select the [Use Quick Menu] checkbox.

3. Click one of the profile buttons.

Profile Button Description

[Recommended] 
button

Settings are [Automatic resolution] for [Image quality] in the [Scanning] tab in the 
ScanSnap setup window and default for other settings.
It is recommended that you select this button when you want to scan documents 
in optimum quality suitable for the paper size of the document.

[Small File] button Settings are [Normal] (Color/Gray: 150 dpi, B&W: 300 dpi) for [Image quality] in 
the [Scanning] tab in the ScanSnap setup window and default for other settings.
It is recommended that you select this button when you want to reduce the file 
size.

[High Quality] 
button

Settings are [Best] (Color/Gray: 300 dpi, B&W: 600 dpi) for [Image quality] in the 
[Scanning] tab in the ScanSnap setup window and default for other settings.
It is recommended that you select this button when you want to scan documents 
in high quality.

[Customize] button Default settings are the same as the [Recommended] settings.
Scan settings can be changed depending on your scanning purpose.

Profile Button
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4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

7. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan] button on the ScanSnap flashes in blue throughout the scan.
The [ScanSnap Manager - Image scanning and file saving] window appears.

The Quick Menu appears when the scanning is completed.

The [Recommended] button is selected in default.
For details about the default settings when using the Quick Menu, refer to the 
ScanSnap Manager Help.
You cannot change the settings for the [Recommended], [Small File], and [High Quality] 
buttons. If you change any of these settings, the profile automatically switches to 
[Customize].
For details about how to change scan settings, refer to "How to Configure Scan 
Settings" (page 275).

The [Scan] button setting is [Duplex Scan (Double-sided)] in default. Note that you can 
switch the [Scan] button setting to [Simplex Scan (Single-sided)] in ScanSnap 
Manager. For more details, refer to "Scanning Only One Side of a Document" (page 
386).
You can also start scanning from the ScanSnap Manager menu.
For more details, refer to "ScanSnap Manager Menu" (page 258).

Do not connect or disconnect the ScanSnap and other USB devices during scanning.
Do not close the ADF paper chute (cover) during scanning.
Do not switch users during scanning.
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8. In the Quick Menu, click the icon of the application to link with ScanSnap 
Manager.

The selected application starts up.

To specify which applications to display/hide in the Quick Menu, or change the display 
order of the applications, refer to "Quick Menu Settings" (page 272).
To select an application to link with ScanSnap Manager before scanning, refer to 
"Without Using the Quick Menu" (page 267).

Application Description

Scan to Folder Displays the [Scan to Folder] window.
You can specify the destination folder to save the scanned 
images.
For details about how to continue the process after you select 
this item, refer to "Saving Data in a Specified Folder" (page 
293).

Scan to E-mail Displays the [Scan to E-mail] window.
Attaches the scanned images to an e-mail message.
For details about how to continue the process after you select 
this item, refer to "Attaching Files to E-Mail" (page 300).

Scan to Print Displays the [Print] window.
Prints out the scanned images with a specified printer.
For details about how to continue the process after you select 
this item, refer to "Using the ScanSnap as a Copy Machine" 
(page 308).

Scan to Mobile Displays the [Scan to Mobile] window.
You can save the scanned images to a mobile device.
For details about how to continue the process after you select 
this item, refer to "Saving Data to a Mobile Device" (page 371).

Scan to Evernote 
(Document) (*1) (*2)

You can save PDF files created from the scanned images to 
Evernote.
For details about how to continue the process after you select 
this item, refer to "Saving Documents to Evernote" (page 335).

Scan to Evernote (Note) 
(*1) (*2)

You can save JPEG files created from the scanned images to 
Evernote.
For details about how to continue the process after you select 
this item, refer to "Saving Handwritten Notes to Evernote" (page 
341).
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*1 : Displayed when Mac OS v10.5.8 or later is installed.
*2 : Displayed when Evernote for Mac 1.10 or later is installed.
*3 : Displayed when SugarSync Manager for Mac 1.9.29 or later is installed.
*4 : Displayed when ABBYY FineReader for ScanSnap is installed.
*5 : Displayed when Cardiris is installed.
*6 : Displayed when iPhoto 5 or later is installed.

Scan to Google Docs(TM) 
(*1)

You can save PDF files created from the scanned images to 
Google Docs.
For details about how to continue the process after you select 
this item, refer to "Saving Documents to Google Docs" (page 
346).

Scan to Salesforce 
Chatter

You can post scanned images to Salesforce Chatter.
For details about how to continue the process after you select 
this item, refer to "Posting to Salesforce Chatter" (page 354).

Scan to SugarSync (*1) 
(*3)

You can save scanned images to your SugarSync folder.
For details about how to continue the process after you select 
this item, refer to "Saving Data to Your SugarSync Folder" 
(page 364).

Scan to Word (*4) Creates a Word file by converting the scanned images into text 
data.
For details about how to continue the process after you select 
this item, refer to "Converting into Word/Excel Documents" 
(page 314).

Scan to Excel (*4) Creates an Excel file by converting the scanned images into text 
data.
For details about how to continue the process after you select 
this item, refer to "Converting into Word/Excel Documents" 
(page 314).

Cardiris (*5) Displays the Cardiris window.
Saves the scanned images in Cardiris.
For details about how to continue the process after you select 
this item, refer to "Storing Business Cards in Cardiris" (page 
322).

iPhoto (*6) Displays the [iPhoto] window.
Saves the scanned images in iPhoto.
For details about how to continue the process after you select 
this item, refer to "Storing Scanned Images in iPhoto" (page 
330).

The output image may slightly differ from the original document in size.
When one of the below applications is active (application menu appears in the menu 
bar), scanning documents by pressing the [Scan] button on the ScanSnap 
automatically starts the linkage between ScanSnap Manager and the application.
- Cardiris (links with ScanSnap Manager only when the document is of business card 

size)
- Scan to Mobile

For details about automatic linkage, refer to "Automatic Linkage with Applications" 
(page 288).

Application Description
265



How to Perform a Scan (for Mac OS Users)
You cannot start scanning when the Quick Menu is displayed. Either select an icon from 
the Quick Menu and finish the process, or close the Quick Menu before you perform the 
next scan.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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■ Without Using the Quick Menu

The following explains the procedure for scanning without using the Quick Menu.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. Clear the [Use Quick Menu] checkbox.

3. Select a profile.

Select a profile from either of the following:

[Profile] pop-up menu in the ScanSnap setup window

Profile menu
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4. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

5. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan] button on the ScanSnap flashes in blue throughout the scan.
The [ScanSnap Manager - Image scanning and file saving] window appears.

The application specified for the selected profile starts up when the scanning is 
completed. 

The [Scan] button setting is [Duplex Scan (Double-sided)] in default. Note that you can 
switch the [Scan] button setting to [Simplex Scan (Single-sided)] in ScanSnap 
Manager.
For more details, refer to "Scanning Only One Side of a Document" (page 386).
You can also start scanning from the ScanSnap Manager menu.
For more details, refer to "ScanSnap Manager Menu" (page 258).

Do not connect or disconnect the ScanSnap and other USB devices during scanning.
Do not close the ADF paper chute (cover) during scanning.
Do not switch users during scanning.
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To select an application to link with ScanSnap Manager in the Quick Menu after 
scanning is completed, refer to "Using the Quick Menu" (page 262).
When the [Set the marked text as a keyword for the PDF file] or the [Convert to 
Searchable PDF] checkbox is selected in the [File option] tab, the application starts after 
text recognition has been performed on the scanned image.
A window showing the text recognition progress appears.
By default, documents are scanned with the following settings: [Image quality: Automatic 
resolution] and [Color mode: Auto color detection].
For details about how to change scan settings, refer to "How to Configure Scan Settings" 
(page 275).
The application that starts after scanning varies depending on what is selected in the 
[Application] tab in the ScanSnap setup window. For details, refer to the ScanSnap 
Manager Help.
The output image may slightly differ from the original document in size.
When one of the below applications is active (application menu appears in the menu 
bar), scanning documents by pressing the [Scan] button on the ScanSnap automatically 
starts the linkage between ScanSnap Manager and the application.
- Cardiris
- Scan to Mobile

For details about automatic linkage, refer to "Automatic Linkage with Applications" (page 
288).
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■ Stopping the Scan

You can stop a scan in progress in case you are scanning a wrong document or the wrong 
side of a document.
Stop the scan in the following procedure:

1. Click the [Stop] button in the [ScanSnap Manager - Image scanning and 
file saving] window which appears during scanning.

The following message appears when the scanning stops.

2. Click the [Quit] button.

To continue scanning, click the [Continue Scanning] button or press the [Scan] button 
on the ScanSnap after loading another document in the ScanSnap.

Remove the document from the ScanSnap after stopping the scan.
For details about how to remove documents, refer to "Troubleshooting" in the ScanSnap 
Manager Help.
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■ Finishing ScanSnap Operation

Exiting ScanSnap Manager
Select [Quit] from the ScanSnap Manager menu.
Normally, you do not have to exit ScanSnap Manager.

Disconnecting the ScanSnap

1. Close the ADF paper chute (cover) to turn off the ScanSnap.

The ScanSnap Manager icon in the Dock changes from  to .

2. Disconnect the USB cable from the computer.

3. Unplug the power cable of the ScanSnap from the AC outlet.

You cannot use the ScanSnap after exiting ScanSnap Manager.
From Finder, select [Applications] and double-click [ScanSnap] → [ScanSnap Manager] to 
start up ScanSnap Manager when you want to use the ScanSnap.

The ScanSnap does not have a power switch and is turned ON/OFF in conjunction with the 
computer's power. The ScanSnap can also be automatically turned ON/OFF by opening or 
closing the ADF paper chute (cover).
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Configuring ScanSnap Manager

This section explains how to set scan settings, how to add, change and delete profiles, 
automatic linkage with applications and windows displayed during scanning.

■ Quick Menu Settings

You can specify which applications to display or hide in the Quick Menu, as well as change 
the display order of the applications in the following procedure.

1. Click [ ] in the Quick Menu.

For details about how to display the Quick Menu, refer to "Using the Quick Menu" (page 
262).

The [Applications to Show/Hide] window appears.
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2. Specify which applications to display in the Quick Menu.

Showing or Hiding Application Icons
Select the checkbox to display the application in the Quick Menu.
To display all the applications in the Quick Menu, click the [Restore Default] button.

Display Order of Applications
Application icons are displayed in the Quick Menu in the same order as they are listed in 
the [Applications to Show/Hide] window.
Drag an application to change its order.
To restore the default display order of the applications displayed in the Quick Menu, 
click the [Restore Default] button.
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The applications are displayed in the order shown below in the Quick Menu and in the 
[Applications to Show/Hide] window.

3. Click the [OK] button to close the [Applications to Show/Hide] window.

The applications to be displayed in the Quick Menu and their display order are set.
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■ How to Configure Scan Settings
You can configure scan settings in the ScanSnap setup window depending on your intended 
use. Configure the scan settings in the following procedure.

1. Select [Settings] from the ScanSnap Manager menu.
For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. Click the [Detail] button to switch to the detail view mode.

Using the Quick Menu

Without Using the Quick Menu

You can also open the ScanSnap setup window by pressing simultaneously the [command 

( )] and [S] keys on the keyboard. This operation is only enabled when ScanSnap 
Manager is active (when "ScanSnap Manager" is displayed in the menu bar).

The ScanSnap setup window retains the display status from the last time the ScanSnap 
was used. For example, if it was closed in detail view mode, the window is displayed in 
detail view mode next time you open it.

Outline view Detail view

Outline view Detail view
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3. Change the scan settings in each tab.

The following items can be configured in each tab:
For details, refer to the ScanSnap Manager Help.

[Application] tab
- Application to be used with the ScanSnap
[Save] tab
- Folder in which scanned image is saved
- File name used for saving the scanned image
[Scanning] tab
- Scanning

(Which image quality to scan with, use color, gray or black & white, scan in 
simplex or duplex mode, enable or disable [Setting for text only document], [Allow 
automatic blank page removal], [Correct skewed character strings automatically], 
[Allow automatic image rotation] and [Continue scanning after current scan is 
finished].)

[File option] tab
- File format of the scanned image (*.pdf, *.jpg)
- Whether to perform text recognition on a marked character string in the scanned 

image and add the character string as a keyword for the PDF file
(Whether to perform text recognition only on the character strings in the first 
marked section or all marked sections to be added as keywords, and in which 
language to perform text recognition.)

- Whether to perform text recognition on character strings in the scanned image to 
convert the file to a searchable PDF file
(Whether to convert the first page only or all pages, and in which language to 
perform text recognition.)

- Whether to create separate PDF files
(Whether to include all scanned images in a single PDF file, or create PDF files, 
each of which including a preset number of pages)
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[Paper] tab
- Paper size of documents (paper size selection, Carrier Sheet settings)
- Whether to detect multifeed
[Compression] tab
- File size of the scanned image (compression rate)

4. Click the [Apply] button.

When you use the Quick Menu, scan settings for the [Customize] button are 
changed.
When you do not use the Quick Menu, scan settings for the currently selected profile 
are changed.

Scan settings vary depending on the scanning method.
For details about items that can be set, refer to "Setting Items With/Without the Quick 
Menu" (page 457).

If you press the [Scan] button on the ScanSnap while the ScanSnap setup window is 
displayed, the ScanSnap setup window closes and scanning starts.Scan setting changes 
made up to this point are saved and documents are scanned by these settings.
Note that when other windows are open, scanning does not start even if you press the 
[Scan] button on the ScanSnap unless open windows are closed.
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■ Profile Management

You can manage up to 20 profiles.
You can select a profile in the [Profile] pop-up menu in the ScanSnap setup window or from 
the Profile menu.

[Profile] pop-up menu

Profile menu

Once the frequently used scan settings are saved as profiles, you do not have to open the 
ScanSnap setup window to change scan settings every time you perform scanning. You can 
easily switch to an appropriate profile you want by just selecting it.
For details about how to add, change or delete profiles, refer to the following:

To add a new profile (→ page 279)
To change scan settings for profiles (→ page 282)
To rename a profile (→ page 284)
To delete a profile (→ page 286)

To use a profile, you need to clear the [Use Quick Menu] checkbox in the ScanSnap setup 
window.
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Adding Profiles

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. Configure the scan settings in each tab.

For details about each tab, refer to the ScanSnap Manager Help.

Clear the [Use Quick Menu] checkbox if it is selected.
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3. Select [Add Profile] from the [Profile] pop-up menu.

The [Add new profile] window appears.

4. Type in a new profile name and click the [OK] button.

The added profile appears in the [Profile] pop-up menu in the ScanSnap setup 
window.

5. Click the [Apply] button.
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6. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

Up to 20 profiles can be saved including the [Standard] profile.
You can change the display order of profiles except for the [Standard] profile.
1. Select [Profile Management] from the ScanSnap Manager menu or from the 

[Profile] pop-up menu in the ScanSnap setup window.
Displays the [ScanSnap Manager - Profile Management] window.

2. Drag the profile to move it to its desired position in the list.

3. Click the [ ] button to close the [ScanSnap Manager - Profile Management] 
window.
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Changing Profile Settings

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. Select a profile from the [Profile] pop-up menu.

3. Change the scan settings in each tab.

For details about each tab, refer to the ScanSnap Manager Help.

Clear the [Use Quick Menu] checkbox if it is selected.
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4. When you finish changing the settings for the selected profile, click the 
[Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.
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Renaming Profiles

1. Select [Profile Management] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The [ScanSnap Manager - Profile Management] window appears.

2. Select a profile, click the [ ] button in the lower left corner, and select 
[Rename].

The name field of the profile becomes editable.

If you cannot select [Profile Management] in the ScanSnap Manager menu, clear the 
[Use Quick Menu] checkbox in the ScanSnap setup window.
You can also display the [ScanSnap Manager - Profile Management] window by 
selecting [Profile Management] from the [Profile] pop-up menu in the ScanSnap setup 
window.

The [Standard] profile cannot be renamed.
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3. Type in a new name.

The profile is renamed.

4. Click the [ ] button to close the [ScanSnap Manager - Profile 
Management] window.

A message window appears.

5. Click the [Apply] button.
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Deleting Profiles

1. Select [Profile Management] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The [ScanSnap Manage - Profile Management] window appears.

2. Select a profile and click the [ ] button.

The selected profile is deleted.

3. Click the [ ] button to close the [ScanSnap Manager - Profile 
Management] window.

A message appears.

If you cannot select [Profile Management] in the ScanSnap Manager menu, clear the 
[Use Quick Menu] checkbox in the ScanSnap setup window.
You can also display the [ScanSnap Manager - Profile Management] window by 
selecting [Profile Management] from the [Profile] pop-up menu in the ScanSnap setup 
window.

The [Standard] profile cannot be deleted.
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4. Click the [Apply] button.
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■ Automatic Linkage with Applications

When one of the following applications is active (application menu appears in the menu bar), 
scanning documents by pressing the [Scan] button on the ScanSnap automatically starts the 
linkage between ScanSnap Manager and the application even when the Quick Menu is 
enabled.
Applications that can automatically link with ScanSnap Manager are as follows:

Cardiris
Scanned image is displayed in Cardiris.
Scan to Mobile
Scanned image is sent to a mobile device.

The example above shows ScanSnap Manager automatically linking with Scan to 
Mobile when Scan to Mobile window is in front (active).

ActiveNot active
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■ Showing the Scanning Progress

When scanning starts, the [ScanSnap Manager - Image scanning and file saving] window 
appears.
The [ScanSnap Manager - Image scanning and file saving] window consists of the following:

Scan status
Scan settings
Save completed
Preview

Also, note that you can stop scanning by clicking the [Stop] button in the [ScanSnap Manager 
- Image scanning and file saving] window.
For details about how to stop scanning, refer to "Stopping the Scan" (page 270).

The [ScanSnap Manager - Image scanning and file saving] window closes automatically after 
saving the scanned image of the last page scanned.
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Hiding the Scanning Progress Status
You can hide the [ScanSnap Manager - Image scanning and file saving] window in the 
following procedure.

1. Select [Help] → [Preferences] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

[ScanSnap Manager - Preferences] window appears.

2. Clear the [Show the scan progress status (recommended)] checkbox.

3. Click the [ ] button in the upper left corner to close the [ScanSnap 
Manager - Preferences] window.

The [ScanSnap Manager - Image scanning and file saving] window is hidden from 
next scanning on.

When the scanning progress status window is not displayed, the current 

number of pages saved is indicated on the ScanSnap Manager icon  in 
the Dock.
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Actions

The ScanSnap has functions useful in your office work available as Actions.
Actions allow you to:

Share the scanned document files with others.
Save the scanned image directly in a shared folder on a network after scanning, share 
the scanned image with others and inform them of the destination folder path by an e-
mail message automatically created with the path stated.

Send document files to participants of a meeting via e-mail.
Send an e-mail message to others with the scanned image file attached.

Use a printer rather than a copy machine to make copies of documents.
Print the scanned image with a printer.

Quote text from your paper documents when you do not want to type it.
Have the scanned image text recognized and converted into a Word or Excel document.

File and organize a large number of business cards.
Store and manage business cards in Cardiris. The card data can be output in either text 
or vCard format. 

Convert catalogs and pamphlets into digital data and save them.
Store and manage scanned images of catalogs and pamphlets directly in iPhoto.

Manage scanned documents through linkage with Evernote.
Save PDF files in Evernote and access them easily anytime, anywhere.

Manage handwritten notes through linkage with Evernote.
Save JPEG files in Evernote and access them easily anytime, anywhere.

Manage scanned documents through linkage with Google Docs.
Save PDF files in Google Docs and access them easily anytime, anywhere.

Manage scanned documents through linkage with Salesforce Chatter.
Post scanned image files to Salesforce Chatter and manage them with Salesforce 
CRM.

Manage scanned documents through linkage with SugarSync.
Save scanned image files to your SugarSync folder and access them easily anytime, 
anywhere.
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 Save scanned documents to a mobile device.
Scanned image file is saved to a connected mobile device. You can access the saved 
files through linkage with an application that can view PDF or JPEG files.

The following are explanations on how to use Actions.
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■ Saving Data in a Specified Folder

This section explains how to save the scanned image file in a specified folder.
You can save the scanned image file in a shared folder on the network and share it with 
others. In addition, you can inform others of the destination folder path by an e-mail message 
automatically created with the path stated.

For details about the procedure to scan and save the scanned image in a specified folder 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 294)
Without Using the Quick Menu (→ page 297)

The e-mail program configured in Mail when you select [Mail] menu → [Preferences] → 
[General] button → [Default email reader] is used as the e-mail program to link with ScanSnap 
Manager.
The following e-mail programs are supported:

Mail
Outlook for Mac 2011
Entourage 2008 for Mac
Entourage 2004 for Mac
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Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Click the [Scan to Folder] icon.

The [Scan to Folder] window appears.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).
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4. Check the scanned image in the preview area.

In the [Scan to Folder] window, you can change files names, destination folders, and 
specify whether to state a path to a destination folder in an e-mail message to notify 
others.
For details about the [Scan to Folder] window, refer to the ScanSnap Manager Help.

Preview
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5. Click the [Save] button.

The scanned image file is saved in the specified folder.
When you select the [State a path to a destination folder in an E-mail message] 
checkbox in the [Scan to Folder] window, a new message window appears listing the 
destination folder path where the file is saved.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Folder] window is closed. Close the [Scan to Folder] window before scanning the next 
document.
Do not move, delete, or rename scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to Folder] window is closed.
296



Actions (for Mac OS Users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Folder].

3. Click the [Apply] button.

4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

ScanSnap Manager also links with [Scan to Folder] when you select:
[Scan to Folder] from the [Profile] pop-up menu of the ScanSnap setup window
[Scan to Folder] from the Profile menu
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5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan to Folder] window appears when the scanning is completed.

7. Check the scanned image in the preview area.

In the [Scan to Folder] window, you can change files names, destination folders, and 
specify whether to state a path to a destination folder in an e-mail message to notify 
others.
For details about the [Scan to Folder] window, refer to the ScanSnap Manager Help.

Preview
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8. Click the [Save] button.

The scanned image file is saved in the specified folder.
When you select the [State a path to a destination folder in an E-mail message] 
checkbox in the [Scan to Folder] window, a new message window appears listing the 
destination folder path where the file is saved.

You cannot start scanning when the [Scan to Folder] window is displayed. Close the 
window before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the 
[Scan to Folder] window is displayed.
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■ Attaching Files to E-Mail

This section explains how to attach the scanned image file to an e-mail message.

For details about the procedure to scan and attach the scanned image to an e-mail message 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 301)
Without Using the Quick Menu (→ page 304)

The e-mail program configured in Mail when you select [Mail] menu → [Preferences] → 
[General] button → [Default email reader] is used as the e-mail program to link with ScanSnap 
Manager.
The following e-mail programs are supported:

Mail
Outlook for Mac 2011
Entourage 2008 for Mac
Entourage 2004 for Mac
300



Actions (for Mac OS Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to E-mail] (If you do not want to change 
any settings, go to step 4.).

1. Click [Settings] under the [Scan to E-mail] icon.

The [Scan to E-mail - Options] window appears.
2. Change the settings.

For details about the [Scan to E-mail - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to E-mail - Options] window.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).

Up to ten files can be attached to an e-mail message.
When you scan more than one document with the scan settings shown below, multiple files 
are created. Pay attention to the number of documents to scan:

File format: JPEG (*.jpg)
[Generate one PDF file per (n) page(s)] checkbox is selected
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4. Click the [Scan to E-mail] icon.

The [Scan to E-mail] window appears.
If you clear the [Show preview] checkbox of the [Scan to E-mail - Options] window in 
step 3., the [Scan to E-mail] window is not displayed. An e-mail message window 
appears with the file attached.

5. Check the scanned image in the preview area.

In the [Scan to E-mail] window, you can rename the file and decide whether to save the 
scanned image in the folder specified for [Image saving folder] after sending it by e-mail.
For details about the [Scan to E-mail] window, refer to the ScanSnap Manager Help.

Preview
302



Actions (for Mac OS Users)
6. Click the [Attach to E-mail] button.

An e-mail message window appears with the file attached.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
E-mail] window is closed. Close the [Scan to E-mail] window before scanning the next 
document.
Do not move, delete, or rename scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to E-mail] window is closed.
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Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
E-mail].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

ScanSnap Manager also links with [Scan to E-mail] when you select:
[Scan to E-mail] from the [Profile] pop-up menu of the ScanSnap setup window
[Scan to E-mail] from the Profile menu
304



Actions (for Mac OS Users)
3. Change the settings for [Scan to E-mail] (If you do not want to change 
any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to E-mail - Options] window appears.

2. Change the settings.
For details about the [Scan to E-mail - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to E-mail - Options] window.

4. Click the [Apply] button in the ScanSnap setup window.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.
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6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

7. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan to E-mail] window appears when the scanning is completed.
If you clear the [Show preview] checkbox of the [Scan to E-mail - Options] window in 
step 3., the [Scan to E-mail] window is not displayed. An e-mail message window 
appears with the file attached.

8. Check the scanned image in the preview area.

In the [Scan to E-mail] window, you can rename the file and decide whether to save the 
scanned image in the folder specified for [Image saving folder] after sending it by e-mail.
For details about the [Scan to E-mail] window, refer to the ScanSnap Manager Help.

Up to ten files can be attached to an e-mail message.
When you scan more than one document with the scan settings shown below, multiple files 
are created. Pay attention to the number of documents to scan:

File format: JPEG (*.jpg)
[Generate one PDF file per (n) page(s)] checkbox is selected

Preview
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9. Click the [Attach to E-mail] button.

An e-mail message window appears with the file attached.

You cannot start scanning when the [Scan to E-mail] window is displayed. Close the 
window before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the 
[Scan to E-mail] window is displayed.
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■ Using the ScanSnap as a Copy Machine

This section explains how to print the scanned image with a printer.
When a printer links with ScanSnap Manager, the ScanSnap can be used as a copy machine.

For details about the procedure to scan and print the scanned image using or without using 
the Quick Menu, refer to the following:

Using the Quick Menu (→ page 309)
Without Using the Quick Menu (→ page 311)

Note that shadows around the edges of the document may appear as lines on the generated 
scanned image, depending on the scanning method and paper conditions. If you print such 
an image, the printed image will also have lines appearing in it.
The scanned image will be printed at a resolution of 150 dpi regardless of the settings 
specified for [Image quality] in the [Scanning] tab.
When you perform a borderless printing, save the image data to file first, and then print it by 
using Preview, Adobe Acrobat or Adobe Reader.
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Actions (for Mac OS Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Print] (If you do not want to change any 
settings, go to step 4.).

1. Click [Settings] under the [Scan to Print] icon.

The [Scan to Print - Options] window appears.

2. Change the settings.
For details about the [Scan to Print- Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Print- Options] window.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).
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Actions (for Mac OS Users)
4. Click the [Scan to Print] icon.

The [Print] window appears.

5. Configure print setup options in the [Print] window.

In the [Print] window, you can specify the printer to be used, the number of copies, and 
size and position of the scanned image to be printed, and whether to save the scanned 
image in the folder specified for [Image saving folder].
For details about the [Print] window, refer to the ScanSnap Manager Help.

6. Click the [Print] button.

The scanned image is printed.

You cannot start scanning after the Quick Menu is displayed and before the [Print] 
window is closed. Close the [Print] window before scanning the next document.
Do not move, delete, or rename the scanned image in other applications after the Quick 
Menu is displayed and before the [Print] window is closed.
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Actions (for Mac OS Users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. From the [Application] pop-up menu in the [Application] tab, select [Scan 
to Print].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

ScanSnap Manager also links with [Scan to Print] when you select:
[Scan to Print] from the [Profile] pop-up menu of the ScanSnap setup window
[Scan to Print] from the Profile menu
311



Actions (for Mac OS Users)
3. Change the settings for [Scan to Print] (If you do not want to change any 
settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Print - Options] window appears.

2. Change the setting.
For details about the [Scan to Print - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Print - Options] window.

4. Click the [Apply] button in the ScanSnap setup window.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

7. Press the [Scan] button on the ScanSnap to start a scan.

The [Print] window appears when the scanning is completed.
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Actions (for Mac OS Users)
8. Configure print setup options in the [Print] window.

In the [Print] window, you can specify the printer to be used, the number of copies, and 
size and position of the scanned image to be printed, and whether to save the scanned 
image in the folder specified for [Image saving folder].
For details about the [Print] window, refer to the ScanSnap Manager Help.

9. Click the [Print] button.

The scanned image is printed.

You cannot start scanning when the [Print] window is displayed. Close the window 
before scanning the next document.
Do not move, delete, or rename the scanned image in other applications while the 
[Print] window is displayed.
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Actions (for Mac OS Users)
■ Converting into Word/Excel Documents

This section explains how to convert the scanned image into Word/Excel files using ABBYY 
FineReader for ScanSnap bundled with the ScanSnap.

The following applications must be installed in your computer in order to perform text-
recognition:
- ABBYY FineReader for ScanSnap (bundled with the ScanSnap)
- Word
- Excel

You cannot view the documents converted into Word and Excel files unless these 
applications are installed and you completed the user registration to use them. Install these 
applications and complete the user registration to view the converted documents on your 
computer.
If Word is not installed in your computer, text-only results of converted documents to Word 
will be displayed in TextEdit. If Excel is not installed in your computer, you cannot view 
documents converted to Excel.
ABBYY FineReader for ScanSnap can be used with the following versions of Word and 
Excel:
- Word: 2011 / 2008 / 2004
- Excel: 2011 / 2008 / 2004

Do not use this function while you are working in Word or Excel. In addition, do not use Word 
or Excel while this function is being executed. If you use either Word or Excel together with 
this function, the conversion result is saved to a file, but the conversion result may not be 
displayed even if the [Open file after recognition] checkbox is selected on the [FineReader for 
ScanSnap Preferences] window.
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About the OCR function of ABBYY FineReader for ScanSnap
ABBYY FineReader for ScanSnap is an application used exclusively with the ScanSnap. This 
program can perform text recognition only for PDF files created by using the ScanSnap. It 
cannot perform text recognition for files created using Adobe Acrobat or other applications.
The optical character recognition program has the following features. Before performing text 
recognition, check whether the documents you want to convert are suitable for conversion 
according to the following guidelines:

Application Suitable for conversion Not suitable for conversion

Scan to Word Documents with simple 
layouts consisting of single or 
double columns

Documents with complex layouts 
containing a mixture of diagrams, tables, 
and text (e.g. brochures, magazines, and 
newspapers)

Scan to Excel Documents containing simple 
tables with no cells merged

Documents containing:
- Tables with no solid border lines
- Tables with complicated cell formats
- Complex tables containing sub-tables
- Diagrams
- Graphs
- Photos 
- Vertical text
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Actions (for Mac OS Users)
The following parameters may not be reproduced as they are in the original document. It is 
recommended that the converted documents be opened with Word or Excel to correct or edit 
misrecognized characters:
- Character font and size
- Character and line spacing
- Underlined, bold and italic characters
- Superscript/subscript

The following types of documents (characters) may not be recognized correctly.
Better results in text recognition may be achieved by changing the color mode or increasing 
the resolution:
- Documents including handwritten characters
- Documents containing small characters (smaller than 10 points)
- Skewed documents
- Documents written in languages other than the specified language
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders
- Documents of complex layouts as well as documents including unreadable characters

(It may take extra time to process text recognition for these documents.)
When converting to Excel files, if the recognition result exceeds 65,536 lines, no more results 
are saved.
When converting to Excel files, information about the layout of the entire document, 
diagrams, and length/width of graphs and tables is not duplicated. Only tables and character 
strings are reproduced.
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Actions (for Mac OS Users)
For details about the procedure to scan and convert the scanned image into Word/Excel files 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 318)
Without Using the Quick Menu (→ page 320)

You can change the settings applied during conversion to Word or Excel documents in the 
ABBYY FineReader for ScanSnap setup window.

Select the [Applications] → [ABBYY FineReader for ScanSnap] → [FineReader for ScanSnap 
Preferences]. Then, select [FineReader for ScanSnap] menu → [Preferences] to display the 
following window.

For details about how to configure settings, refer to the ABBYY FineReader for ScanSnap Help.
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Using the Quick Menu 

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Click the [Scan to Word] or [Scan to Excel] icon.

The following message appears and conversion starts.

When the conversion is completed, Word or Excel starts up, and the conversion 
result is displayed.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab of the ScanSnap setup window.

When you perform a scan with [JPEG(*.jpg)] selected for [File format] in the [File 
option] tab in the ScanSnap setup window, scanned data cannot be converted into a 
Word or Excel file. 
You cannot start scanning when the Quick Menu is displayed. Wait until the 
conversion is over to scan another document.
Do not move, delete or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Mac OS Users)
The Word or Excel file is saved in one of the following formats:
Scan to Word: RTF format (.rtf)
Scan to Excel: XLS format (.xls)
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Actions (for Mac OS Users)
Without using the Quick Menu 

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Word] or [Scan to Excel].

3. Click the [Apply] button in the ScanSnap setup window.

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

It is recommended to select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab in the ScanSnap setup window.
ScanSnap Manager can also link with [Scan to Word] or [Scan to Excel] when you 
select:
- [Scan to Word] or [Scan to Excel] from the [Profile] pop-up menu of the ScanSnap 

setup window
- [Scan to Word] or [Scan to Excel] from the Profile menu
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Actions (for Mac OS Users)
4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

The following message appears and image data conversion to Word or Excel files 
starts.

When the conversion is completed, Word or Excel starts up and the conversion 
result is displayed.

The Word or Excel file is saved in one of the following formats:
Scan to Word: RTF format (.rtf)
Scan to Excel: XLS format (.xls)
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Actions (for Mac OS Users)
■ Storing Business Cards in Cardiris

This section explains how to store business card images and the related information in 
Cardiris.

For details about the procedure to scan and manage business cards in Cardiris using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 323)
Without Using the Quick Menu (→ page 325)
Using the Address Book in Cardiris (→ page 328)
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Actions (for Mac OS Users)
Using the Quick Menu

1. Load a business card in the ScanSnap.

Load the business card so that the front side faces the ADF paper chute (cover).
To scan multiple business cards, load them in a pile.
Do not leave space between the side guides and business cards.

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Click the [Cardiris] icon.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab of the ScanSnap setup window.
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Actions (for Mac OS Users)
The Cardiris window appears.

4. Check the scanned card image and the text recognition result.

The current card image is displayed on the top-right.
A list of already scanned business cards is displayed in the card toolbar.
The recognition result is displayed under the card image.

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap 
Manager links with Cardiris before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

Do not exit Cardiris while setup or message window is open.

To recognize a business card of a different language from the one currently set in 
Cardiris, click the card style button and change the country setting.
For details about the functions of Cardiris and how to use it, refer to Cardiris™ 4 User 
Guide and Cardiris Help.

Card style 
button

[Export] button

Output format 
button

Card toolbar Recognition 
result

Card image
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Actions (for Mac OS Users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select 
[Cardiris].

3. Click the [Apply] button.

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab of the ScanSnap setup window.

ScanSnap Manager also links with [Cardiris] when you select:
[Cardiris] from the [Profile] pop-up menu of the ScanSnap setup window
[Cardiris] from the Profile menu
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Actions (for Mac OS Users)
4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

5. Load a business card in the ScanSnap.

Load the business card so that the front side faces the ADF paper chute (cover).
To scan multiple business cards, load them in a pile.
Do not leave space between the side guides and business cards.

6. Press the [Scan] button on the ScanSnap to start a scan.

The Cardiris window appears.
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Actions (for Mac OS Users)
7. Check the scanned card image and the text recognition result.

The current card image is displayed on the top-right.
A list of already scanned business cards is displayed in the card toolbar.
The recognition result is displayed under the card image.

Do not exit Cardiris while setup or message window is open.

To recognize a business card of a different language from the one currently set in 
Cardiris, click the card style button and change the country setting.
For details about the functions of Cardiris and how to use it, refer to Cardiris™ 4 User 
Guide and Cardiris Help.

Card style 
button

[Export] button

Output format 
button

Card toolbar Recognition 
result

Card image
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Actions (for Mac OS Users)
Using the Address Book in Cardiris
To register the recognized characters of a scanned business card in the Address Book, 
perform the following procedure.

1. Click the output format button or select [Settings] → [Output Format] on 
the menu bar.

The [Business Cards] window appears.

2. Select [Address Book] in the [Format] pop-up menu.

3. Click the [OK] button.

Do not exit Cardiris when setup or message window is open.
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Actions (for Mac OS Users)
4. Click the [Export] button or select [Process] → [Export All Cards] on the 
menu bar.

The text recognition result of all scanned business cards in the card toolbar is 
registered in the Address Book.

5. Select [Cardiris for ScanSnap] → [Quit Cardiris for ScanSnap] on the 
menu bar to quit Cardiris.

The recognition result of scanned business cards can be output in text or vCard format. For more 
details, refer to Cardiris™ 4 User Guide and Cardiris Help.
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Actions (for Mac OS Users)
■ Storing Scanned Images in iPhoto

This section explains how to store the scanned image in iPhoto.

For details about the procedure to scan and store the scanned image in iPhoto using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 331)
Without Using the Quick Menu (→ page 333)
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Actions (for Mac OS Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Click the [iPhoto] icon.

The [iPhoto] window appears.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap 
Manager links with iPhoto before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Mac OS Users)
4.  Check the scanned image stored in iPhoto.

The scanned image is also saved in the folder specified for [Image saving folder] in the 
[Save] tab of the ScanSnap setup window at the same time when it is saved to iPhoto. 
Delete this file if unnecessary.
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Actions (for Mac OS Users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. From the [Application] pop-up menu in the [Application] tab, select 
[iPhoto].

3. Click the [Apply] button.

4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

ScanSnap Manager also links with [iPhoto] when you select:
[iPhoto] from the [Profile] pop-up menu of the ScanSnap setup window
[iPhoto] from the Profile menu
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Actions (for Mac OS Users)
5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

The [iPhoto] window appears when the scanning is completed.

7.  Check the scanned image stored in iPhoto.

The scanned image is also saved in the folder specified for [Image saving folder] in the 
[Save] tab of the ScanSnap setup window at the same time when it is saved to iPhoto. 
Delete this file if unnecessary.
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Actions (for Mac OS Users)
■ Saving Documents to Evernote

This section explains how to save the scanned image as a PDF file to Evernote.
When you save a scanned image to Evernote after converting it into a searchable PDF, the 
PDF file becomes searchable in Evernote.

For details about the procedure to scan and save the scanned image to Evernote using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 336)
Without Using the Quick Menu (→ page 338)

You need to create an Evernote account (free or premium).
You first need to create a notebook in Evernote for Mac to save a file to Evernote.
Disable [Bring the new note to the 
front] in Evernote [Preferences] 
window beforehand to prevent new 
notes appearing on the screen when 
you scan documents consecutively.
The screenshot on the right is from 
Evernote for Mac 2.0.4. Clear the 
[Bring the new note to the front] 
checkbox in this window.
The actual window and the contents 
may differ depending on the Evernote 
version you are using.

PDF
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Actions (for Mac OS Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Evernote (Document)] (If you do not 
want to change any settings, go to step 4.).

1. Click [Settings] under the [Scan to Evernote (Document)] icon.

The [Scan to Evernote (Document) - Options] window appears.

2. Change the settings.
For details about the [Scan to Evernote (Document) - Options] window, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Evernote (Document) - Options] window.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).
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Actions (for Mac OS Users)
4. Click the [Scan to Evernote (Document)] icon.

If [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup window, a separate PDF file will be created from each JPEG file.
The following window appears during file creation.

If the [Convert to Searchable PDF] checkbox is selected in step 3., text recognition is 
performed according to the [OCR options] settings in the [Scan to Evernote - 
Options] window.
The following window appears during text recognition.

Evernote for Mac starts up, and the PDF file is saved to Evernote.

You cannot start scanning when the Quick Menu is displayed. Save the PDF file to 
Evernote before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

Text recognition will be performed if there are any pages containing text which is not 
yet recognized. Note that text recognition will be performed on all pages, including 
pages containing text on which text recognition has already been performed.

The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup window even after the scanned 
image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Mac OS Users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Evernote (Document)].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

ScanSnap Manager also links with [Scan to Evernote (Document)] when you select:
[Scan to Evernote (Document)] from the [Profile] pop-up menu of the ScanSnap setup 
window
[Scan to Evernote (Document)] from the Profile menu
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Actions (for Mac OS Users)
3. Change the settings for [Scan to Evernote (Document)] (If you do not 
want to change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Evernote (Document) - Options] window appears.

2. Change the settings.
For details about the [Scan to Evernote (Document) - Options] window, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Evernote (Document) - Options] window.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).
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Actions (for Mac OS Users)
7. Press the [Scan] button on the ScanSnap to start a scan.

When the scanning is completed, a separate PDF file will be created from each 
JPEG file if [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the 
ScanSnap setup window.
The following window appears during file creation.

If the [Convert to Searchable PDF] checkbox is selected in step 3., text recognition is 
performed according to the [OCR options] settings in the [Scan to Evernote 
(Document) - Options] window.
The following window appears during text recognition.

Evernote for Mac starts up, and the PDF file is saved to Evernote.

Text recognition will be performed if there are any pages containing text which is not 
yet recognized. Note that text recognition will be performed on all pages, including 
pages containing text on which text recognition has already been performed.

The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup window even after the scanned 
image is saved to Evernote.Delete this file if unnecessary.
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Actions (for Mac OS Users)
■ Saving Handwritten Notes to Evernote

This section explains how to save the scanned image as a JPEG file to Evernote.
When you save a JPEG file to Evernote, text recognition is performed on all text, including 
handwritten characters, and the file becomes searchable in Evernote.

For details about the procedure to scan and send the scanned image to Evernote using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 342)
Without Using the Quick Menu (→ page 344)

You need to create an Evernote account (free or premium).
You first need to create a notebook in Evernote for Mac to save a file to Evernote.
Disable [Bring the new note to the 
front] in Evernote [Preferences] 
window beforehand to prevent new 
notes appearing on the screen when 
you scan documents consecutively.
The screenshot on the right is from 
Evernote for Mac 2.0.4. Clear the 
[Bring the new note to the front] 
checkbox in this window.
The actual window and the contents 
may differ depending on the Evernote 
version you are using.

JPEG
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Actions (for Mac OS Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Click the [Scan to Evernote (Note)] icon.

If [PDF(*.pdf)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup window, a separate JPEG file will be created from each page of the PDF file.
The following window appears during file creation.

Evernote for Mac starts up, and the JPEG file is saved to Evernote.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).

You cannot start scanning when the Quick Menu is displayed. Save the JPEG file to 
Evernote before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Mac OS Users)
When you select [PDF(*.pdf)] for [File format] in the [File option] tab of the ScanSnap 
setup window, a four-digit serial number is automatically added to the name of the file 
which is saved to Evernote.
e.g. When the file name is [ScanSnap], the file is saved as:

ScanSnap_0001, ScanSnap_0002, ScanSnap_0003...
The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup window even after the scanned 
image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Mac OS Users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Evernote (Note)].

3. Click the [Apply] button.

4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

ScanSnap Manager also links with [Scan to Evernote (Note)] when you select:
[Scan to Evernote (Note)] from the [Profile] pop-up menu of the ScanSnap setup 
window
[Scan to Evernote (Note)] from the Profile menu
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Actions (for Mac OS Users)
5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

When the scanning is completed, a separate JPEG file will be created from each 
page of the PDF file if [PDF(*.pdf)] is selected for [File format] in the [File option] tab 
of the ScanSnap setup window. 
The following window appears during file creation.

Evernote for Mac starts up, and the JPEG file is saved to Evernote.

When you select [PDF(*.pdf)] for [File format] in the [File option] tab of the ScanSnap 
setup window, a four-digit serial number is automatically added to the name of the file 
which is saved to Evernote.
e.g. When the file name is [ScanSnap], the file is saved as:

ScanSnap_0001, ScanSnap_0002, ScanSnap_0003...
The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup window even after the scanned 
image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Mac OS Users)
■ Saving Documents to Google Docs

This section explains how to save the scanned image as a PDF file to Google Docs.

For details about the procedure to scan and save the scanned image to Google Docs using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 347)
Without Using the Quick Menu (→ page 350)

You need to create a Google account (free).

PDF
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Actions (for Mac OS Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Google Docs(TM)] (If you do not want to 
change any settings, go to step 4.).

1. Click [Settings] under the [Scan to Google Docs(TM)] icon.

The [Scan to Google Docs(TM) - Options] window appears.
2. Change the settings.

For details about the [Scan to Google Docs(TM) - Options] window, refer to the 
ScanSnap Manager Help.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).
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Actions (for Mac OS Users)
3. Click the [OK] button to close the [Scan to Google Docs(TM) - Options] window.

4. Click the [Scan to Google Docs(TM)] icon.

If you did not specify a Google account in the [Scan to Google Docs(TM) - Options] 
window in step 3., the [Scan to Google Docs(TM)] window appears. To continue, 
enter your e-mail address and password, and click the [OK] button.

If the computer is shared with other users, do not set your information in [Email] and 
[Password]. Otherwise, other users will be able to log into Google Docs 
automatically.
It is recommended to set only [Email] in this window, and type in the password every 
time.

You cannot start scanning when the Quick Menu is displayed. Save the PDF file to 
Google Docs before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

If the computer is shared with other users, do not select the [Remember the 
password in the keychain] checkbox in this window.
Otherwise, other users will be able to log into Scan to Google Docs automatically.
Scan to Google Docs is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Mac OS Users)
If [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup window, a separate PDF file will be created from each JPEG file.
The following window appears during file creation.

If you select the [Convert to Searchable PDF] checkbox in the [Scan to Google 
Docs(TM) - Options] window in step 3., text recognition is performed according to the 
[OCR options] settings in the [Scan to Google Docs(TM) - Options] window.
The following window appears during text recognition.

Saving to Google Docs starts. Click the [Close] button to close the [Scan to Google 
Docs(TM)] window when the saving is completed.

If you select the [Close this window when save completes] checkbox above, the 
[Scan to Google Docs(TM)] window will automatically close from next scanning on 
when the saving is completed.

Text recognition will be performed if there are any pages containing text which is not 
yet recognized. Note that text recognition will be performed on all pages, including 
pages containing text on which text recognition has already been performed.

Google Docs does not start up after the saving has completed. To check the saved PDF 
file, start a web browser and log in to Google Docs.
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Actions (for Mac OS Users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Google Docs(TM)].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

ScanSnap Manager also links with [Scan to Google Docs(TM)] when you select:
[Scan to Google Docs(TM)] from the [Profile] pop-up menu of the ScanSnap setup 
window
[Scan to Google Docs(TM)] from the Profile menu
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Actions (for Mac OS Users)
3. Change the settings for [Scan to Google Docs(TM)] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Google Docs(TM) - Options] window appears.

2. Change the settings.
For details about the [Scan to Google Docs(TM) - Options] window, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Google Docs(TM) - Options] window.

4. Click the [Apply] button.

If the computer is shared with other users, do not set your information in [Email] and 
[Password]. Otherwise, other users will be able to log into Google Docs 
automatically.
It is recommended to set only [Email] in this window, and type in the password every 
time.
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Actions (for Mac OS Users)
5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

7. Press the [Scan] button on the ScanSnap to start a scan.

If you did not specify a Google account in the [Scan to Google Docs(TM) - Options] 
window in step 3., the [Scan to Google Docs(TM)] window appears when the 
scanning is completed. To continue, enter your e-mail address and password, and 
click the [OK] button.

If [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup window, a separate PDF file will be created from each JPEG file.
The following window appears during file creation.

If the computer is shared with other users, do not select the [Remember the 
password in the keychain] checkbox in this window.
Otherwise, other users will be able to log into Google Docs automatically.
Scan to Google Docs is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Mac OS Users)
If you select the [Convert to Searchable PDF] checkbox in the [Scan to Google 
Docs(TM) - Options] window in step 3., text recognition is performed according to the 
[OCR options] settings in the [Scan to Google Docs(TM) - Options] window.
The following window appears during text recognition.

Saving to Google Docs starts. Click the [Close] button to close the [Scan to Google 
Docs(TM)] window when the saving is completed.

If you select the [Close this window when save completes] checkbox above, the 
[Scan to Google Docs(TM)] window will automatically close from next scanning on 
when the saving is completed.

Text recognition will be performed if there are any pages containing text which is not 
yet recognized. Note that text recognition will be performed on all pages, including 
pages containing text on which text recognition has already been performed.

Google Docs does not start up after the saving has completed. To check the saved PDF 
file, start a web browser and log in to Google Docs.
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Actions (for Mac OS Users)
■ Posting to Salesforce Chatter

This section explains how to post the scanned image as a PDF or a JPEG file to Salesforce 
Chatter.

For details about the procedure to post to Salesforce Chatter using or without using the Quick 
Menu, refer to the following:

Using the Quick Menu (→ page 355)
Without Using the Quick Menu (→ page 359)

A Salesforce CRM license is required separately.
ScanSnap Manager can link with the following Salesforce editions:
- Unlimited
- Enterprise
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Actions (for Mac OS Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Salesforce Chatter] (If you do not want 
to change any settings, go to step 4.).

1. Click [Settings] under the [Scan to Salesforce Chatter] icon.

The [Scan to Salesforce Chatter - Options] window appears.

2. Change the settings.
For details about the [Scan to Salesforce Chatter - Options] window, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Salesforce Chatter - Options] window.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).

If the computer is shared with other users, do not set your information in [User 
Name], [Password] and [Security Token]. Otherwise, other users will be able to log 
into Salesforce automatically.
It is recommended to set only [User Name] and [Security Token] in this window, and 
type in the password every time. 
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Actions (for Mac OS Users)
4. Click the [Scan to Salesforce Chatter] icon.

If you did not specify a Salesforce account in the [Scan to Salesforce Chatter - 
Options] window in step 3., the [Scan to Salesforce Chatter - Login] window appears. 
To continue, enter your user name and password and click the [OK] button. Enter a 
security token if needed. 

The [Scan to Salesforce Chatter] window appears.

If the computer is shared with other users, do not select the [Remember the 
password in the keychain] checkbox in this window.
Otherwise, other users will be able to log into Salesforce automatically.
Scan to Salesforce Chatter is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Mac OS Users)
5. Check the scanned image in the preview area.

In the [Scan to Salesforce Chatter] window, you can set the posting destination and 
method, the message to post, the name and description of the image file that will be 
posted to Salesforce Chatter, and save the scanned image in the folder specified for 
[Image saving folder].
For details about the [Scan to Salesforce Chatter] window, refer to the ScanSnap 
Manager Help.

Preview
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Actions (for Mac OS Users)
6. Click the [Post] button.

Posting to Salesforce Chatter starts. Click the [Close] button to close the [Scan to 
Salesforce Chatter] window when the posting is completed.

If you select the [Close this window when posting completes] checkbox above, the 
[Scan to Salesforce Chatter] window will automatically close from next scanning on 
when the posting is completed.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Salesforce Chatter] window is closed. Close the [Scan to Salesforce Chatter] window 
before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

Salesforce does not start up after the posting is completed. To check the saved scanned 
image file, start a web browser and log in to Salesforce.
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Actions (for Mac OS Users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Salesforce Chatter].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected in the [Profile] pop-up menu or from the Profile menu next time 
you perform a scan.
For details about how to add a profile, refer to "Profile Management" (page 278).
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Actions (for Mac OS Users)
3. Change the settings for [Scan to Salesforce Chatter] (If you do not want 
to change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Salesforce Chatter - Options] window appears.

2. Change the setting.
For details about the [Scan to Salesforce Chatter - Options] window, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Salesforce Chatter - Options] window.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

If the computer is shared with other users, do not set your information in [User 
Name], [Password] and [Security Token]. Otherwise, other users will be able to log 
into Salesforce automatically.
It is recommended to set only [User Name] and [Security Token] in this window, and 
type in the password every time. 
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Actions (for Mac OS Users)
6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

7. Press the [Scan] button on the ScanSnap to start a scan.

If you did not specify a Salesforce account in the [Scan to Salesforce Chatter - 
Options] window in step 3., the [Scan to Salesforce Chatter - Login] window appears 
when the scanning is completed. To continue, enter your user name and password 
and click the [OK] button. Enter a security token if needed.

The [Scan to Salesforce Chatter] window appears.

If the computer is shared with other users, do not select the [Remember the 
password in the keychain] checkbox in this window.
Otherwise, other users will be able to log into Salesforce automatically.
Scan to Salesforce Chatter is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Mac OS Users)
8. Check the scanned image in the preview area.

In the [Scan to Salesforce Chatter] window, you can set the posting destination and 
method, the message to post, the name and description of the image file that will be 
posted to Salesforce Chatter, and save the scanned image in the folder specified for 
[Image saving folder].
For details about the [Scan to Salesforce Chatter] window, refer to the ScanSnap 
Manager Help.

Preview
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Actions (for Mac OS Users)
9. Click the [Post] button.

Posting to Salesforce Chatter starts. Click the [Close] button to close the [Scan to 
Salesforce Chatter] window when the posting is completed.

If you select the [Close this window when posting completes] checkbox above, the 
[Scan to Salesforce Chatter] window will automatically close from next scanning on 
when the posting is completed.

You cannot start scanning when the [Scan to Salesforce Chatter] window is displayed. 
Close the window before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
[Scan to Salesforce Chatter] window is displayed.

Salesforce does not start up after the posting is completed. To check the saved scanned 
image file, start a web browser and log in to Salesforce.
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Actions (for Mac OS Users)
■ Saving Data to Your SugarSync Folder

This section explains how to save the scanned image as a PDF or a JPEG file to your 
SugarSync folder.

For details about the procedure to scan and save the scanned image to your SugarSync 
folder using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 365)
Without Using the Quick Menu (→ page 368)

You need to have a SugarSync account.
You need to have SugarSync Manager for Mac 1.9.29 or later installed in order to use this 
function.

When you first log into SugarSync after installing SugarSync Manager for Mac, the Magic 
Briefcase, which is a folder used for SugarSync, is automatically created.
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Actions (for Mac OS Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to SugarSync] (If you do not want to 
change any settings, go to step 4.).

1. Click [Settings] under the [Scan to SugarSync] icon.

The [Scan to SugarSync - Options] window appears.

2. Change the setting.
For details about the [Scan to SugarSync - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to SugarSync - Options] window.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).
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Actions (for Mac OS Users)
4. Click the [Scan to SugarSync] icon.

The [Scan to SugarSync] window appears.
If you clear the [Show preview] checkbox in step 3., scanned image is directly saved 
to your SugarSync folder.

5. Check the scanned image in the preview area.

In the [Scan to SugarSync] window, you can rename the file and specify your 
SugarSync folder.
For details about the [Scan to SugarSync] window, refer to the ScanSnap Manager 
Help.

The file will not be synced with SugarSync unless you select a SugarSync folder as the 
destination folder.

Preview
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Actions (for Mac OS Users)
6. Click the [Save] button.

The scanned image is saved to your SugarSync folder.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
SugarSync] window is closed. Close the [Scan to SugarSync] window before scanning 
the next document.
Do not move, delete or rename the scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to SugarSync] window is closed.
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Actions (for Mac OS Users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
SugarSync].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected in the [Profile] pop-up menu or from the Profile menu next time 
you perform a scan.
For details about how to add a profile, refer to "Profile Management" (page 278).
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Actions (for Mac OS Users)
3. Change the settings for [Scan to SugarSync] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to SugarSync - Options] window appears.

2. Change the setting.
For details about the [Scan to SugarSync - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to SugarSync - Options] window.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

7. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan to SugarSync] window appears when the scanning is completed.
If you clear the [Show preview] checkbox in step3., scanned image is directly saved 
to your SugarSync folder.
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Actions (for Mac OS Users)
8. Check the scanned image in the preview area.

In the [Scan to SugarSync] window, you can rename the file and specify your 
SugarSync folder.
For details about the [Scan to SugarSync] window, refer to the ScanSnap Manager 
Help.

9. Click the [Save] button.

The scanned image is saved to your SugarSync folder.

The file will not be synced with SugarSync unless you select a SugarSync folder as the 
destination folder.

You cannot start scanning when the [Scan to SugarSync] window is displayed. Close 
thie window before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the 
[Scan to SugarSync] window is displyed.
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Actions (for Mac OS Users)
■ Saving Data to a Mobile Device

This section explains how to save the scanned image as a PDF or a JPEG file to a mobile 
device.

Only one mobile device can be connected to the computer.
You need to have ScanSnap Connect Application installed in the mobile device in order to 
use this function. Download ScanSnap Connect Application for mobile devices from 
application stores such as App Store. 
ScanSnap Connect Application for mobile devices operate on the following operating 
systems:
- iOS 4.2.1 or later

The number of scanned image files and the maximum file size that can be saved on a mobile 
device at once are as follows:
- Number of files: Up to 100
- File size: 1024 MB

A firewall alert may be displayed when you first launch [Scan to Mobile]. When the alert is 
displayed, select [Allow].
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Actions (for Mac OS Users)
For details about the procedure to perform scanning and saving scanned images to a mobile 
device through automatic linkage, using or without using the Quick Menu, and how to save 
existing files to a mobile device, refer to the following:

Automatic Linkage (→ page 373)
Using the Quick Menu (→ page 376)
Without Using the Quick Menu (→ page 379)
Saving an Existing File to a Mobile Device (→ page 383)

The following message appears when you first launch [Scan to Mobile]. Click the [OK] button 
to open the [Scan to Mobile - Basic] window. 

In the [Scan to Mobile - Basic] window, enter a password to connect to the mobile device. 
For details about other setting items, refer to the ScanSnap Manager Help. 

When Scan to Mobile is running, the Scan to Mobile icon is displayed on the menu bar.
The Scan to Mobile icon shows the communication status between the computer and the 
mobile device. The appearance of the icon changes according to the communication status 
as shown below.

Status Scan to Mobile icon

Waiting

Standby
Sending

Sending error

Rejected
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Actions (for Mac OS Users)
Automatic Linkage

1. From Finder, select [Applications] and double-click [ScanSnap] → [Scan 
to Mobile].

The [Scan to Mobile] window appears. 

For details about the features of ScanSnap Connect Application for mobile devices and how 
to use it, refer to the ScanSnap Connect Application User's Guide (iOS).
For details about automatic linkage with active applications, refer to "Automatic Linkage with 
Applications" (page 288).
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Actions (for Mac OS Users)
2.  Connect to the computer from your mobile device. 

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User’s Guide (iOS).

When the connection is established, the [Scan to Mobile] window appears on the 
computer, showing the mobile device that is currently connected to the computer.

3. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).
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Actions (for Mac OS Users)
4. Press the [Scan] button on the ScanSnap to start a scan.

Scanned images will be sent to the mobile device from the computer when the 
scanning is completed.

5. Click the [Close] button to close the [Scan to Mobile] window when the 
sending of the scanned image is completed.

To enable automatic linkage with Scan to Mobile, press the [Scan] button on the ScanSnap 
and start a scan while Scan to Mobile is active (the Scan to Mobile menu appears on the 
menu bar). 

When you select the [Wait until the [Send] button is clicked] checkbox in the [Scan to 
Mobile - Basic] window, the [Send] button appears in the [Scan to Mobile] window. Click 
the [Send] button to send the image to the mobile device. 

The [Scan to Mobile] window closes automatically when the mobile device is disconnected 
from the computer.
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Actions (for Mac OS Users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

2. Press the [Scan] button on the ScanSnap to start a scan.

The Quick Menu appears when the scanning is completed.

3. Change the settings for [Scan to Mobile] (If you do not want to change 
any settings, go to step 4.).

1. Click [Settings] under the [Scan to Mobile] icon.

The [Scan to Mobile - Options] window appears.

2. Change the setting.
For details about the [Scan to Mobile - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Mobile - Options] window.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 262).

When [Scan to Mobile] has already started and is active (with the Scan to Mobile menu 
appearing in the menu bar), ScanSnap Manager links with [Scan to Mobile] automatically 
and the Quick Menu does not appear. 
To display the Quick Menu, change the menu bar menu to an application other than Scan 
to Mobile, and then try scanning again.
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Actions (for Mac OS Users)
4. Click the [Scan to Mobile] icon. 

The [Scan to Mobile] window appears.

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap 
Manager links with [Scan to Mobile] before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Mac OS Users)
5. Connect to the computer from your mobile device.

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User’s Guide (iOS). 

When the connection is established, the [Scan to Mobile] window appears showing 
the mobile device that is currently connected to the computer. Then, the scanned 
image is sent to the mobile device.

6. Click the [Close] button to close the [Scan to Mobile] window when the 
sending of the scanned image is completed.

When you select the [Wait until the [Send] button is clicked] checkbox in the [Scan to 
Mobile - Basic] window, the [Send] button appears in the [Scan to Mobile] window. Click 
the [Send] button to send the image to the mobile device.
For details about the features of ScanSnap Connect Application for mobile devices and 
how to use it, refer to the ScanSnap Connect Application User's Guide (iOS). 

The [Scan to Mobile] window closes automatically when the mobile device is disconnected 
from the computer.
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Actions (for Mac OS Users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Mobile].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 267).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected in the [Profile] pop-up menu or from the Profile menu next time 
you perform a scan.
For details about how to add a profile, refer to "Profile Management" (page 278).
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Actions (for Mac OS Users)
3. Change the settings for [Scan to Mobile] (If you do not want to change 
any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Mobile - Options] window appears.

2. Change the setting.
For details about the [Scan to Mobile - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Mobile - Options] window.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).
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Actions (for Mac OS Users)
7. Press the [Scan] button on the ScanSnap to start a scan.

The [Scan to Mobile] window appears on the computer when the scanning is 
completed.

8. Connect to the computer from your mobile device. 

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User’s Guide (iOS). 

When the connection is established, the [Scan to Mobile] window appears showing 
the mobile device that is currently connected to the computer. Then, the scanned 
image is sent to the mobile device.
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Actions (for Mac OS Users)
9. Click the [Close] button to close the [Scan to Mobile] window when the 
sending of the scanned image is completed.

When you select the [Wait until the [Send] button is clicked] checkbox in the [Scan to 
Mobile - Basic] window, the [Send] button appears in the [Scan to Mobile] window. Click 
the [Send] button to send the image to the mobile device.
For details about the features of ScanSnap Connect Application for mobile devices and 
how to use it, refer to the ScanSnap Connect Application User's Guide (iOS).

The [Scan to Mobile] window closes automatically when the mobile device is disconnected 
from the computer.
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Saving an Existing File to a Mobile Device

1. From Finder, select [Applications] and double-click [ScanSnap] → [Scan 
to Mobile].

The [Scan to Mobile] window appears. 

For details about the features of ScanSnap Connect Application for mobile devices and how to 
use it, refer to the ScanSnap Connect Application User's Guide (iOS). 
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2.  Connect to the computer from your mobile device.

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User’s Guide (iOS). 

 When the connection is established, the [Scan to Mobile] window appears showing 
the mobile device that is currently connected to the computer.

3. From the menu bar, select [File] → [Open].

The [Open] window appears.
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4. Select a PDF or JPEG file to save to the mobile device, and click the 
[Open] button. 

The file is sent to the mobile device from the computer.

5. Click the [Close] button to close the [Scan to Mobile] window when the 
sending of the scanned image is completed.

When you select the [Wait until the [Send] button is clicked] checkbox in the [Scan to 
Mobile - Basic] window, the [Send] button appears in the [Scan to Mobile] window. Click 
the [Send] button to send the image to the mobile device.

The [Scan to Mobile] window closes automatically when the mobile device is disconnected 
from the computer.
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Using the ScanSnap in Various Ways

This section explains about various ways of using the ScanSnap.

■ Scanning Only One Side of a Document

By default, the ScanSnap scans in duplex mode.
To perform simplex scanning, perform the following steps to change the setting.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Scanning side] pop-up menu in the [Scanning] tab, select 
[Simplex Scan (Single-sided)].

3. Click the [Apply] button in the ScanSnap setup window.
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4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

Image data of the scanned side of the document is saved.

When you select [Simplex scan] from the ScanSnap Manager menu, scanning is 
performed in simplex mode even if [Duplex Scan (Double-sided)] is specified for 
[Scanning side] in the [Scanning] tab.
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■ Scanning Color Documents in Gray or Black & White

When [Auto color detection] is specified for [Color mode] in the [Scanning] tab of the 
ScanSnap setup window, ScanSnap Manager automatically recognizes whether the scanned 
document is color, gray or black & white, and saves documents in their respective color 
modes.
If you want to scan color documents and save them in gray or black & white, change the 
settings in the following procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Color mode] pop-up menu in the [Scanning] tab, select [Gray] or 
[B&W].

3. Click the [Apply] button.

4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.
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5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

6. Press the [Scan] button on the ScanSnap to start a scan.

Scanned image is saved in gray or black & white.
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■ Deleting Blank Pages from the Scanned Image

The ScanSnap can detect and automatically delete blank pages from a scanned image. For 
example, when you scan a mixed batch of double-sided and single-sided documents in duplex 
mode, the images are generated without the back sides of the single-sided documents (blank 
pages).
To delete blank pages, perform the following steps to change the setting.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. Click the [Option] button in the [Scanning] tab.

The [Scanning mode option] window appears.

The following documents may be detected as blank.
- Almost blank documents with only a few characters
- Documents of only one color (including black) and without any patterns, lines or 

characters
When you scan such documents, clear the [Allow automatic blank page removal] checkbox.
Also make sure to check the image data for accidentally deleted pages when discarding the 
scanned document.
Blank pages are not deleted when Cardiris is used.
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3. Select the [Allow automatic blank page removal] checkbox.

4. Click the [OK] button to close the [Scanning mode option] window.

5. Click the [Apply] button in the ScanSnap setup window.

6. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

7. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

8. Press the [Scan] button on the ScanSnap to start a scan.

Scanned image is saved without any blank pages.
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■ Correcting Skewed Character Strings

When documents with skewed character strings are scanned, the ScanSnap is able to detect 
the skewed character strings and correct them.
To correct skewed character strings, change the settings in the following procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

Up to +/-5 degrees of skew can be corrected.
Since this option is performed assuming that the document contains a certain amount of text, 
character strings may be adjusted at a wrong angle when scanning the following types of 
documents.
In that case, clear the [Correct skewed character strings automatically] checkbox:
- Documents on which pitches between lines or characters are extremely narrow, or 

characters are overlapped
- Documents with many outlined or decorated characters
- Documents with many photographs or figures and few characters
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with characters printed in various directions such as drawings
- Documents with long diagonal lines
- Documents including handwritten characters.

This setting is disabled when you perform a scan using the Carrier Sheet.

You do not have to enable [Correct skewed character strings automatically] when [Automatic 
detection] is specified for [Paper size] in the [Paper] tab of the ScanSnap setup window because 
the skewed image is always corrected when documents are scanned by this setting.
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2. Click the [Option] button in the [Scanning] tab.

The [Scanning mode option] window appears.

3. Select the [Correct skewed character strings automatically] checkbox.

4. Click the [OK] button to close the [Scanning mode option] window.

5. Click the [Apply] button in the ScanSnap setup window.

6. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.
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7. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

8. Press the [Scan] button on the ScanSnap to start a scan.

Scanned image is saved with skewed character strings corrected.
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■ Correcting the Orientation of Scanned Images

In an office environment, it is often the case that a single batch contains same size documents 
of different page orientations.
The ScanSnap is able to automatically rotate each scanned image to its correct orientation for 
such document batches.
To rotate scanned images to their correct orientations, change the settings in the following 
procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

Since this option determines the document’s page orientation based on the character strings 
printed on the document, the following types of documents may be rotated to the wrong 
orientation.
In that case, clear the [Allow automatic image rotation] checkbox:

Documents with many extremely large or small characters
Documents on which pitches between lines or characters are extremely narrow, or characters 
are overlapped
Documents with many characters contacting underlines or borders
Documents with many photographs or figures and few characters
Documents with characters on an unevenly colored background
e.g. Shaded characters
Documents with many decorated characters
e.g. Decorated characters (embossed/outlined)
Documents with characters on a patterned background
e.g. Characters overlapping illustrations and diagrams
Documents with characters printed in various directions such as drawings
Documents written using only capital letters
Documents including handwritten characters.
Skewed documents
Documents written in an unsupported language (language other than Japanese/English/ 
French/German/Italian/Spanish/Russian/Portuguese)
Documents with complex layouts
Documents with a large amount of image noise
Documents with faint characters
Documents with faded characters
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2. Click the [Option] button in the [Scanning] tab.

The [Scanning mode option] window appears.

3. Select the [Allow automatic image rotation] checkbox.

4. Click the [OK] button to close the [Scanning mode option] window.

5. Click the [Apply] button in the ScanSnap setup window.

6. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.
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7. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

8. Press the [Scan] button on the ScanSnap to start a scan.

The scanned image is saved in correct orientation.
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■ Scanning Documents of Different Widths or Lengths 
in One Batch

You can scan documents of different widths or lengths in one batch.
To scan documents of different widths or lengths in one batch, change the settings in the 
following procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size].
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3. Select an item other than [Check Length] in [Multifeed Detection].

4. Click the [Apply] button in the ScanSnap setup window.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Load documents in the ScanSnap.

1. Align the edges of the documents.

If you scan documents of different widths or lengths in one batch with [Check Length] 
selected, documents will be detected as multifeeds and scanning cannot be performed. 
Note that scanning Letter and A4 size documents in the same batch does not result in 
multifeed detection.
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2. Place the documents at the center of the ADF paper chute.    

7. Press the [Scan] button on the ScanSnap to start a scan.

Scanned images are saved in the original document sizes.

Make sure that all documents are placed above the pick roller.
Otherwise, some documents will not be picked.

Adjust the side guides to the widest document in the batch.
Carefully load small documents that cannot reach the side guide straight into the ADF 
paper chute (cover). If the documents are skewed during scanning, the quality of 
scanned image data may be degraded (partly lost image data/slant lines produced) or 
scanned image data may be output in a different size than the original. If you have 
difficulties in scanning the documents straight, it is recommended to scan documents in 
several batches, documents of the same width being in the same batch, and enable 
continuous scanning.
Note that documents that cannot be guided by the side guide may cause paper jams.

If the documents are scanned skewed, the images may not be output in their original 
sizes.

Pick roller's width
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■ Scanning Documents Larger Than A4/Letter Size

You can scan documents larger than A4/Letter size such as A3, 11 × 17 in. and B4 size using 
the Carrier Sheet. By folding the document in half and scanning in duplex mode, the two sides 
are merged into a single image.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then 
click the [Carrier Sheet Settings] button.

The [Carrier Sheet Settings] window appears.

The [Correct skewed character strings automatically] checkbox ([Scanning] tab → [Option] in the 
ScanSnap setup window) will be disabled.

You can also scan documents smaller than A4/Letter size and have both sides saved as a single 
image.
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3. Select [one double-page spread image] in [Save as] and click the [OK] 
button.

For details about the Carrier Sheet settings, refer to the ScanSnap Manager Help.

4. In the [Scanning side] pop-up menu in the [Scanning] tab, select [Duplex 
Scan (Double-sided)] and click the [Apply] button.

If [Simplex Scan (Single-sided)] is specified for [Scanning side] in the [Scanning] tab, the 
ScanSnap outputs the same result as performing a simplex scan in [Create front and 
back images separately] mode.
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5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Place the document inside the Carrier Sheet.

1. Fold the document in half so that the sides to be scanned are facing out.
Fold it tightly and smooth out any creases.

2. Open the Carrier Sheet to bind the document.
Align the fold line with the right edge of the 
Carrier Sheet so that the document fits in 
the upper right-hand corner of the Carrier 
Sheet.

Note that the front side of the Carrier Sheet has a thick vertical line in the upper right-
hand corner.
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7. Place the end with the black and white pattern as the leading edge in the 
direction of the arrow.

Secure the Carrier Sheet with the side guides to avoid 
skewing.

8. Press the [Scan] button on the ScanSnap to start a scan.

Both sides of the document are scanned and 
saved as one double-page spread image.

There may be a line or a gap appearing between the front and back side images.
Also when you scan thick papers, images on both left and right may skew towards each other 
from the top.
These symptoms may be improved when you perform the following:
- Fold the document properly
- Neatly align the edges of the document with the edges of the Carrier Sheet when placing 

the document inside the Carrier Sheet
If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] window, an 
optimal size will be selected automatically from the available standard sizes (A3, B4 or 11 × 
17 in.) from the same pop-up menu.                                                                                             
Note that the size of the image may become smaller than the original document depending 
on the document.
Example: When you scan an A3 size document whose content is printed to fit A4 size in the 

center, the image data is output in B4 size.
To output the scanned image in its original size, specify the document size in the [Paper size] 
pop-up menu.
Part of the image data around where the document is folded may appear missing. In that 
case, set the document so that its edge is about 1 mm inside from the edge of the Carrier 
Sheet.
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■ Scanning Documents Such as Photographs and 
Clippings

Using the Carrier Sheet allows you to scan documents that can be damaged quite easily such 
as photographs, or non-standard size documents that are difficult to load directly such as 
clippings.
Change the settings to scan documents such as photographs and clippings in the following 
procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then 
click the [Carrier Sheet Settings] button.

The [Carrier Sheet Settings] window appears.

In the [Scanning mode option] window ([Scanning] tab → [Option] button in the ScanSnap setup 
window), the [Correct skewed character strings automatically] checkbox is disabled.
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3. Select [two separate images (front and back)] in [Save as] and click the 
[OK] button.

For details about the Carrier Sheet settings, refer to the ScanSnap Manager Help.

4. Click the [Apply] button in the ScanSnap setup window.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Place the document inside the Carrier Sheet.

Open the Carrier Sheet and place the top of the 
document against the top center of the Carrier Sheet. 
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7. Place the end with the black and white pattern as the leading edge in the 
direction of the arrow.

Set the back side of the document facing towards you.
Secure the Carrier Sheet with the side guides to avoid skewing.

8. Press the [Scan] button on the ScanSnap to start a scan.

Scanned image is saved.

The scanned image is output at the center of the page in the size specified in the 
[Paper size] pop-up menu of the [Carrier Sheet Settings] window.
If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] 
window, an optimal size will be selected automatically from the available standard sizes 
(A3, B4 or 11 × 17 in.) from the same pop-up menu.                                                                                             
Note that the size of the image may become smaller than the original document 
depending on the document scanned, or part of the image may appear missing.
Example: When an A5 size image is printed in the center of an A4 size document, the 

image is output in A5 size.
To output the scanned image in its original size, specify the document size in the [Paper 
size] pop-up menu.

In the following cases, place a blank (white) sheet of paper underneath the document when 
scanning:

The scanned image is not saved in the correct size (when [Automatic detection] is 
selected in the [Paper size] pop-up menu of the [Carrier Sheet Settings] window)
Shadows appear around the edges of the scanned image
Black lines appear around the edges of a uniquely shaped cutting

Back Back

Blank 
sheet
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■ Long Page Scanning

Documents up to 863 mm (34 in.) in length can be scanned.
The following explains how to scan long pages.

1. Load a document in the ScanSnap.

For details about documents that can be loaded, refer to "Documents for Scanning" 
(page 29).

Long page documents should be loaded one sheet at a time in the ADF paper chute 
(cover).

When you scan long pages, take note of the following.

Loading
Hold the document with your hands so 
that it does not fall out of the ADF paper 
chute (cover).

Removing
Secure enough space around the 
stacker to prevent the ejected sheet 
from falling off the stacker.
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2. Press the [Scan] button on the ScanSnap for 3 seconds or longer until it 
flashes in blue.

Scanning starts.

When you scan the first page as a long page and continue scanning, the next document is 
also scanned as long page.

The error message below appears and long page scanning is disabled when [Excellent] 
is selected in the [Image quality] pop-up menu of the [Scanning] tab in the ScanSnap 
setup window.

When you perform a long page scan, the current settings are ignored and the following 
settings are used:
- Multifeed Detection: None
- Paper size: Automatic detection
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■ Saving Scanned Images in Multiple PDF Files

The ScanSnap is able to save scanned image in separate PDF files based on the specified 
number of pages. For example, you can scan a batch of slips, and save each slip as a PDF 
file.
To save image data in multiple PDF files, change the settings in the following procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [File format] pop-up menu in the [File option] tab, select [PDF 
(*.pdf)], and then click the [Option] button.

The [PDF file format option] window appears.
410



Using the ScanSnap in Various Ways (for Mac OS Users)
3. Select [Generate one PDF file per (n) page(s)] and enter the number of 
pages to split.

One PDF is created every time the number of pages specified here has been saved.

4. Click the [OK] button to close the [PDF file format option] window.

5. Click the [Apply] button in the ScanSnap setup window.

6. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

7. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

8. Press the [Scan] button on the ScanSnap to start a scan.

One PDF file is created every time the number of pages specified in step 3. has been 
scanned.

In duplex mode, two pages (front/back) are created per document.
When you select the [Allow automatic blank page removal] checkbox in the [Scanning 
mode option] window ([Scanning] tab → [Option] button), the number of pages of the 
original document and the scanned image does not match when blank pages are deleted. 
Clear this checkbox when you want to keep the original page number order.
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■ Creating Searchable PDF Files

The ScanSnap is able to perform text recognition on a scanned image automatically and 
create a searchable PDF file.
To create searchable PDF files, change the settings in the following procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

2. In the [File format] pop-up menu in the [File option] tab, select [PDF 
(*.pdf)].

It is recommended that you select [Better] or [Best] for [Image quality] in the [Scanning] tab 
of the ScanSnap setup window.
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3. Select the [Convert to Searchable PDF] checkbox.

The following message appears.

Click the [OK] button to close the window.

Language
Select the language. Japanese, English, French, German, Italian, Spanish, Russian, 
and Portuguese can be selected.
Target pages
Select [All pages] to perform text recognition for all pages and [First page] for just the 
first page.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).
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7. Press the [Scan] button on the ScanSnap to start a scan.

Text recognition is performed on the scanned image and a searchable PDF file is 
created.

It may take extra time to process text recognition depending on your computer system 
environment when you enable this setting in step 3.
Scanned images of the following types of documents (characters) may not be 
recognized correctly.
In that case, better results in text recognition may be achieved by changing the setting 
for [Color mode] or specifying a higher resolution in [Image quality].
- Documents including handwritten characters.
- Documents with small characters scanned at a low resolution
- Skewed documents
- Documents written in languages other than the specified language
- Documents including texts written in italic characters
- Documents containing characters with superscripts/subscripts and complicated 

mathematical expressions 
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders

It may take extra time to perform text recognition on the following documents:
- Documents with complex layouts
- Documents with information other than text

e.g. Text on a shaded background
Vertical text can be searched with Adobe Acrobat, but not with Spotlight or Preview.
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■ Automatically Setting Keywords for PDF Files

If the document is black & white, character strings (e.g. page heading, title) can be set as 
keywords and used for a PDF file search. 
Mark a character string to be set as a keyword with a water-based highlight pen so that the 
character string is completely covered. 
When you perform a scan, the marked character strings are recognized and set as keywords 
for the PDF file.

Mark black & white documents in the following way:
Any regular highlight pen can be used. 
The following shows the colors and thickness recommended for highlight pens:

Mark a straight line over a single character string.
The supported range of a marked section is as follows: 
Minimum:3 mm (short side) × 10 mm (long side) 
Maximum:20 mm (short side) × 150 mm (long side)
Use only one color per page for marking.
Make sure to cover the entire character string when marking it. 
Mark sections so that the entire section is evenly colored.

Pink Yellow Blue Green

Good example: Bad example 1:
(does not cover the entire section)

Bad example 2:
(unevenly colored)

Scan

Scan

Scan Scan

Sets text as a keyword for the PDF 
file

Searchable PDF file

ImageConverts character string in a 
marked section into text

keyword

You can search for the file through 
the set keyword
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Do not mark more than ten sections per page.

Change the settings in the following procedure to automatically set keywords for PDF files.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The ScanSnap setup window appears.

For the following documents, marked sections cannot be recognized and set as keywords:
- Color documents such as catalogues or pamphlets 
- Documents in which two or more colors are used for marking 
- Documents containing colors other than for marking (pens other than highlight pens are 

used or the document is stained) 
- Documents with too many marked sections on a single page

The following types of marked character strings cannot be set as keywords:
- The size of the marked section is outside the supported range 
- The marking is irregular (e.g. skewed) 
- Multiple marked sections are too close to each other 
- The color of the highlight pen is too pale or the color has faded 

When you mark more than one character string, make sure to leave a gap of at least 5 mm 
between the marked sections. Marked sections that are too close to each other may be 
detected as one marked section.
In the following case, character strings surrounding marked sections may be set as 
keywords: 
- Marked section overlaps the line above and below 

In the following cases, unmarked character strings may be set as keywords:
- Color documents such as catalogues or pamphlets 
- Documents with color text, diagrams, pictures, tables and lines
- Documents containing sections framed by a highlight pen
- Stained documents

Increase the resolution when you have trouble setting the keywords correctly.
Keywords set for a PDF file can be checked [Document Properties] of Adobe Acrobat / 
Adobe Reader or Preview [Inspector].
416



Using the ScanSnap in Various Ways (for Mac OS Users)
2. In the [File format] pop-up menu in the [File option] tab, select [PDF 
(*.pdf)].

It is recommended that you select [Better] or [Best] for [Image quality] in the [Scanning] tab 
of the ScanSnap setup window.
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3. Select the [Set the marked text as a keyword for the PDF file] checkbox.

Target marked sections
Select [First marked section] to perform text recognition and set a keyword for the 
PDF file only for the character strings in the first marked section, and [All marked 
sections] for all marked sections.

Language
Select the language. Japanese, English, French, German, Italian, Spanish, Russian, 
and Portuguese can be selected.

Do not select [First marked section] when the text orientation of your document is 
vertical.

The following explanation is for when you select [First marked section]:
Select this button to set a character string such as a title of a document as a 
keyword for the PDF file.
Example: When only the title of a document is marked, the marked character 

string is set as a keyword for the PDF file, and the PDF file becomes 
searchable by the title character string.

When multiple marked sections exist in line, the marked character string closest 
to the top of the document is set as a keyword.
Example: In the following case, the character string in marked section B, which is 

higher than marked section A, is set as a keyword.

Marked section A Marked section B
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Target pages
Select [First page] to perform text recognition and set a keyword for the PDF file only 
for the first page, and [All pages] for all pages.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 32).

7. Press the [Scan] button on the ScanSnap to start a scan.

Text recognition is performed on marked character strings and a PDF file is created 
with the keywords added.

It may take extra time to process text recognition depending on your computer system 
environment when you enable this setting in step 3.
Scanned images of the following types of documents (characters) may not be 
recognized correctly.
In that case, better results in text recognition may be achieved by specifying a higher 
resolution in [Image quality].
- Documents including handwritten characters.
- Documents with small characters scanned at a low resolution
- Skewed documents
- Documents written in languages other than the specified language
- Documents including texts written in italic characters
- Documents containing characters with superscripts/subscripts and complicated 

mathematical expressions 
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders

It may take extra time to perform text recognition on the following documents:
- Documents with complex layouts
- Documents with information other than text

e.g. Text on a shaded background
If the same character string is marked several times in the document, the same 
keyword is added multiple times in the PDF file.
Total length of all the keywords can be up to 255 characters.
When you check keywords in Adobe Acrobat or Adobe Reader, the added keywords 
may be displayed with a set of quotation marks (e.g. "ABC").
For Mac OS X v10.4, keywords cannot be set for PDF files that are 500 MB or larger.
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Using the ScanSnap in Various Ways (for Mac OS Users)
■ Saving Two Files or Pages into One Double-Page 
Spread Image

With Page Merger, you can merge two JPEG files, two single-page PDF files, or two pages of 
a multi-page PDF file vertically or horizontally. The merged file or page is saved as a single 
double-page spread image.
For details about how to merge pages, refer to the ScanSnap Manager Help.
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Troubleshooting
For details about how to resolve problems such as removing jammed documents, refer to 
"Troubleshooting" in the ScanSnap Manager Help.

Select [Help] → [Troubleshooting] in the Right-Click Menu.

Select [Help] → [Troubleshooting] in the ScanSnap Manager menu.
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Daily Care
This chapter explains about the cleaning materials and how to clean the ScanSnap.

Cleaning Materials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 423

Cleaning the Outside of the ScanSnap . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 424

Cleaning the Inside of the ScanSnap. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 425

The bottom part of the ScanSnap may become hot when the ScanSnap is being used but this 
does not affect ScanSnap operation or cause any physical harm. Be careful not to drop the 
ScanSnap when carrying it.
422



Cleaning Materials
Cleaning Materials

Cleaning materials and their part numbers are as below.

*1 : Cleaning Wipes are wet sheets pre-moistened with Cleaner F1 which can be used instead of 
cloths moistened with Cleaner F1.

*2 : Any lint-free cloth can be used.

To obtain these products, contact your FUJITSU dealer or an authorized FUJITSU scanner 
service provider.

Product Name Part No. Unit Note

Cleaner F1 PA03950-0352 1 bottle Size: 100 ml

Cleaning Wipe (*1) PA03950-0419 1 pack 24 packets

Lint-free dry cloth (*2) Commercially 
available

- -

PFU LIMITED
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Cleaning the Outside of the ScanSnap
Cleaning the Outside of the ScanSnap

Clean the outside of the ScanSnap in the following procedure.

How to perform cleaning

1. Unplug the cables from the ScanSnap.

2. Clean the outside of the ScanSnap with a dry cloth, or a cloth moistened 
with Cleaner F1/mild detergent.

Never use paint thinner or any other organic solvents.
Be careful not to get any moisture or water inside the scanner during cleaning.
It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten 
the cloth with moderate quantity. Wipe off the cleaner completely to leave no residue on 
the cleaned parts.

Mild detergent or 
Cleaner F1

Cloth

Thinner
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Cleaning the Inside of the ScanSnap
Cleaning the Inside of the ScanSnap

Scanning continuously may cause dust and paper dust to accumulate inside the ScanSnap 
and result in scanning error.
As a guideline, the inside of the ScanSnap should be cleaned every 1000 sheets scanned. 
Note that this guideline varies depending on the types of documents you scan. 
For instance, it may be necessary to clean the scanner more frequently when you scan 
documents on which the toner is not sufficiently fused.

WARNING
Before you perform cleaning, you must turn off the ScanSnap and unplug the cables to 
avoid the risk of fire or electric shock.
Do not place internal parts of the scanner (e.g. pad assy, pick roller) anywhere within reach 
of small children.
Do not use aerosol spray or spray that contains alcohol to clean the scanner. Dust blown 
up by strong air from the spray may enter inside of the scanner which may cause scanner 
failure or malfunction.
Also note that sparks generated by static electricity may cause a fire.
The glass inside the scanner becomes very hot when the ScanSnap is being used.
Unplug the cables from the ScanSnap and wait for at least 15 minutes before cleaning.

CAUTION

Be careful not to get your hand or the cloth caught on the pick spring (metal part) as a 
deformed pick spring may cause injury.

Check the number of sheets scanned in the following procedure.

Select [Help] → [About ScanSnap Manager] → [Detail] button in the Right-Click Menu to 
display the [ScanSnap Manager - Scanner and driver information] dialog box, and then see 
[Total page count].

Select [Help] → [About ScanSnap Manager] → [Detail] button in the ScanSnap Manager menu 
to display the [ScanSnap Manager - Scanner and driver information] window, and then see 
[Total page count].
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Cleaning the Inside of the ScanSnap
How to perform cleaning

1. Unplug the power cable from the AC outlet.

2. Pull the ADF release catch to open the ADF top section.

3. Clean the following locations with a cloth moistened with Cleaner F1.

Do not use water or mild detergent to clean the inside of the ScanSnap.
It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten 
the cloth with moderate quantity.
Wipe off the cleaner completely to leave no residue on the cleaned parts.

ADF release 
catch

ADF top section

ADF paper chute (cover)

Pad assy

Idler roller (×4)

Glass (×2)
(including the one on the ADF 
top section)

Pick roller

Ultrasonic sensor
(including the one on the ADF 
top section)

Pick spring (metal part)
*gray part
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Cleaning the Inside of the ScanSnap
Pad assy (× 1, located on the ADF top section)
Gently wipe the rubber pads downwards. Be careful not to get your hand or the cloth 
caught on the pick spring (metal part). 
Glass (× 2, one on the ADF top section and one on its opposite side)
Gently wipe the dirt and dust off the surface of the glass sections.
Ultrasonic sensor (× 2, one on the ADF top section and one on its opposite side)
Gently wipe the dirt and dust off the surface of the ultrasonic sensors.
Pick roller (× 1)
Gently wipe the dirt and dust off the roller as you rotate it manually. Be careful not to 
damage the surface of the rollers. Make sure that it is cleaned properly because 
residue on the roller will affect the feeding performance.
Idler roller (× 4, located on the ADF top section)
Gently wipe the dirt and dust off the rollers as you rotate them manually. Be careful 
not to damage the surface of the rollers. Make sure that it is cleaned properly 
because residue on the roller will affect the feeding performance.

4. Connect the power cable, and press the [Scan] button for 3 seconds with 
the ADF top section open. 

Connect the power cable only when cleaning the feed rollers and eject rollers.
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Cleaning the Inside of the ScanSnap
5. Clean the feed roller and the eject roller with a cloth moistened with 
Cleaner F1.

Feed roller (× 2)
Press the [Scan] button to rotate the rollers. Gently wipe the dirt and dust off while 
taking care not to damage the surface of the rollers. Make sure that it is cleaned 
properly because residue on the roller will affect the feeding performance.
Eject roller (× 2)
Press the [Scan] button to rotate the rollers. Gently wipe the dirt and dust off while 
taking care not to damage the surface of the rollers. Make sure that it is cleaned 
properly because residue on the roller will affect the feeding performance.

Do not use water or mild detergent to clean the inside of the ScanSnap. 
It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten 
the cloth with moderate quantity.
Wipe off the cleaner completely to leave no residue on the cleaned parts.

Pressing the [Scan] button six times will rotate the feed rollers and the eject rollers one 
revolution.

Eject roller (×2)

Feed roller
(×2)
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Cleaning the Inside of the ScanSnap
6. Close the ADF top section.

It clicks when it returns to its original position.

Confirm that the ADF top section is completely closed.
Otherwise, paper jams or other feeding errors may occur.

ADF top section

ADF paper chute 
(cover)
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Consumables
This chapter explains about the consumable part numbers, replacement cycles and how to 
replace the consumables.

WARNING
Before you replace the consumables, you must turn off the ScanSnap and unplug the 
cables to avoid the risk of fire or electric shock.
To avoid injuries, do not place internal parts of the scanner (e.g. pad assy, pick roller) 
anywhere within reach of small children.

Part Numbers and Replacement Cycle of Consumables. . . . . . . . . . . . . . . . . . . . . . 431

Replacing the Pad Assy. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 433

Replacing the Pick Roller . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 437

The bottom part of the ScanSnap may become hot when the ScanSnap is being used but this 
does not affect ScanSnap operation or cause any physical harm. Be careful not to drop the 
ScanSnap when carrying it.
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Part Numbers and Replacement Cycle of Consumables
Part Numbers and Replacement Cycle of 
Consumables

The following table shows the part numbers of the consumables and the suggested 
replacement cycles.

Note that the suggested replacement cycles are guidelines for using A4 (80 g/m² [20 lb]) 
wood-free paper, as these cycles vary depending on the type of documents scanned.
Only use the specified consumables.

To purchase the consumables, contact your FUJITSU dealer or an authorized FUJITSU 
scanner service provider.

No. Name Part No. Suggested replacement cycle

1  PAD ASSY PA03586-0002 50,000 sheets or one year

2 PICK ROLLER PA03586-0001 100,000 sheets or one year
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Part Numbers and Replacement Cycle of Consumables
You can check the status on each consumable part in the following procedure.

1. Select [Check consumable status] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
The [ScanSnap Manager - Check consumable status] dialog box appears.

2. Check the status of each consumable.

Refer to [Suggested replacement cycle] as a guideline and replace the 
consumables.

1. Select [Check consumable status] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The [ScanSnap Manager - Check consumable status] window appears.

2. Check the status of each consumable.

Refer to [Suggested replacement cycle] as a guideline and replace the 
consumables.
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Replacing the Pad Assy
Replacing the Pad Assy

Replace the pad assy in the following procedure.

1. Unplug the power cable from the ScanSnap.

2. Remove all documents from the ADF paper chute (cover).

3. Pull the ADF release catch to open the ADF top section.

4. Remove the pad assy.

Squeeze both ends of the pad assy and pull it out in the direction of the arrow.

ADF release 
catch

ADF top section

ADF paper chute (cover)

ADF top section

Pad assy
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Replacing the Pad Assy
5. Attach a new pad assy.

6. Close the ADF top section.

It clicks when it returns to its original position.

7. Connect the power cable, and turn on the ScanSnap.

Confirm that the pad assy is attached properly. Otherwise, paper jams or other feeding 
errors may occur.

ADF top section

Pad assy

ADF top section

ADF paper chute 
(cover)
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Replacing the Pad Assy
8. Reset the consumable counter.

1. Select [Check consumable status] from the Right-Click Menu.
For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).

The [ScanSnap Manager - Check consumable status] dialog box appears.

2. Click the [Reset] button for [PAD ASSY Count].

A confirmation message appears.

3. Click the [Yes] button.

The [PAD ASSY Count] is reset to 0.
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Replacing the Pad Assy
1. Select [Check consumable status] from the ScanSnap Manager menu.
For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The [ScanSnap Manager - Check consumable status] window appears.

2. Click the [Reset] button for [PAD ASSY Count].

A confirmation message appears.

3. Click the [Yes] button.

The [PAD ASSY Count] is reset to 0.
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Replacing the Pick Roller
Replacing the Pick Roller

Replace the pick roller in the following procedure.

1. Unplug the power cable from the ScanSnap.

2. Remove all documents from the ADF paper chute (cover).

3. Pull the ADF release catch to open the ADF top section.

4. Adjust the side guides to "A5" size.

ADF release 
catch

ADF top section

ADF paper chute (cover)

A5 A5
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Replacing the Pick Roller
5. Remove the sheet guide.

Hold the pickup tabs on both ends, and lift it up and away.

6. Rotate the bushing (left).

Sheet guide
Pickup tab Pickup tab

Shaft

BushingPick roller
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Replacing the Pick Roller
7. Remove the pick roller with its shaft.

Gently lift the left part of the pick roller shaft (about 5 mm), move it towards the left, and 
then pull it out.

The area around the pick roller may get dirty due to paper dust, and cause scan errors.
Wipe the dirt off with a cloth moistened with Cleaner F1 to prevent such errors.
Do not use water, mild detergent or aerosol spray.

Pick rollerShaft
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Replacing the Pick Roller
8. Remove the pick roller from its shaft.

Pull out the shaft as you lift the retaining clip.

9. Attach a new pick roller on the shaft.

Insert the protrusion on the shaft into the slot.

Lifting the retaining clip with your fingernail may hurt or damage your fingernail.
Use a paper clip or something alike if you have trouble lifting it up.

Shaft

Pick roller

Retaining clip

Protrusion

Shaft

Pick roller
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Replacing the Pick Roller
10.Attach the shaft.

Insert the right end of the shaft into the slot, and lower the other end gradually.

11.Rotate the bushing (left) to lock the shaft.

Confirm that the pick roller is installed properly. Otherwise, paper jams or other feeding 
errors may occur.

Pick rollerShaft

Shaft

BushingPick roller
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Replacing the Pick Roller
12.Attach the sheet guide.

Hold the pickup tabs on both ends, and attach the sheet guide.

It clicks when the pickup tabs are released.

13.Close the ADF top section.

It clicks when it returns to its original position.

14.Connect the power cable, and turn on the ScanSnap.

Confirm that the sheet guide is attached properly. Otherwise, paper jams or other feeding 
errors may occur.

Sheet guide

Pickup tab Pickup tab

ADF top section

ADF paper chute 
(cover)
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Replacing the Pick Roller
15.Reset the consumable counter.

1. Select [Check consumable status] from the Right-Click Menu.
For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).

The [ScanSnap Manager - Check consumable status] dialog box appears.

2. Click the [Reset] button for [PICK ROLLER Count].

A confirmation message appears.

3. Click the [Yes] button.

The [PICK ROLLER Count] is reset to 0.
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Replacing the Pick Roller
1. Select [Check consumable status] from the ScanSnap Manager menu.
For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

The [ScanSnap Manager - Check consumable status] window appears.

2. Click the [Reset] button for [PICK ROLLER Count].

A confirmation message appears.

3. Click the [Yes] button.

The [PICK ROLLER Count] is reset to 0.
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Appendix
This appendix explains how to update ScanSnap Manager, how to uninstall the software, 
setting items with/without the Quick Menu, how to purchase the Carrier Sheet and the 
ScanSnap installation specifications.

Updating ScanSnap Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 446
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Setting Items With/Without the Quick Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 457
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Installation Specifications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 463
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Updating ScanSnap Manager
Updating ScanSnap Manager

Updates are released regularly in an effort to improve the usability and functionality of 
ScanSnap Manager.
This section explains how to update ScanSnap Manager.

For details about updates of the software bundled with the ScanSnap, visit the following web 
page:
http://scansnap.fujitsu.com/g-support/en/

■ Updating in Windows

Update ScanSnap Manager in the following procedure.
We recommend that you run the update regularly.

1. Select [Help] → [Online Update] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 70).
 A confirmation message appears.

It is necessary to have a browser with Internet access to perform the update.
Always log on as a user with Administrator privileges.

You can also update ScanSnap Manager by selecting [Start] menu → [All Programs] → 
[ScanSnap Manager] → [Online Update].
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Updating ScanSnap Manager
2. Click the [Yes] button.

If a later version of ScanSnap Manager (update) is available, a confirmation 
message appears.

3. Click the [Yes] button.

The program is downloaded, and a confirmation message appears.

If the latest version of ScanSnap Manager is already installed, the message below 
appears.

Click the [OK] button to close the message.
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Updating ScanSnap Manager
4. Click the [Install] button.

Installation starts, and the ScanSnap Manager installer starts up.
Follow the instructions on the screen to continue with the installation.

When you click the [Information] button, Internet Explorer which displays information about 
the latest update for ScanSnap Manager opens.
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Updating ScanSnap Manager
■ Updating in Mac OS

Update ScanSnap Manager in the following procedure.
We recommend that you run the update regularly.

1. Select [Help] → [Online Update] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 258).

 A confirmation message appears.

2. Click the [Yes] button.

If a later version of ScanSnap Manager (update) is available, a confirmation 
message appears.

It is necessary to have a browser with Internet access to perform the update.

You can also update ScanSnap Manager by selecting:
[Help] → [Online Update] from the menu bar
From Finder, [Applications] → [ScanSnap] and double-clicking [Online Update].

If the latest version of ScanSnap Manager is already installed, the message below 
appears.

Click the [OK] button to close the message.
449



Updating ScanSnap Manager
3. Click the [Yes] button.

The program is downloaded, and a confirmation message appears.

4. Select [Quit] from the ScanSnap Manager menu to exit ScanSnap 
Manager.

5. Click the [Install] button.

Installation starts, and the ScanSnap Manager installer starts up.
Follow the instructions on the screen to continue with the installation.

When you click the [Information] button, a web browser which displays information about 
the latest update for ScanSnap Manager opens.
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Uninstalling the Software
Uninstalling the Software

This section explains how to uninstall the software bundled with the ScanSnap.
For details about installation, refer to "Installing the Software" (page 38).

■ Uninstalling in Windows
This section explains how to uninstall the following software:

ScanSnap Manager
ScanSnap Organizer
CardMinder
ABBYY FineReader for ScanSnap
Evernote for Windows
Scan to Microsoft SharePoint

The procedure is as follows.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Exit all running software.

3. Select [Start] menu → [Control Panel] → [Programs] → [Programs and 
Features].

The [Uninstall or change a program] dialog box appears with a list of currently 
installed software.
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Uninstalling the Software
4. Select the software to uninstall.

To uninstall ScanSnap Manager
Select [ScanSnap Manager].
To uninstall ScanSnap Organizer
Select [ScanSnap Organizer].
To uninstall CardMinder
Select [CardMinder].
To uninstall ABBYY FineReader for ScanSnap
Select [ABBYY FineReader for ScanSnap (TM) 4.1].
To uninstall Evernote for Windows
Select [Evernote].
To uninstall Scan to Microsoft SharePoint
Select [Scan to Microsoft SharePoint].

5. Click the [Uninstall] button.

A confirmation message appears.

6. Click the [Yes] button.

The software is uninstalled.

To uninstall more than one software, repeat steps 4. to 6. for each software.

Screen displays may vary slightly depending on the operating system that you are 
using. In that case, follow the instructions by the operating system.
Example:
- [Programs and Features]

In Windows XP: [Add or Remove Programs]
In Windows 2000: [Add/Remove Programs]

- [Uninstall] button 
In Windows XP or Windows 2000: [Remove] button

If you cannot successfully uninstall the following software, select [Manuals] → 
[Troubleshooting (installation)] in the [ScanSnap Setup] dialog box and refer to 
Troubleshooting (installation).
- ScanSnap Manager
- ScanSnap Organizer
- CardMinder
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Uninstalling the Software
■ Uninstalling in Mac OS

This section explains how to uninstall the following software:
ScanSnap Manager (→ page 453)
ABBYY FineReader for ScanSnap (→ page 454)
Cardiris (→ page 455)
Evernote for Mac (→ page 456)

ScanSnap Manager

1. Turn on the computer and log in as a user with Administrator privileges.

2. From Finder, select [Applications] and double-click [ScanSnap] → [Sub] 
→ [ScanSnap Uninstaller.app].

The [ScanSnap Uninstaller] window appears, displaying the [Welcome to ScanSnap 
Uninstaller] screen.

3. Click the [Continue] button.

The [Read Me] screen appears.

4. Read [Read Me], and then click the [Uninstall] button.

An authentication window appears.

5. Enter the user name and password for a user with Administrator 
privileges, and click the [OK] button.

Uninstallation starts. When the uninstallation is complete, the [Uninstall succeeded] 
screen appears.

6. Click the [Close] button.
If ScanSnap Manager has been configured as a login item with a user account other 
than the current one, remove it in the following procedure:
1. Log in under the user account where ScanSnap Manager is set as a login item.
2. From the Apple ( ) menu, select [System Preferences].

The [System Preferences] window appears.
3. Select [Accounts].

The [Accounts] window appears.
4. From [My Account], select the currently logged-in user.
5. Select the [Login Items].

A list of login items appears.
6. From this list, select [ScanSnap Manager].
7. Click the [ ] button under the list.

ScanSnap Manager is removed from the list.
8.  Close the [Accounts] list.
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Uninstalling the Software
ABBYY FineReader for ScanSnap

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ABBYY FineReader for ScanSnap if it is running (select [(Application 
name)] → [Quit FineReader for ScanSnap] from the menu bar).

One of the following application names is displayed on the menu bar:
FineReader for ScanSnap
Scan to Excel
Scan to Searchable PDF
Scan to Word

3. From Finder, select [Applications] → [ABBYY FineReader for ScanSnap], 
and drag the [ABBYY FineReader for ScanSnap] folder into the Trash.

4. Empty the Trash.

The [ABBYY FineReader for ScanSnap] folder is detected.

For Mac OS X v.10.5/Mac OS X v10.4, also perform the following.
From the sidebar in Finder, select the [volume name] → [Library] → [Receipts], and drag 
[ABBYY FineReader.pkg] into the Trash.
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Uninstalling the Software
Cardiris

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit Cardiris if it is running (select [Cardiris for ScanSnap] → [Quit 
Cardiris for ScanSnap] from the menu bar).

3. From Finder, select [Applications] → [Cardiris for ScanSnap], and drag 
the [Cardiris for ScanSnap] folder into the Trash.

4. Empty the Trash.

The [Cardiris for ScanSnap] folder is deleted.

For Mac OS X v.10.5/Mac OS X v10.4, also perform the following.
From the sidebar in Finder, select [volume name] → [Library] → [Receipts], and drag 
[Cardiris.pkg] into the Trash.
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Uninstalling the Software
Evernote for Mac

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit Evernote if it is running (select [Evernote] → [Quit Evernote] from 
the menu bar).

If the Evernote icon ( ) is displayed on the right side of the menu bar, click the icon 
and select [Quit] from the menu that appears.

3. From Finder, select [Applications] → [Evernote], and drag the [Evernote] 
application into the Trash.

4. Empty the Trash.

The [Evernote] application is deleted.
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Setting Items With/Without the Quick Menu
Setting Items With/Without the Quick Menu

Setting items that you can configure in the ScanSnap setup dialog box/window differ 
depending on whether you are using the Quick Menu. You can select whether or not to use 
the Quick Menu according to your preferences.
For details about setting items and default settings, refer to the ScanSnap Manager Help.

(OK: Available, NA: Not available)

Setting Items With/Without the Quick Menu

Setting Item Using 
the Quick Menu

Without Using 
the Quick Menu

Profile Profile button OK NA

Recommended OK NA

Small File OK NA

High Quality OK NA

Customize OK NA

Profile Management NA OK

Application Application NA (*1) OK

None (Scan to File) NA OK

Adobe® Acrobat®

Adobe Acrobat Pro, Adobe Acrobat 
Professional or Adobe Acrobat Standard

NA OK

Adobe® Reader®

Adobe Reader

NA OK

CardMinder

Cardiris

NA OK

ScanSnap Organizer NA OK

ABBYY Scan to Excel

Scan to Excel 

NA OK

ABBYY Scan to Word

Scan to Word

NA OK

ABBYY Scan to PowerPoint(R) NA OK

ABBYY Scan to Searchable PDF

Scan to Searchable PDF

NA OK
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Setting Items With/Without the Quick Menu
Application Application NA (*1) OK

Scan to Folder NA OK

Scan to E-mail NA OK

Scan to Picture Folder NA OK

Scan to Print NA OK

Rack2-Filer
NA OK

Scan to SharePoint
NA OK

Preview
NA OK

iPhoto
NA OK

Scan to Evernote (Note) (*2) NA OK

Scan to Evernote (Document) (*2) NA OK

Scan to Google Docs(TM) (*2) NA OK

Scan to Salesforce Chatter (*2) NA OK

Scan to SugarSync (*2) NA OK

Scan to Mobile (*2) NA OK

Save Image saving folder OK

File Name Format OK

Rename file after scanning NA OK

Scanning Image quality OK

Automatic resolution OK

Normal (Color/Gray: 150 dpi, B&W: 300 dpi) OK

Better (Color/Gray: 200 dpi, B&W: 400 dpi) OK

Best (Color/Gray: 300 dpi, B&W: 600 dpi) OK

Excellent (Color/Gray: 600 dpi, B&W: 1200 dpi) OK

Color mode OK

Auto color detection OK

Color OK

Gray OK

B&W OK

Color high compression
NA OK

Setting Items With/Without the Quick Menu

Setting Item Using 
the Quick Menu

Without Using 
the Quick Menu
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Setting Items With/Without the Quick Menu
Scanning Scanning side OK

Duplex Scan (Double-sided) OK

Simplex Scan (Single-sided) OK

Continue scanning after current scan is finished OK

Option OK

Brightness (Black and White scanning only) OK

Setting for text only document OK

Allow automatic blank page removal OK

Correct skewed character strings automatically OK

Allow automatic image rotation OK

Set the document with its face up
OK

File option File format OK

PDF(*.pdf) OK

JPEG(*.jpg) OK

Set the marked text as a keyword for the PDF file OK

First marked section OK

All marked sections OK

Convert to Searchable PDF OK

Language OK

Target pages OK

First page OK

All pages OK

Option OK

Multipage PDF (whole batch in one PDF) OK

Generate one PDF file per (n) page(s) OK

Set a password for PDF file
NA OK

Setting Items With/Without the Quick Menu

Setting Item Using 
the Quick Menu

Without Using 
the Quick Menu
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Setting Items With/Without the Quick Menu
*1 : When using the Quick Menu, you can start an application to link with ScanSnap Manager from 
the Quick Menu after scanning. Therefore, the [Application] tab is not displayed. 

*2 : Not available in Windows 2000.

Paper Paper size OK

Automatic detection OK

A4 (210 × 297 mm) OK

A5 (148 × 210 mm) OK

A6 (105 × 148 mm) OK

B5 (JIS) (182 × 257 mm) OK

B6 (JIS) (128 × 182 mm) OK

Post card (100 × 148 mm) OK

Business card (90 × 55 mm, 55 × 90 mm) OK

Letter 
(8.5 × 11 in. (216 × 279.4 mm))

OK

Legal 
(8.5 × 14 in. (216 × 355.6 mm))

OK

Customize OK

Multifeed OK

None OK

Check Length OK

Check Overlapping [Ultrasonic] OK

Carrier Sheet Settings OK

Compression Compression rate OK

1 OK

2 OK

3 OK

4 OK

5 OK

Setting Items With/Without the Quick Menu

Setting Item Using 
the Quick Menu

Without Using 
the Quick Menu
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Purchasing/Cleaning the Carrier Sheet
Purchasing/Cleaning the Carrier Sheet

The Carrier Sheet can be used to scan documents that are larger than A4/Letter size, 
photographs and clippings.
This section explains about how to purchase/clean the Carrier Sheet.

■ Purchasing the Carrier Sheet

The product name and part number of the Carrier Sheet are as follows.

The Carrier Sheet should be replaced approximately every 500 scans.
However, replace it if damage or dirt is noticeable.

To purchase the Carrier Sheet, contact your FUJITSU dealer or an authorized FUJITSU 
scanner service provider.

Name Quantity Part No.

ScanSnap Carrier Sheet 5 sheets PA03360-0013
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Purchasing/Cleaning the Carrier Sheet
■ Cleaning the Carrier Sheet

As you keep using the Carrier Sheet, dirt and dust will accumulate on the surface and the 
inside.
Clean the Carrier Sheet regularly because it may result in scanning errors.

How to perform cleaning
Gently wipe the dirt and dust off the surface and the inside of the Carrier Sheet with a cloth 
moistened with Cleaner F1/mild detergent.

Do not use paint thinner or any other organic solvents.
Do not use force to rub against the Carrier Sheet because it may be damaged or deformed.
Be careful not to leave any crease on the Carrier Sheet.
After cleaning the inside of the Carrier Sheet with a cloth moistened with Cleaner F1/mild 
detergent, make sure that it is completely dry before closing the Carrier Sheet.
The Carrier Sheet should be replaced approximately every 500 scans.
For details about purchasing the Carrier Sheet, refer to "Purchasing the Carrier Sheet" (page 
461).
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Installation Specifications
Installation Specifications

The following table summarizes the installation specifications of the ScanSnap.

Item Specification

Outer dimensions (Width × Depth × Height) Minimum: 292 × 159 × 158 (mm) / 11.5 × 6.3 × 6.2 (in.)
(when the ADF paper chute (cover) is closed)
Maximum: 292 × 475 × 286 (mm) / 11.2 × 9.1 × 9.4 (in.)
(when the ADF paper chute (cover) and the stacker are 
open)

Weight 3.0 kg (approx. 6.62 lb)

Input power Voltage 100 V

Phase Single phase

Frequency range 50/60 Hz

Power consumption During operation: 35 W or less
During standby: 4.5 W

Temperature / humidity
allowable ranges

Temperature During operation: 5 to 35°C / 41 to 95°F
During standby: -20 to 60°C / -4 to 140°F
During storage/transportation: -20 to 60°C / -4 to 140°F

Humidity During operation: 20 to 80%
During standby: 8 to 95%
During storage/transportation: 8 to 95%

292 mm (11.5 [in]) 475 mm (18.7 [in])

286 mm 
(11.3 [in])
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About Maintenance
Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for 
repairs on this product.

Do not perform repairs on this scanner.
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The contents of this manual are subject to change without notice.
PFU LIMITED assumes no liability for incidental or consequential damages arising 
from the use of this product, and any claims by a third party.
Copying of the contents of this manual, in whole or in part, as well as the scanner 
applications is prohibited under the copyright law.

ScanSnap S1500/S1500M
Operator's Guide

P3PC-2432-05ENZ0
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